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Resumen 

 

Este trabajo presenta una propuesta metodológica para la enseña- aprendizaje de 

los fundamentos de la microscopía óptica mediante el uso de las nuevas 

tecnologías de la información y las comunicaciones (NTIC) haciendo énfasis en el 

procesamiento y análisis digital de las imágenes (DIP) y en la cual los estudiantes 

“aprenden haciendo”. Los módulos diseñados para este fin guían al estudiante 

hacia el uso del microscopio comprendiendo la óptica inmersa en toda la 

trayectoria de la luz hasta la adquisición por la cámara digital o por el ojo, lo cual 

se logra a través de la transformación de un microscopio muy simple y usando 

elementos caseros en uno con mayores prestaciones para hacer técnicas en 

microscopía adicional a la de campo claro, como son la de polarización y la de 

campo oscuro. Estos módulos también guían al estudiante en el procesamiento y 

la interpretación digital de las imágenes obtenidas. El software empleado para el 

DIP es de libre uso: OrquideaJAI e ImageJ. La propuesta se aplicó en la 

Universidad Nacional de Colombia sede Medellín a través de un curso 

extracurricular sobre microscopía óptica en el que participaron como voluntarios 

10 estudiantes de 5 programas de pregrado y un profesor asociado de Escuela de 

Geociencias. La pertinencia y calidad de la propuesta se mide a partir de una 

encuesta realizada a los participantes al final de esta experiencia. 
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Abstract 

This paper show a methodological tender about teaching- learning of optical microscopy 

basics using information and communication new technologies (ICNT) emphasizing in the 

process and digital image analysis (DIP), whit this, the students “learn by doing”. The 

modules designed for this purpose, guide the student toward to use of microscope 

comprising the basic principles of light travel immersed in the optical until the image 

formation in the digital camera o in the eye, this is profit through the transformation of a 

microscope very simple and using household things into one with higher benefits for to do 

techniques in additional microscopy to the brightfield microscopy, such as polarization 

and darkfield. These modules also guide the student in the processing and interpretation 

digital of images obtained by them. The software OrquideaJAI and ImageJ used for the 

DIP is of free use. The proposal was applied in the National University of Colombia at 

Medellin, through an extracurricular course about optical microscopy whit 10 students of 5 

undergraduate programs and an associate professor of Geosciences School, who 

participated as volunteer. The relevance and quality of this proposal is measured from a 

survey of participants at the end of this experience. 

 

Key words:  
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Introducción 

En el campo de la educación y la pedagogía de las ciencias naturales han surgido 

innumerables investigaciones cuyo propósito fundamental es mejorar los procesos de 

enseñanza-aprendizaje de los conceptos y teorías básicas en áreas como la biología y la 

física. En todos los casos se deja en evidencia una marcada necesidad de implementar 

estrategias que permitan al estudiante alcanzar una mayor comprensión de los objetivos 

del proceso de aprendizaje, de tal manera que como lo señalan Greca & Moreira (1998) 

se potencien en los estudiantes posturas más críticas y reflexivas frente a los conceptos 

científicos. 

Este trabajo está enmarcado en la propuesta pedagógica constructivista de David 

Ausubel y John Dewey, autores que invitan al docente a la aplicación de estrategias 

donde el estudiante sea el protagonista y responsable de su proceso de aprendizaje, 

permitiendo así el desarrollo de diferentes propuestas pedagógicas entre las que se 

destaca la denominada “learning by doing” que en su traducción al español significa 

“aprender haciendo”,  en la cual el aprendizaje se enfoca en un contexto social sobre el 

que incide la aprehensión y la interacción con los conceptos científicos. 

Para la enseñanza de las ciencias naturales, particularmente de la biología, el 

microscopio ha sido una herramienta que posibilita el acercamiento desde lo 

experimental a lo teórico, ya que desde su invento ha acercado al hombre al 

descubrimiento del microcosmos en donde se desarrollan organismos a simple vista 

imperceptibles, permitiendo así, dar explicación a una serie de sucesos que se 

desarrollan a su alrededor. Con los avances tecnológicos que ofrece cada época este 

instrumento se ha sofisticado permitiendo en la actualidad captar y analizar imágenes a 

través de varios dispositivos como un ordenador, un celular, una tabla, entre otros, 

buscando mejorar la calidad de la imagen y procesarla para una mejor interpretación de 

éstas apoyados en software específico para este fin. De esta manera se integran las 
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Nuevas Tecnologías de la Informática y la Comunicación (NTIC) a un instrumento 

desarrollado en el siglo XVII.   

En el aula el microscopio como instrumento es de gran ayuda y más si los estudiantes en 

sus experiencias logran asociar la teoría y la práctica a partir de la valoración de las 

imágenes que desde una herramienta como ésta se pueden obtener, así, se posibilita 

que la calidad en la comprensión de los procesos biológicos, de la morfología y anatomía 

de los organismos vivos y materia inerte que se tratan en el aula como parte de los 

planes curriculares propuestos para cada nivel de formación, puedan ser comprendidos 

significativamente, dándole sentido a temáticas que en ocasiones se muestran como 

abstractas, de acuerdo con Malagón (2002) “el experimento está en estrecha relación 

con las construcciones conceptuales, en este sentido se puede pensar que la teoría y la 

experiencia se mueven una alrededor de la otra” 

En el desarrollo del presente trabajo se propone la elaboración de una serie de 

estrategias que incentiven a los estudiantes a hacer uso de las NTIC para el análisis de 

las imágenes que ellos mismos pueden lograr a partir de un microscopio óptico. De esta 

manera se busca promover el desarrollo cognitivo de los estudiantes asociado a la 

curiosidad y creatividad, atendiendo así la llamada metodología "aprender haciendo" 

("learning by doing"), pues los contenidos teóricos son necesarios para avanzar en el 

aprendizaje de cualquier área de conocimiento, pero para lograr retenerlos y dotarlos de 

utilidad, es mejor experimentar con ellos. 

Para la aplicación de esta propuesta es necesario que los estudiantes tengan dominio 

conceptual acerca de la teoría de la naturaleza ondulatoria de la luz con la que pueda 

darse explicación a la formación de la imagen luego de que la luz viaja a través de los 

lentes que constituyen el microscopio. Por ello la esta propuesta se llevará inicialmente a 

estudiantes de pregrado de la Universidad Nacional de Colombia sede Medellín que ya 

han visto el curso de física de ondas y óptica. 

Con el prerrequisito señalado anteriormente, la propuesta se desarrolla con diez 

estudiantes de pregrado y un docente PhD de la Universidad Nacional de Colombia sede 

Medellín y se lleva a cabo en el laboratorio de física de esta institución. Las actividades 

se realizan en seis sesiones, una de introducción y cinco prácticas (ver anexos A, B, C, D 

y E), trabajadas para el fortalecimiento teórico de conceptos relacionados con la óptica 
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del microscopio y la aplicación y uso de software (Orquidea JAI e Image J) para 

mejoramiento y análisis digital de la imagen. La propuesta se enmarca en la metodología 

“learning by doing” haciendo uso de estrategia teórica apoyada con actividades prácticas 

experimentales, con las que se busca generar en los estudiantes participantes espacios 

para la observación, análisis, discusión y conclusiones, propiciando con esto el desarrollo 

de posturas critico-reflexivas. 

Esta propuesta parte de la pregunta ¿Cómo elaborar una estrategia que permita mejorar 

el proceso enseñanza-aprendizaje de la microscopía óptica integrándola a las nuevas 

TIC como recurso tecnológico? 

La propuesta diseñada e implementada en este trabajo final es de nivel universitario. Sin 

embargo en futuros trabajos se puede realizar la adaptación necesaria para su aplicación 

a estudiantes de básica y media secundaria buscando generar fundamentos e 

interdisciplinariedad en varias áreas curriculares como física, matemática, biología, 

tecnología e informática, a fin de construir, fortalecer y dinamizar los conceptos 

académicos de los diferentes niveles escolares. 

La metodología “aprender haciendo” es un componente de las estrategias pedagógicas 

propuesta por John Dewey donde se propone desarrollar habilidades del pensamiento a 

fin de que el estudiante pueda progresar en sus estructuras cognitivas, el papel del 

maestro es el de facilitador contribuyente al desarrollo de capacidades donde el 

estudiantes piense, idee, cree y reflexione. 

Haciendo un rastreo bibliográfico se encontraron algunos trabajos que relacionan el uso 

de las TIC en la enseñanza de las ciencias, por ejemplo,  “Constructivis Learning and 

theaching of optics concepts using ICT tool in Greek primary school: A pilot study”, donde 

Tekos et al (2009) señalan que el uso de las TIC como herramienta de enseñanza 

pueden contribuir al aprendizaje de las ciencias a partir del uso de software y otros 

materiales digitales. López M & Morcillo J (2007) discuten que la integración de las TIC 

en la asignatura de ciencias naturales adolece de falta de materiales concebidos para 

desarrollar el trabajo practico con los alumnos y en el artículo Aplicación del análisis 

digital de imágenes al estudio de la calidad del corcho realizado por Molinas M & Campos 

M (1993) se explica que el análisis y proceso digital de imágenes, es una técnica 

computarizada que permite la obtención de medidas de superficie, longitudes y  
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densidades, así como el análisis automatizado de partículas, trabajando con valores 

reales previa calibración. Estos hallazgos dan cuenta de la intención de algunos autores 

de integrar a la enseñanza de las ciencias las TIC como herramienta didáctica, pero 

dejan también de manifiesto que este recurso no es de disposición general. 

Sobre trabajos similares donde las TIC se asocien directamente a la microscopia tal 

como se propone en este trabajo, la pesquisa bibliográfica no arroja resultados, lo cual le 

da a esta idea un tinte innovador. 

La metodología propuesta para el desarrollo del presente trabajo se expone en el 

capítulo 3. Al final de la experiencia teórico práctica los estudiantes participantes 

responden a un cuestionario tipo encuesta con la intención de valorar la propuesta 

aplicada y los objetivos del trabajo. Los resultados se presentan en el capítulo 4 y en el 

capítulo 5 se dan las conclusiones y recomendaciones.  En los anexos A, B, C, D y E 

se presentan los talleres realizados por los participantes en el curso. 
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1. Aspectos preliminares 

 

1.1. Planteamiento del problema 

Bien es sabido que en el área de ciencias naturales, específicamente en la biología, el 

microscopio es uno de los instrumentos que mayor oportunidad de acercamiento a lo 

teórico ofrece, sin embargo en las instituciones de educación básica secundaria y 

pregrado de educación superior, esta herramienta pudiera ser utilizada con mayor 

rendimiento, permitiendo a los estudiantes mayor acercamiento a lo experimental y 

posturas críticas y reflexivas sobre los aportes que desde instrumentos como éste se 

pueden hacer a la ciencia y a la tecnología. 

En el ejercicio como docente me he preguntado frecuentemente hasta dónde mis 

estudiantes realmente comprenden y le dan significancia a los conceptos que se ejecutan 

en clase, y cuando esta pregunta la asocio a los logros que cada estudiante debe 

alcanzar durante el desarrollo de prácticas donde se hace uso del microscopio, puedo 

evidenciar que para muchos de ellos, el trabajo practico es importante pues estimula su 

creatividad, habilidad comunicativa, capacidad de síntesis, entre otros, además se asocia 

a una mayor disposición para la aprehensión de los conceptos, aunque para los 

estudiantes no siempre sea fácil analizar eficazmente las imágenes que con una 

herramienta como ésta se obtienen; en otros casos encuentro que los jóvenes no 

siempre comprenden lo que están observando, esto se debe a diversas razones entre las 

que destaco que:   

- En algunos casos los estudiantes no saben lo que deberían ver en la práctica 

experimental, esto tal vez puede estar asociado a las pobres prácticas de estudio 
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en casa que de ser aplicado adecuadamente ubicaría conceptualmente al 

estudiante y le permitiría prepararse para tal actividad. 

- Otra situación puede estar vinculada a la falta de conectores entre la teoría 

tratada y las prácticas realizadas. 

Asumiendo que nuestros estudiantes están interesados en trabajar con el microscopio 

como herramienta de asociación es importante el desarrollo de estrategias y 

herramientas complementarias que en microscopía ayuden a analizar la imagen captada 

y de esta manera se destaquen para ellos las formas, estructuras y demás información 

que está contenida en la imagen. 

Creo entonces que es necesario elaborar estrategias que motiven más a los estudiantes 

y les ayude en la construcción de su conocimiento haciéndolos participes del mismo. La 

metodología aprender haciendo asociada a las NTIC (herramientas de dominio popular, 

frecuentemente usada por los jóvenes), podrían aportar de manera significativa en las 

comprensión de algunos de los conceptos trabajados en la clase de biología a partir del 

análisis digital de la imagen haciendo posible que el estudiante dinamice su proceso de 

aprendizaje y se asocie efectivamente con una herramienta de tan alto significado 

científico como lo es el microscopio. 

1.2. Pregunta problematizadora 

Considerando lo anterior, se hace necesario la construcción de estrategias que permitan 

la movilización de los elementos claros y concretos que fortalezcan los modelos 

explicativos que utilizan los estudiantes, al momento de buscar explicar sus 

comprensiones sobre lo que están alcanzando durante las prácticas de ciencias 

naturales donde se hace uso del microscopio.  

En consecuencia, se parte de la siguiente pregunta: 

¿Cuál será el impacto sobre la enseñanza-aprendizaje de los fundamentos de la 

microscopía óptica usando las NTIC con énfasis en el procesamiento y análisis digital de 

la imagen con un grupo de estudiantes de pregrado en ingeniería de la Universidad 

Nacional de Colombia sede Medellín? 
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1.3. Justificación  

Desde su invento el microscopio ha acercado al hombre al descubrimiento del 

microcosmos en donde se desarrollan organismos a simple vista imperceptibles, 

permitiendo así dar explicación a una serie de sucesos que se desarrollan a su alrededor. 

Con los avances tecnológicos que ofrece cada época este instrumento se hace más 

sofisticado, permitiendo mejorar la calidad de las imágenes captadas por sus lentes.  

En el aula los estudiantes que se acercan al microscopio como herramienta para ver 

cosas pequeñas, se asombran con él, con lo que observan, pero, ¿Realmente ven al 

detalle lo que este instrumento les permite? ¿Desde la óptica reconocen como se ha 

formado la imagen? ¿Comprenden toda la información aportada por este instrumento? 

Para aclarar esas incógnitas y aportar en la clara interpretación de las imágenes que se 

forman a través del microscopio, logrando discriminar la información relevante de la que 

no, nace esta idea, con la que se busca proponer una estrategia metodológica que 

permita a los estudiantes relacionar conceptos teóricos de formación de imagen con la 

experimentación a través de la manipulación virtual mediante el uso de software. De esta 

manera se pretende despertar en los estudiantes curiosidad, creatividad, capacidad de 

crítica y habilidades propositivas argumentativas e interpretativas que  le permitan 

analizar y determinar con más precisión eso que el microscopio óptico común muestra 

Como estrategias de acercamiento al conocimiento biológico se propone que sean los 

estudiantes quienes se hagan participes de las acciones tendientes al desarrollo 

conceptual de las temáticas a partir de la metodología “Learning by doing”, donde la 

experimentación es el eje conductor del proceso de aprendizaje. Esta idea pedagógica 

surge del filósofo y educador norteamericano John Dewey y coincide con las propuestas 

de David Ausubel a la vez que se articula con la idea aristotélica de la educación activa 

que en otras palabras invita a que sean los estudiantes quienes hagan y aprendan a 

hacer, ideas que se conectan perfectamente con los estándares nacionales diseñados 

para la educación de nuestros jóvenes donde se pretende que ellos logren “saber y saber 

hacer”. 



Aspectos preliminares 22 

 

1.4. Antecedentes 

Desde la utilización del primer microscopio que abrió los ojos del hombre a un nuevo 

horizonte de seres vivientes, permitiéndole observar organismos de dimensiones 

extraordinariamente pequeñas y cuya existencia no se había siquiera sospechado, los 

progresos de la microscopia han sido continuos. Pero para los que se acercan por 

primera vez a ellos o los que lo hacen esporádicamente la información que este recurso 

ofrece se queda fundamentada en lo que superficialmente se observa. 

 

La microscopia sigue representando una de las pocas áreas de la ciencia en la que los 

aficionados y los científicos de avanzada pueden hacer que otros se interesen por sus 

trabajos ya que despierta y sacia la curiosidad que es la base de la formación científica y 

permite la asociación de lo que somos con lo que nuestro entorno nos ofrece. La 

utilización de este instrumento nos ayuda a acercarnos a conceptos de la biología y 

conceptos aplicados de física. La microscopía es la muestra del influjo del progreso 

técnico sobre el avance de la ciencia y sobre el establecimiento de nuevas concepciones 

y visiones del mundo que rodea al hombre y que llega más allá del alcance de sus 

sentidos. Ahora incluso podemos asociar diestramente las nuevas tecnologías 

informáticas y de comunicación (NTIC) con la microscopia, logrando diversificar y 

flexibilizar los alcances de este instrumento. 

El análisis digital de  las imágenes captadas a través de los microscopios convencionales 

o de los microscopios caseros permite al estudiante alcanzar conclusiones de asociación 

a las temáticas tratadas de manera teórica y procesar la información para el 

conocimiento básico de los fenómenos que ocurren alcanzando así el saber y el saber 

hacer. Pertusa (2003) destaca en su libro Técnicas de análisis de imagen: Aplicaciones 

en Biología, que “el análisis de la imagen es una técnica compleja que exige para su 

estudio de un planteamiento eminentemente práctico y que se beneficia del avance de 

los medios informáticos para la obtención de datos cuantitativos en imágenes 

microscópicas y macroscópicas”.  

El uso de las TIC como herramienta para mejorar la calidad, análisis e interpretación de 

las imágenes, supone un avance que permite tanto al curioso como al profesional darle 

desde el uso de técnicas básicas un mejor trato a la imagen, logrando que estas sean 
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más ilustrativas y obteniendo otro tipo de información como: datos numéricos, medición, 

segmentación, interpretación tridimensional y bidimensional, lo que eminentemente hará 

más eficaz la producción y análisis de la imagen. 

La integración de las TIC a  la enseñanza de las ciencias naturales específicamente a la 

biología, ha sido un proceso largo y tortuoso en el que las dificultades de uso al parecer 

no se han saldado, a continuación, la mirada de algunos autores respecto  esta situación. 

 M. García & Morcillo J.G. (2007) en su artículos los autores presentan la necesidad 

de integrar a la enseñanza de la biología las TIC y las dificultades que se presentan 

en regiones como Latinoamérica para hacerlo en contraste con lo que ocurre en 

países de la Unión Europea como Inglaterra. Resaltan que las  TIC permite la 

interactividad del estudiante con el saber. 

Para la aplicación práctica de las TIC, los  autores señalan que pueden usarse por 

ejemplo laboratorios virtuales con los que entre otros se permite: 

o Tener en cuenta las diferencias en el ritmo de aprendizaje de los alumnos a un 

nivel más profundo de lo que es posible en el laboratorio presencial (posibilidad 

de repetir las prácticas o alterar su secuencia, por ejemplo). 

o Desarrollar en los estudiantes habilidades y destrezas en el uso de las TIC. 

o Desarrollar una nueva forma de aprendizaje que estimule en los estudiantes el 

deseo por aprender e investigar, etc. 

 Joanne Orlando (2013) señala que las TIC se han introducido en las escuelas a nivel 

internacional, junto con la expectativa de que los maestros utilizarán prácticas 

constructivistas en su uso. Muchos docentes norteamericanos han integrado a su 

ejercicio laboral de enseñanza las TIC, sin embargo, la escuela y los factores 

sistémicos, así como las creencias fundamentales de los profesores sobre el 

aprendizaje, el mantenimiento de prácticas centrados en el profesor han bloqueado la 

adopción de prácticas constructivistas. 

El uso de las Nuevas TIC permite el desarrollo de un sinfín estrategias con las cuales el 

hombre busca practicismo para sus acciones cotidianas y espera con ello aumentar la 

eficacia en estas labores, Rodríguez R (2011) señala que “Los sistemas de visión 
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artificial o por computadora, tratan de englobar un conjunto de procedimientos 

relacionados con el procesamiento de imágenes, los cuales abarcan un sinfín de técnicas 

y herramientas matemáticas, físicas, computacionales y de ingeniería con aplicaciones 

en numerosos campos de la vida moderna” 

Buscando integrar un poco la microscopía a las nuevas tecnologías en los últimos años 

ha surgido el desarrollo de los llamados microscopios virtuales, estos son sistemas que 

permiten la captura de todo o parte de una muestra (por ejemplo citológica), el 

almacenamiento y su posterior visualización a diferentes aumentos, simulando un 

microscopio convencional. Con estos se busca hacer aproximaciones al entorno 

experimental desde los cuales los individuos (estudiantes) puedan desarrollar habilidades 

que les faciliten la interpretación, el análisis y la observación de muestras que pueden ser 

reales o diseñadas para tales fines. Respecto a ello algunos autores como Marín D y 

Romero E (2011) destacan que “Un microscopio es un sistema óptico que transforma un 

objeto en una imagen y amplifica (to magnify) sus detalles característicos. Cuando se 

habla de microscopía virtual, se introducen nuevos procesos, como la construcción de 

placas virtuales, su almacenamiento y el diseño de herramientas flexibles que permiten 

visualizar interactivamente dichas placas en diferentes ampliaciones. Para el trabajo en el 

aula escolar existen diferentes sitios en internet que permiten la interacción de los 

estudiantes con muestras simples a partir de los denominados laboratorios virtuales.  

1.5. Objetivos 

1.5.1 Objetivo general 

Elaborar una propuesta de la enseñanza-aprendizaje  de los fundamentos de la 

microscopía óptica usando las NTIC haciendo énfasis en el análisis y el procesamiento 

digital de las imágenes. 

 

1.5.2 Objetivos específicos 

 Diseñar e implementar los módulos de las prácticas para la enseñanza-aprendizaje 

de los fundamentos de la microscopía óptica haciendo uso de las NTIC. 



Aspectos preliminares 25 

 

 Aplicar la propuesta a un grupo experimental debidamente seleccionado de 

estudiantes de ingeniería de la Universidad Nacional de Colombia sede Medellín. 

 Evaluar el impacto de la propuesta aplicada al grupo experimental.
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2. Marco referencial 

 

2.1. Referente teórico 

2.1.1 Constructivismo y microscopía 

Aprender Haciendo, “Learning by Doing” en inglés, es una metodología de aprendizaje de 

raíz constructivista donde la atención está puesta en el estudiante; su propósito es que 

las dinámicas de aprendizaje del educando se den a raíz del desarrollo de posiciones de 

tipo constructivista de la enseñanza. De acuerdo con esta metodología el proceso 

enseñanza- aprendizaje va de la práctica a la teoría permitiendo el desarrollo del 

aprendizaje por etapas como lo propone Schwartz S. (1995) cuando habla del 

aprendizaje activo a partir del hacer, Tabla 1. 

Tabla 1: Descripción de las etapas del aprendizaje activo propuesto por  Schwartz S. (1995) 

Etapas En qué consiste 
Responsabilidades de 

los estudiantes 

Aprender sobre el 

aprendizaje 

Hacer 

Las tareas estimulan la actividad 
de los estudiantes (discusión de 
casos, proyectos comunitarios, 
análisis y resolución de 
problemas, simulaciones, juegos y 
dinámicas). 

Los estudiantes eligen 
y planean sus 
estrategias de trabajo. 

Se anima a los estudiantes a 
observar aspectos de su 
aprendizaje mientras están 
involucrados en las 
actividades. 

Revisar 

Los estudiantes se detienen para 
tomar conciencia de lo que ocurrió 
en el proceso, que fue importante, 
como se sintieron, etc. 

Los estudiantes 
monitorean su progreso 
y revisan su plan. 

Los estudiantes describen lo 
que observaron y revisan su 
aprendizaje (objetivos, 
estrategias, sentimientos, 
productos y contexto) 

Aprender 
Se explicitan las nuevas ideas y 
perspectivas que la actividad 
permitió generar. 

Los estudiantes 
pueden identificar por 
ellos mismos que es lo 
que aprendieron  

Identifican los elementos que 
afectan el progreso y proponen 
nuevas estrategias. 

Aplicar 

Se plantean acciones futuras a la 
luz de los nuevos hallazgos o 
conocimientos. Se examina la 
posibilidad de transferir lo 
aprendido a otras situaciones. 

Los estudiantes revisan 
sus planes tomando en 
cuenta sus 
aprendizajes recientes. 

Los estudiantes planean como 
continuar observando y 
experimentando. 
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Fuente: Adaptado de Watkins, 2003. Tomado de Schwartz, S y Pollishure, M. (1995). 

 

De acuerdo con  National Training Laboratories (1977), en el proceso de aprendizaje los 

estudiantes solo alcanzan un nivel de retención y de comprensión del 20% de lo que se 

ve, 20% de lo que se oye, 40% de lo que se ve y se oye contra el 80% de lo que se 

vivencia o se descubre. Este tipo de teorías refuerzan la idea de que la experimentación 

como alternativa de enseñanza potencia las habilidades de aprendizaje. 

La pedagogía contemporánea presenta muchas características que tienen relación con 

las ideas de John Dewey (1859-1952), filósofo y educador norteamericano quien fundó 

en EEUU, una escuela revolucionaria, cuya máxima era “Aprender Haciendo”. Esta 

metodología debía ser un programa de enseñanza práctico, centrado en la experiencia 

de los estudiantes y que implicara a la vez un hacer y una prueba. De acuerdo con este 

método se deben presentar para la enseñanza situaciones en las que los problemas se 

refieran a la vida común y se resuelvan haciendo uso de herramientas de la cotidianidad,  

Diagrama 1.  

 

Diagrama 1 “Aprender haciendo” John Dewey 
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Con base en lo anterior, considero que las ciencias naturales, específicamente la biología 

que está asociada a todo lo que hay en nuestro entorno podría fácilmente explicarse 

desde nuestras realidades; por ejemplo, el microcosmos que es sólo observable a través 

del microscopio debe estudiarse con estrategias donde nace el análisis digital de las 

imágenes como punto de partida, asociando este ejercicio a otras herramientas de las 

cotidianidad actual como lo son los computadores, las cámaras digitales, los celulares, 

tablas, etc, todas ellas componentes de las NTIC. 

En el siglo XXI “aprender haciendo” nos invita a hacer uso de todas la herramientas 

tecnológicas que hay a disposición para alcanzar las metas pedagógicas propuestas para 

la escuela de hoy, atrás quedaron la tiza y el tablero como únicas herramientas. Hoy, por 

ejemplo, para la comprensión de los procesos que se llevan a cabo en la célula, para el 

análisis morfológico y/o anatómico de los seres vivos en los que se requiere hacer uso de 

microscopio están a disposición innumerables alternativas. De acuerdo con Javier 

Martínez Aldanondo, especialista en formación de personas a través de la División 

Gestión del Conocimiento de Catenaria, publicó el año 2005 un artículo titulado “Los 7 

pecados capitales” del e-learning’ describiendo como el primer y más grande  de estos 

pecados, es creer que las personas aprenden escuchando o leyendo. Esto fue 

largamente detallado por Martínez, en el Seminario Edunet 2005, realizado en Santiago 

de Chile, afirmando que ya desde los griegos se sabía que “Lo que tenemos que 

aprender, lo aprendemos haciendo” (Aristóteles). 

Una de las motivaciones para el desarrollo de la propuesta fue la necesidad de superar 

los obstáculos materiales del poder de resolución y cantidad de microscopios disponibles 

para los estudiantes de biología general. Por otra parte, la utilización de microscopios en 

clase no siempre resulta satisfactoria por diferentes motivos: requiere de ciertas 

habilidades en el manejo de instrumental de laboratorio, e implica un cierto nivel de 

abstracción para la comprensión de las imágenes; por otra parte, se dificulta el trabajo 

grupal en la interpretación de lo que se observa, dado que los estudiantes sólo pueden 

observar los preparados individualmente y no ven necesariamente todos lo mismo (y no 

al mismo tiempo). 

Atendiendo las propuestas del Grupo de Didáctica de las Ciencias (GDC) el análisis 

digital de imágenes permite ejercitar la interpretación de estructuras tridimensionales a 
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través de imágenes bidimensionales (Díaz y Jiménez, 1996), tal como sucede con la 

realización por parte de los estudiantes de dibujos y diagramas. 

Al momento la cámara web se puede adaptar y utilizar para toma de fotos digitales a 

nivel microscópico. Como lo vienen realizando en escuelas de México, EEUU, y varios 

países europeos, en los denominados microscopios caseros  que haciendo uso de un 

software para la ampliación de imágenes permite la captación y análisis de las imágenes. 

Con la implementación de la “clase inversa” (flipped classroom), una de las metodologías 

activas más innovadoras actualmente, que presentan una clara relación con el uso de las 

TICs,  Bergman y Sams (2011) comprobaron que a medida que avanza un curso, los 

estudiantes se integraron mejor en la asignatura, se acostumbraron a pensar, cuestionar 

y, en definitiva, a pensar de una forma crítica. Es a partir de esto que M. García Irles et 

al, a través de materiales diseñados por ellos en los últimos años y de la utilización de los 

contenidos educativos disponibles en la web, propusieron utilizar las TICs en el 

aprendizaje de la Histología a través del diseño de diversas actividades basadas en la 

clase inversa; obtenido como resultado que se reforzaron y complementaron las practicas 

docentes, se respetó el tiempo que cada estudiante requiere para aprender y se 

promovió el trabajo colaborativo a través de la resolución de problemas. 

2.1.2. Las NTIC en la educación  

Las NTIC son las tecnologías promovidas en los avances de la informática (software, 

Internet, correo electrónico, bancos de información, etc.) y las telecomunicaciones 

(satélites, telefonías, fibras ópticas, televisión por cable y televisión por satélite). La 

llegada de estas a la educación ha generado nuevos espacios para la enseñanza. 

El desarrollo impetuoso de la ciencia y la tecnología ha llevado a la sociedad a entrar al 

nuevo milenio inmerso en lo que se ha dado en llamar "era de la información" e incluso 

se habla de que formamos partes de la "sociedad de la información". Sin lugar a dudas, 

estamos en presencia de una revolución tecnológica de alcance insospechado. 

Las NTIC o nuevas tecnologías para la información y las comunicaciones, se definen 

como "…Un conjunto de aparatos, redes y servicios que se integran o se integraran a la 

larga, en un sistema de información interconectado y complementario. La innovación 



Marco referencial 31 

 

tecnológica consiste en que se pierden la frontera entre un medio de información y otro". 

Estas NTIC conforman un sistema integrado por: 

 Las telecomunicaciones: Representadas por los satélites destinados a la transmisión 

de señales telefónicas, telegráficas y televisivas; la telefonía que ha tenido un 

desarrollo impresionante a partir del surgimiento de la señal digital; el fax y el modem; 

y por la fibra óptica, nuevo conductor de la información en forma luminosa que entre 

sus múltiples ventajas económicas se distingue el transmitir la señal a grandes 

distancias sin necesidad de usar repetidores y tener ancho de banda muy amplio. 

 La informática: Caracterizada por notables avances en materia de hardware y 

software que permiten producir, transmitir, manipular y almacenar la información con 

más efectividad, distinguiéndose la multimedia, las redes locales y globales 

(INTERNET), los bancos interactivo de información, los servicios de mensajería 

electrónica, etc. 

 La tecnología audiovisual: Que ha perfeccionado la televisión de libre señal, la 

televisión por cable, la televisión restringida (pago por evento) y la televisión de alta 

definición. 

El impacto social de las NTIC toca muy de cerca a escuelas y universidades, propiciando 

modificaciones en las formas tradicionales de enseñar y aprender. Sin embargo, es 

perfectamente posible distinguir en Colombia tres grupos de instituciones escolares: las 

que poseen los recursos económicos para adquirir la tecnología y un desarrollo 

profesional de sus docentes que les permita llevar a cabo una verdadera transformación 

en la forma de enseñar; las que aun teniendo la posibilidad de adquirir la tecnología 

carecen de un claustro preparado para darle un correcto uso educacional; y finalmente la 

gran mayoría de instituciones que carecen de recursos económicos para renovar su 

parque tecnológico al ritmo que impone el desarrollo de éste. 

Si nos atenemos al hecho evidente de que el avance incesante de la tecnología no 

parece tener freno, el reto de los centros educacionales y en particular de las 

universidades radica en prepararse como institución y preparar a su vez a sus educandos 

y educadores a adaptarse a los cambios de manera rápida y efectiva con un mínimo 

gasto de recursos humanos y materiales. Entre las claves fundamentales para el éxito 

está lograr que el aprendizaje se convierta en un proceso natural y permanente para 
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estudiantes y docentes. Es necesario aprender a usar las nuevas tecnologías y usar las 

nuevas tecnologías para aprender. 

Es tarea de los educadores utilizar las NTIC como medios para proporcionar la formación 

general y la preparación para la vida futura de sus estudiantes, contribuyendo al 

mejoramiento en el sentido más amplio de su calidad de vida. 

2.2. Referente disciplinar 

El uso de los microscopios tradicionalmente se hace bajo observación directa de la 

imagen bien sea mediante el uso solo del ojo o a través de cámaras, por ejemplo 

acopladas a un PC (computador personal).  Los profesionales que usan este instrumento 

adquieren mucha destreza en el manejo del mismo y en el uso de diferentes técnicas 

(microscopía de campo claro, microscopía de campo oscura, microscopía de 

interferencia,  microscopía de polarización,…) pero en general carecen de la 

comprensión de los conceptos físicos involucrados; adicionalmente en la mayor parte de 

los casos  no están capacitados para realizar un análisis profundo de la información que 

trae una imagen.    

En este trabajo se diseña e implementa una propuesta de enseñanza-aprendizaje de la 

microscopía óptica a través de un buen análisis de la fundamentación óptica tanto en 

todo el recorrido de la luz en el instrumento como en el análisis de la imagen resultante, 

las posibles transformaciones sobre ésta y las limitaciones  del ojo para su detección. La 

metodología se apoya en el uso de las denominadas NTICs (Nuevas Tecnologías en la 

Información y las Comunicaciones) tanto en lo referente al hardware como al software 

2.2.1. El microscopio simple  

El microscopio es un instrumento de observación directa y no de proyección. Por lo tanto 

como el ojo normal sólo  enfoca sobre la retina haces divergentes o paralelos, se deduce 

que la imagen final que debe entregar un microscopio debe ser virtual. 

 

Debido a la agudeza visual del ojo, cuanto más se acerca un objeto al ojo mayor será su 

ángulo aparente con que se le observa, mayor  es el área de la retina cubierta por la 

imagen y mayor serán los detalles que se pueden observar del objeto, pero sin acercarlo 
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una distancia menor al denominado punto próximo (25 cm), Figura 1. En este punto la 

imagen alcanza su máximo tamaño en la retina y aún se percibe con  nitidez. En la 

Figura 1 se ilustra cómo cuando el objeto se acerca más que el punto próximo no se 

logra enfocar la imagen en la retina.  

 

Figura 1: Punto  próximo del ojo 

Una lente convergente puede conseguir que la imagen de un objeto se vea ampliada, y, 

por lo tanto, verla bajo un ángulo aparente mayor. Esta lente recibe el nombre de lupa o 

microscopio simple, Figura 2: su función es proporcionar una imagen virtual, de mayor 

tamaño que el objeto  y derecha de los objetos cercanos, por lo tanto el objeto se debe 

colocar entre el foco objeto de la lupa y ésta, Figura 3. La amplificación máxima se 

produce cuando el objeto está en el foco.  

 

 

Figura 2: Lupa 
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Figura 3: Formación de la imagen usando una lupa 

El aumento angular se define como la relación entre el ángulo visual de la imagen en la 

retina cuando se ve a través de la lupa y el ángulo visual de la imagen en la retina 

cunado se ve con el ojo desnudo  a la distancia del punto próximo (25 cm = 0,25 m): 

 

'

a

θ
M  =                       [1]

θ
 

 

Bajo aproximación paraxial se obtiene, 

a

y'
0,25 y'LM  =  = 

y L y

0,25

 

Recordando que el aumento lateral para lentes es, 

L

y' s'
M  =  =     

y s
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en donde s y s’ son la respectivas distancia objeto y distancia imagen, f’ la distancia focal 

imagen, se obtiene, 

a

0,25 s'
M  = 

L s
 

a '

0,25 s'
M  = 1 - 

L f

 
 
 

 

Si se ubica el objeto en el punto focal la imagen virtual da en el infinito (-∞) y al ecuación 

anterior se transforma en, 

a '

0,25
M  =  = 0,25 P                 [2]

f
 

siendo P la potencia de la lente  en dioptrías. En esta situación los rayos son paralelos y 

el ojo ve la escena en una configuración relajada, es decir, sin acomodación, una 

característica ideal para la buena observación. 

Si una lupa  es 2,5 X, significa que la imagen en la retina es 2,5 veces mayor con el 

objeto a la distancia focal de la lupa que lo que sería si el objeto estuviera en el punto 

próximo del ojo desnudo. Esta lupa según la ecuación [2] tendría una potencia de 10 

dioptrías, es decir una distancia focal de 10 cm.    

2.2.2. El microscopio compuesto  

En la Figura 4 se representa el diagrama esquemático de un microscopio compuesto. 

Consta de dos lentes convergentes. La lente más próxima al objeto se denomina 

objetivo, forma una imagen real, invertida y de mayor tamaño que el objeto. La lente 

más próxima al ojo se denomina ocular y permite observar la imagen formada por el 

objetivo (logra que veamos la imagen del objetivo con un ángulo aparente mayor que si el 

objeto estuviera en el punto próximo del ojo). La imagen final dada por el microscopio es 

virtual, invertida (derecha respecto a la imagen del objetivo)  y de mayor tamaño: la 

imagen final después de pasar por el ojo se forma en la retina. 
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El microscopio se utiliza para observar objetos de pequeño tamaño que están cercanos. 

El objeto que se desea examinar se coloca delante del objetivo, a una distancia 

ligeramente superior a la distancia focal, y su imagen se forma dentro de la distancia 

focal del ocular, Figura 4: lo mejor es ubicar el ocular de manera que la imagen formada 

por la lente objetivo (y1’) caiga sobre el punto focal de ella, F2, es decir con enfoque al 

infinito. En la Figura 4 (arriba) está un poco más cerca de la lente y en la Figura 4 (abajo) 

está con enfoque al infinito. Cuando una imagen se forma en el foco, F2, la luz emerge 

del ocular en forma de un haz de rayos paralelos y forma la imagen en el infinito, pero el 

ojo, sin esfuerzo de acomodación, la concentra en la retina.  

La distancia d entre el punto focal imagen del objetivo F’1 y el punto focal objeto del 

ocular F2 se llama longitud del tubo. En los microscopios tiene un valor fijo: 16 cm. 

Aumento del microscopio 

El poder amplificador del microscopio (M) es el producto de la amplificación lateral del 

objetivo por la amplificación angular del ocular: 

   aobjetivo ocular
M = M x M              [3]  

El aumento lateral de la lente objetivo es,  

 
'

1

objetivo

y
M  = 

y
 

con base en la propiedad de triángulos semejantes, se obtiene, 

 
'

1

objetivo
1

y d
M  =  =                        [4]

y f
 

El aumento angular  del ocular es, ecuación  [2], tomando como referencia el punto 

próximo del ojo es, 

a

2

0,25
M  = 

f
 

Por lo tanto el aumento del microscopio es, 
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1 2

0,25 d
M=                                      [5]

f  f
 

 

Figura 4: Esquema del fundamento óptico de un microscopio 
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La Tabla 2 indica los aumentos logrados con diferentes objetivos. 

Tabla 2: Aumentos de un microscopio con diferentes configuraciones 

 Objetivo f1 

en mm 

Aumento 

objetivo 

para d=16 

cm 

Aumento total 
Distancia de 

trabajo en 

mm 
Ocular 5x Ocular 10x Ocular 15x 

50 3,2 16 32 48 30 

25 6,4 32 64 96 14 

16 10 50 100 150 8 

8 20 100 200 300 2 

4 40 200 400 600 0,5 

2 80 400 800 1200 0,2 

Apertura numérica del objetivo y poder de resolución 

El poder de resolución de un microscopio por lo general depende del diseño del 

objetivo. Un objetivo capaz de aprovechar un gran cono angular de luz procedente de la 

muestra, tendrá mejor poder de resolución que un objetivo limitado a un cono de luz más 

pequeño. El poder de resolución de un objetivo (distancia mínima, dmin, que debe existir 

entre dos puntos del objeto para que se puedan visualizar como dos puntos separados) 

es, 

 
0

min

λ
d =0,61                            [6]

A.N.
 

en donde A.N. corresponde a la apertura numérica del objetivo, 

A.N. = n sen θ                              [7]  

El poder de resolución es inversamente proporcional a la A.N. del objetivo. Como indica 

la fórmula [6], existen tres métodos para aumentar el poder de resolución o, lo que es lo 

mismo, para disminuir la distancia resoluble dmin.  El primer método consiste en la 

disminución de la longitud de onda 0λ , el segundo en aumentar el ángulo θ  en el 

espacio objeto  y el tercero en el incremento del índice de refracción en el espacio objeto. 

Trabajando con filtros selectivos, la longitud de onda puede disminuirse acercándose al 

extremo del espectro de la longitud de onda violeta o corta. Por medio de una óptica y 

técnicas especiales, este efecto puede extenderse a la longitud de onda ultravioleta, a fin 
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de disminuir aún más los límites factibles de definición. La posibilidad de aumentar el 

ángulo θ   al máximo teórico de los 90°, (o sea, A.N. = 1,00) se ve limitada en la práctica. 

La lente apocromática de A.N. 0,95 proporciona el valor θ  más alto que todavía resulta 

útil. Valores de A.N. más altos de 0,95 se consiguen por medio de líquidos de inmersión y 

que correspondería tercer método de disminuir la distancia resoluble: los denominados 

"objetivos de inmersión” en los cuales se aplica un líquido entre el portamuestras y la 

lente frontal del objetivo. El líquido de inmersión suele ser aceite (n= 1.52) aunque 

también suelen aplicarse de vez en cuando agua (n = 1.33) y bromuro de naftalina (n= 

1.66).  

En realidad no hay un límite máximo de aumentos en un microscopio, sólo existe un 

límite en cuanto al denominado aumento útil. La limitación fundamental no consiste en el 

aumento sino en el poder de resolución, o sea, la capacidad del microscopio de visualizar 

los detalles más finos del objeto. Una vez que la imagen se ha aumentado hasta el punto 

en donde la imagen se vuelve borrosa, el hecho de aumentar la imagen aún más 

producirá, debido al límite del poder de resolución, una imagen de tamaño más grande, 

pero también más borrosa y sin visualización de más detalles. Este tipo de incremento 

inútil del aumento se llama "aumentos vacíos”, indicando que se trata de aumentos más 

allá del límite útil en cuanto a la reproducción fiel de los detalles finos.  

Una forma de estimar el aumento útil es calcular el aumento capaz de hacer que una 

separación de objetos igual al límite de resolución del microscopio dmin , ecuación [6], 

alcance aumentada el valor de 0,2 mm (200 000 nm) que es el límite de resolución del 

ojo:   

0
min

λ
d =0,61    

n senθ
 

Tomando,   

sen θ 1;  

0λ  = 550 nm

 

aceiten  = 1,50  
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Se obtiene 

min d  200 nm;  

y por lo tanto el aumento útil Mutil, 

util

200 000 nm
M = 1000                        [8]

200 nm
  

 

Haciendo un cálculo más general, 

util

min

0,2 mm
M  = 

d
 

util
0

0,2 mm
M  = 

λ
0,61

A.N

 

y tomando 0λ  = 550 nm se obtiene, 

 utilM   600  A.N.;  

En la práctica, con óptica bien corregida de aberraciones y que da buen contraste, se 

pueden lograr aumentos útiles de hasta 1000 veces la apertura numérica. Aumentos 

mayores solo logran disminuir el esfuerzo del ojo humano para observar los detalles de 

una imagen pequeña: en la práctica el aumento útil se calcula así, 

 utilM   1000  A.N.                       [9];  

Se denomina aumento vacío de la imagen de un objeto, aquel que por más ampliación 

que se haga de la imagen, utilizando oculares de mayores aumentos, se llega a un punto 

en que ya no se logran distinguir más detalles.  

La limitación fundamental no consiste en el aumento sino en el poder de resolución, o 

sea, la capacidad del microscopio de visualizar los detalles más finos del objeto. Una 

vez que el objeto se ha aumentado hasta el punto en donde la imagen se vuelve 
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borrosa, el hecho de aumentar el objeto aún más producirá, debido al límite del poder 

de resolución, una imagen de tamaño más grande, pero también más borrosa y sin 

visualización de más detalles. Este tipo de incremento inútil del aumento se llama 

"aumentos vacíos”, indicando que se trata de aumentos más allá del límite útil en cuanto 

a la reproducción fiel de los detalles finos. 

 

Área y profundidad de campo 

El área de campo corresponde al área de la muestra que se está viendo a través del 

microscopio: a mayor aumento menor área de campo, Figura 5. El poder penetrante o 

profundidad de campo expresa la cualidad de un objetivo de poder presentar 

perfectamente detalladas los diversos planos de una preparación sin variar la posición de 

enfoque: a mayor aumento menor profundidad de campo, Figura 6. Con aumentos 

medianos o grandes, al mover el tornillo micrométrico, podemos observar sólo pequeños 

espesores con nitidez, mientras que por encima y por debajo de esta zona la imagen se 

desvanece. Con aceite de inmersión la profundidad de campo es muy escasa 

 

Figura 5: Área de campo 
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Figura 6: Profundidad de campo 

 

 

Contraste 

Para muchos fines médicos y biológicos el límite de resolución de un microscopio y el 

aumento no son, sin embargo, los únicos parámetros importantes; en muchos casos el 

contraste lo es todavía más. En gran parte de los trabajos médicos y biológicos el objeto 

examinado consiste de células suspendidas en disolución acuosa, y las células tienen un 

índice de refracción muy poco diferente del agua que los rodea lo que dificulta obtener 

imagen de éstas  debido al bajo contraste: es inútil aumentar el poder de resolución de 

un microscopio, si debido a la falta de contraste, la imagen final conseguida es 

indistinguible de su entorno. Es aquí donde se hizo y se hace necesario desarrollar 

técnicas de microscopía óptica que resuelvan estas dificultades respecto al contraste.  

La técnica más básica es la de campo claro. Las otras han sido desarrolladas para lograr 

mejorar el contraste donde éste es muy bajo. Por ejemplo si la muestra, es decir el 

objeto, absorbe parcial o totalmente la luz se dice que es un objeto de amplitud y puede 

fácilmente observarse con la microscopía de campo claro tradicional, incluso con la 

ayuda de técnicas de tinción, la mayoría de las cuales matan las células. Pero hay 

objetos que no absorben la luz y se denominan objetos de fase: debido a que el ojo 

humano solo detecta diferencias de intensidad y de color, es necesario convertir cambios 

de fase en el objeto en diferencias de intensidad y es en estos casos donde es necesario 

desarrollar otras técnicas de microscopía óptica que se fundamenten, por ejemplo, en el 
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fenómeno de interferencia de la luz. En esta propuesta se analiza la técnica tradicional 

de microscopía de campo claro y técnicas que mejoran el contraste como la de campo 

oscuro lograda mediante el uso de filtros y la de polarización lograda mediante el uso de 

polarizadores. 

2.2.3. La imagen digital  

El procesamiento y análisis digital de imágenes es un área de la ingeniería que manipula 

y analiza la información contenida en una imagen digital mediante el uso de un 

computador. El procesamiento digital tiene como objetivo mejorar la calidad de la imagen. 

El análisis tiene como objetivo analizar e interpretar la información contenida. 

 

La mayor parte de los usuarios de esta tecnología manipula software de procesamiento y 

análisis de las imágenes digitales pero sin saber los principios que hay detrás de las 

manipulaciones del mismo, lo que los puede llevar a obtener imágenes con errores que 

podrían ser severos. Conocer los fundamentos de esta tecnología los capacita para 

innovar y para emplearla óptimamente y así mejorar en su desarrollo profesional. 

    

En esta propuesta de enseñanza de la microscopía óptica se tratan los conceptos 

básicos de la imagen digital y su manipulación (análisis y procesamiento) de una manera 

didáctica sin entrar de fondo en la matematización pero sin perder rigurosidad.  Para el 

caso del estudio de la microscopía en su forma moderna, no es posible aplicarla de 

manera eficiente y eficaz sino se recurreal DIP (Digital Image Processing). 

 

¿Qué es una Imagen digital? 

Si el dominio, valores (x,y) y el rango, valores de f(x,y) son continuos, la imagen es 

continua o análoga; si el dominio y el rango son discretos, la imagen es digital. 

 
Para convertir una imagen de tonos continuos en formato digital, la imagen análoga es 

dividida en valores de brillos individuales a través de dos procesos denominados 

muestreo (sampling) y cuantización (quantization), tal como se ilustra en la Figura 7. 

El muestreo es la partición del dominio, es decir los pixeles/pulgada que tiene la imagen: 

ver Figura 8 izquierda (hasta por cierto, una imagen con muy baja resolución espacial). 

La cuantización es la partición del rango, es decir el número de niveles de gris que se 
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usan para asignarles valores a cada pixel de la imagen: ver Figura 7 derecha (se realizó 

a 256 niveles de gris, de 0 a 255, lo cuales pueden ser representados en la pantalla de 

un computador utilizando un sistema de numeración binario, con 8 bits, 25628  ). 

 

 

Figura 7: Muestreo y cuantización de una imagen 

 

La resolución espacial de una imagen digital está relacionada con el muestreo y 

depende de: 

 La densidad espacial de los puntos (x,y) de la imagen (densidad de píxeles). El 

número de píxeles contenidos en una imagen digital y la distancia entre cada píxel 

(conocido como período de muestreo) está en función de la apreciación de los 

sensores del dispositivo de captura de la imagen. 

 La resolución óptica del dispositivo de captura de la imagen. 

Histograma 

Una vez definidas las resoluciones, puede hablarse del histograma de una imagen. Un 

histograma informa sobre el número de píxeles que hay para cada nivel de gris. 

Normalizado a la unidad, puede entenderse como la probabilidad de que un valor de gris 

determinado aparezca en la imagen. 

El histograma de una imagen es una herramienta visual de gran aceptación y utilidad 

para el estudio de imágenes digitales. Una simple mirada sobe él, puede proporcionar 

una idea muy aproximada de la distribución de niveles de gris, el contraste que presenta 

la imagen y alguna pista del método más adecuado para manipularla. 
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El histograma de una imagen digital con L niveles de gris en el rango [0, L-1] es una 

función discreta de la forma: 

  k
k

n
h r  =                         [10]

n
 

Donde rk  es el k-ésimo nivel de gris, nk  es el número de píxeles en la imagen con ese 

nivel de gris,  n  es el número total de píxeles de la imagen, k = 0, 1, 2, 3, …, L-1. 

Las intensidades o niveles de gris están representadas a lo largo del eje X  y el número 

de ocurrencias para cada intensidad se representan en el eje Y. Debe remarcarse que la 

frecuencia de aparición de cada nivel de gris en el histograma, se muestra siempre en 

forma relativa debido al hecho que el valor absoluto puede variar bastante en función del 

tamaño de la imagen, así como también puede variar el máximo valor a representar. 

La forma del histograma proporciona informaciones importantes como la intensidad 

media y la dispersión de los valores de nivel de gris, siendo esta última, la medida de 

contraste de la imagen. Cuanto mayor es la dispersión a lo largo del eje de los niveles 

de gris, mayor es el contraste de la imagen y es entonces cuando el sistema visual 

humano consigue una mejor respuesta en su apreciación de la imagen. 

En la Figura 8 se ilustran histogramas de algunas imágenes. En el histograma de la 

Figura 8-a, se puede observar como la probabilidad de los niveles de gris cercanos al 

negro es muy elevada con respecto al resto, lo que permite deducir que el histograma 

corresponde una imagen oscura y con poco contraste caracterizado por el bajo número 

de diferentes gris. En el histograma correspondiente a la Figura 8-b, se puede observar 

que tiene una forma estrecha, con los valores de probabilidad altos concentrados en 

unos pocos niveles de gris, lo que se traduce en una imagen clara con poco contraste. 

En el histograma de la Figura 8-c, se observa una alta probabilidad de niveles de gris 

cercanos al blanco, pero con niveles de gris más distribuidos, de lo que se deduce que 

corresponde a una imagen con un contraste intermedio. Por último, en el histograma que 

corresponde a la Figura 8-d se observa como la probabilidad de ocurrencia de cada uno 

de los niveles de gris está mejor repartida a lo largo de todos ellos, correspondiendo con 

una imagen de alto contraste. 
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Figura 8: Histogramas de algunas imágenes 

 

Operaciones básicas con imágenes digitales 

Sobre las  imágenes se pueden realizar operaciones aritméticas (sumar, restar, 

multiplicar,  dividir, potenciación y logaritmación), operaciones booleanas (and, or, xor, 

not) y morfológicas (erosión, dilatación, cierre, apertura). En las dos últimas operaciones 

las imágenes deben estar binarizadas (sólo dos valores de niveles de gris).  

 

Para realizar estas operaciones se operan los valores correspondientes (nivel de gris) 

píxel a píxel:  el valor del píxel (i, j) de una imagen fuente  se opera con el  valor del píxel 

(i, j) de la otra imagen fuente y el resultado se lo asigna como valor al píxel (i, j) de la 

imagen que representa el resultado. 

 

En la Figura 9 se ilustra el resultado de una dilatación en donde se observa cómo se 

ensancharon las líneas.  
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Figura 9: Un ejemplo de una operación morfológica 

Transformad de Fourier de una imagen 

La forma convencional de desplegar el espectro de Fourier (la transformada de Fourier) 

es en un sistema de coordenadas cartesiano con su origen en el en el centro de la 

“imagen del espectro”: en este plano los ejes son las frecuencias espaciales fx,  fy, ver 

Figura 10 derecha. 

 

 

Figura 10: Magnitud de la transformada de Fourier de una imagen 

En la Figura 11 se ilustra varias imágenes (columna izquierda), la magnitud del espectro 

de Fourier (columna central) y la fase del espectro (columna derecha). 

Representación de Fourier de una imagen 

Una imagen f(x,y) se puede expresar como una superposición de perfiles de imágenes 

armónicas (superposición de perfiles de ondas armónicas planas).  A cada perfil que 

compone la imagen se le denomina componente de Fourier y a su conjunto espectro 

de Fourier. No sólo la fase  de estos perfiles depende de las frecuencias espaciales 

(fx,fy) sino también su amplitud. En la Figura 12 se ilustra lo afirmado en este párrafo.   
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Figura 11: Transformadas de Fourier de algunas imágenes 

 

 

 

Figura 12: Representación de Fourier de una imagen 

 

Filtros espaciales sobre una imagen 

Hay técnicas de análisis de imágenes que actúan sobre áreas de la imagen: esto se hace 

mediante el uso de las denominadas máscaras o filtros espaciales a través de la 

operación de convolución en el dominio espacial, es decir actuando directamente 

sobre los pixeles de la imagen, 
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     g x,y  = f x,y h x,y                 [11]  

 
en donde f(x,y) es la imagen orignal, h(x,y) es el filtro o máscara y g(x,y) la imagen 

procesada. 

La convolución es simplemente una suma ponderada de píxeles en el vecindario del 

píxel fuente. Los “pesos” son determinados por una pequeña matriz h(x,y) llamada  

máscara de convolución, que determina unos coeficientes a aplicar sobre los píxeles 

de una determinada área de la imagen. Las dimensiones de la matriz son normalmente 

impares e iguales, de forma que se pueda determinar el centro de la matriz cuadrada. La 

posición del valor central se corresponde con la posición del píxel de salida y se calcula 

tal como se ilustra en la Figura 13. Luego se desplaza la máscara centrándola en el pixel 

siguiente y se repite la operación hasta terminar el recorrido por toda la imagen f(x,y): el 

resultado es la imagen procesada g(x,y). El proceso es bastante repetitivo, pero sencillo y 

eficaz. 

 

 

Figura 13: Operación de convolución de máscara con una imagen 

 

Los filtros espaciales pueden clasificarse basándose en su linealidad: filtros lineales y 

filtros no lineales. A su vez los filtros lineales pueden clasificarse como: filtros paso 

bajo, filtros paso alto y filtros paso bajo. Los paso bajo atenúan las zonas de alto 

contraste (bordes o detalles muy marcados de la imagen) y alteran muy poco las zonas 

de bajo contrate, estas zonas son las representativas de las regiones lentamente 

variables de la imagen, por lo tanto el contraste y la intensidad de la imagen quedaran 

uniformizados después del filtrado, eliminando en algo el ruido de fondo. Los paso alto 

atenúan las zonas de bajo contraste y alteran muy poco las zonas de alto contrate, 



Marco referencial 50 

 

resaltándose los borde y los detalles muy marcados o finos de la imagen y los paso 

banda afectan zonas intermedias de contraste. La forma de operar de los filtros lineales 

es a través de la convolución. 

Los filtros espaciales no lineales también operan sobre entornos. Sin embargo, su 

operación se basa directamente en los valores de los píxeles en el entorno en 

consideración. Unos ejemplos de filtros no lineales habituales son los filtros mínimo, 

máximo y de mediana que son conocidos como filtros de rango.  

Otra clasificación de los filtros espaciales puede hacerse basándose en su finalidad, y así 

se tienen los filtros de realce (Sharpening) para eliminar zonas borrosas o filtros de 

suavizado (Smoothing) para difuminar la imagen. También se tienen los filtros 

diferenciales que se caracterizan por el tipo de máscaras (Laplaciano, Prewitt, Sobel, 

etc.), y se utilizan para la detección de bordes. El proceso de detección de bordes se 

basa en realizar un incremento del contraste en las zonas donde hay una mayor 

diferencia entre las intensidades, y en una reducción de éste donde tenemos poca 

variación de intensidad.  

Filtros frecuenciales sobre una imagen 

En el domino espacial el procesamiento de las imágenes se hace convolucionando  el 

filtro h(x,y) con la imagen original f(x,y) obteniéndose la imagen trasnformada g(x,y), 

ecuación [11], 

      g x,y  = f x,y h x,y  
 

El teorema de la convolución dice que en el dominio de las frecuencias (dominio de 

Fourier) ese proceso se hace con el producto de las TF (Transformadas de Fourier),
 
 

 

           g x,y  = f x,y h x,y              G fx,fy  = F fx,fy  H fx,fy       [12]       
 

En donde G es la TF de g, F la TF de f y H la TF de h. Esta es la base de las técnicas 
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de procesamiento de las imágenes en el dominio de las frecuencias. 

 

En la terminología de sistemas lineales, la transformación H(fx,fy) se denomina la 

función de transferencia del proceso. En óptica H(fx,fy) se denomina la función de 

transferencia óptica, y su magnitud es la modulación de la función de transferencia. 

En una aplicación típica de mejora de la imagen, f(x,y) es conocida y el objetivo, después 

de calcular F(fx,fy), es seleccionar H(fx,fy) de forma que la imagen deseada, que es la 

transformada de Fourier inversa (
1 ) de H(fx,fy)F(fx,fy), es decir, 

   1g(x,y)  H fx,fy  F fx,fy          [13]      

presente resaltada alguna característica de f(x,y). Por ejemplo, se pueden acentuar los 

bordes de f(x,y) empleando una función H(fx,fy) que ponga énfasis en las componentes 

de alta frecuencia de F(fx,fy). En la Figura 14 se ilustra lo dicho. 

 

Figura 14: (a) Proceso (filtrado) en el dominio espacial y (b) Proceso (filtrado)  en el dominio de la 
frecuencia 

Basándose en el teorema de convolución (convolucionar las funciones en el dominio 

espacial es igual que multiplicar sus espectros en el dominio frecuencial) el proceso del 

filtrado en el dominio de las frecuencias se realiza siguiendo los siguientes pasos,  

 Transformar los datos de la imagen al dominio frecuencial mediante la transformada 

de fourier.  

 Multiplicar el espectro de la imagen con alguna máscara de filtrado. 
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 Transformar el espectro de vuelta al dominio espacial empleando la transformada de 

Fourier inversa. 

Hay muchos tipos de filtros pero la mayoría es una derivación o una combinación de 

cuatro tipos básicos: paso bajo, paso alto, paso banda, y banda eliminada. Los filtros 

paso banda y banda eliminada se pueden crear por la sustracción apropiada y la adición 

de las respuestas en frecuencia de los filtros paso bajo y paso alto. El filtro paso bajo 

deja pasar frecuencias bajas mientras que atenúa las frecuencias más altas. Los filtros 

paso altos atenúan las frecuencias bajas y dejan pasar frecuencias más altas. Los filtros 

paso banda permiten una banda específica de frecuencia. 

 

Software a emplear 

OrquídeaJAI 

Calculadora digital de imágenes con copyright para Diego Luis Aristizábal Ramírez, 

docente de la escuela de Física de la Universidad nacional de Colombia sede Medellín. 

Este docente es el que asesora esta propuesta de enseñanza-aprendizaje de la 

microscopía óptica. 

 

El software con su tutorial se encuentra en el siguiente link: 

http://ludifisica.medellin.unal.edu.co/index.php/software-hardware/orquiedajai 

 

ImageJ 

Es un software de análisis y procesamiento digital de imágenes de dominio público y 

desarrollado por National Institutes of Health. El software y su documentación se 

encuentran en el siguiente link: 

http://rsb.info.nih.gov/ij/index.html 

 

Un buen tutorial se encuentra en: 

http://rsbweb.nih.gov/ij/docs/guide/146-1.html#toc-Section-1 

http://ludifisica.medellin.unal.edu.co/index.php/software-hardware/orquiedajai
http://rsb.info.nih.gov/ij/index.html
http://rsbweb.nih.gov/ij/docs/guide/146-1.html#toc-Section-1
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2.3. Referente didáctico 

En la presente propuesta se hace referencia a las siguientes leyes y disposiciones 

originadas desde algunos organismos institucionales que dan línea y caracterizan las 

condiciones que debe tener la educación global y nacional. 

En la Declaración Universal de los Derechos Humanos, referente a la educación se 

encuentra que el derecho a la educación forma parte esencial de los derechos culturales 

contemplados en el artículo 26 y 27, pues entre dichos derechos figura que “toda persona 

tiene derecho a la educación. La educación debe ser gratuita, al menos en lo 

concerniente a la instrucción elemental y fundamental. La instrucción elemental será 

obligatoria. La instrucción técnica y profesional habrá de ser generalizada; el acceso a los 

estudios superiores será igual para todos, en función de los méritos respectivos” y “el 

derecho de acceso a la cultura y al patrimonio cultural propios y de la humanidad, así 

como de participar y disfrutar de ellos, incluido el derecho de beneficiarse del progreso 

científico y tecnológico”. En efecto, según el Comité de los Derechos Económicos, 

Sociales y Culturales (CESCR) de las Naciones Unidas, "el derecho de toda persona a 

participar en la vida cultural está intrínsecamente vinculado al derecho a la educación, 

por medio de la cual los individuos y las comunidades transmiten sus valores, religión, 

costumbres, lenguas y otras referencias culturales, y que contribuye a propiciar un 

ambiente de comprensión mutua y respeto de los valores culturales"   

La Constitución Política Colombiana de 1991, en los artículos 67, 68 y 69, con respecto a 

la educación declara que: 

ARTÍCULO 67. La educación es un derecho de la persona y un servicio 

público que tiene una función social; con ella se busca el acceso al 

conocimiento, a la ciencia, a la técnica, y a los demás bienes y valores de la 

cultura. 

La educación formará al colombiano en el respeto a los derechos humanos, a 

la paz y a la democracia; y en la práctica del trabajo y la recreación, para el 

mejoramiento cultural, científico, tecnológico y para la protección del 

ambiente. 
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Corresponde al Estado regular y ejercer la suprema inspección y vigilancia de 

la educación con el fin de velar por su calidad, por el cumplimiento de sus 

fines y por la mejor formación moral, intelectual y física de los educandos; 

garantizar el adecuado cubrimiento del servicio y asegurar a los menores las 

condiciones necesarias para su acceso y permanencia en el sistema 

educativo. […] 

ARTÍCULO 68. La enseñanza estará a cargo de personas de reconocida 

idoneidad ética y pedagógica. La Ley garantiza la profesionalización y 

dignificación de la actividad docente.  […] 

ARTÍCULO 69. El Estado fortalecerá la investigación científica en las 

universidades oficiales y privadas y ofrecerá las condiciones especiales para 

su desarrollo.  

El Estado facilitará mecanismos financieros que hagan posible el acceso de 

todas las personas aptas a la educación superior.  

Es así como se le da reconocimiento a la educación en ciencia y tecnología como 

eje básico y transversal que apunta a la formación de los estudiantes.  

La Ley 115 de 1994 (Ley General de Educación), de conformidad con el artículo 67 de la 

Constitución Política, define y desarrolla la organización y la prestación de la educación 

formal en sus niveles de preescolar, básica (primaria y secundaria) y media, no formal e 

informal. 

Ley 115 de 1994- Ley General de Educación. Ordena la organización del Sistema 

Educativo General Colombiano. Esto es, establece normas generales para regular el 

Servicio Público de la Educación que cumple una función social acorde con las 

necesidades e intereses de las personas, de la familia y de la sociedad. Respecto a la 

Educación Superior, señala que ésta es regulada por ley especial, excepto lo dispuesto 

en la presente Ley. "Excepto en lo dispuesto en la Ley 115 de 1994, sobre Educación 

Tecnológica que había sido omitida en la Ley 30 de 1992. Ver Artículo 213 de la Ley 115. 

En la Resolución 2343 de 1996 se encuentran los siguientes indicadores de logros 

curriculares por conjuntos de grados para los distintos niveles de la educación formal, 

establecidos de acuerdo con lo dispuesto en la Ley 115 de 1994, sin embargo estos no 
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se alejan de lo que se espera para la formación en educación no formal (Universitaria) en 

áreas de la ciencia, por tal motivo considero que algunos de los indicadores que se 

proponen también se vinculan claramente con la ejecución de este proyecto. Algunos de 

estos indicadores son: 

 Elabora preguntas con base en su propio conocimiento teórico y no 

simplemente sobre sucesos aislados. 

 Muestra curiosidad por conocer objetos y eventos del mundo y explorar temas 

científicos. 

 Manifiesta inquietudes y deseos de saber acerca de temas teóricos, 

ambientales y tecnológicos. 

 Se documenta para responder sus propias preguntas y formular otras nuevas. 

 Interpreta, trata y ofrece posibles respuestas a los problemas que él mismo 

plantea, a los que plantea el profesor o a los que encuentra en su entorno o en 

algún momento. 

 Plantea y realiza experimentos para poner a prueba sus propias hipótesis, las 

de sus profesores y compañeros. 

 Plantea con relativa solvencia problemas de las ciencias naturales, teniendo en 

cuenta las implicaciones derivadas de la aplicación de una determinada teoría 

científica. Plantea una necesidad práctica en términos de un problema 

ambiental, tecnológico y propone y discute soluciones alternativas, 

fundamentándose en esquemas explicativos. . 

 Describe invenciones, sucesos y eventos cuyos efectos científicos y 

tecnológicos han redundado en grandes beneficios para la humanidad o han 

causado grandes catástrofes y argumenta sobre las consecuencias positivas y 

negativas de dichos sucesos.  

Para el área de ciencias naturales el  Instituto Colombiano para la Evaluación de la 

Educación antes Instituto Colombiano para el Fomento de la Educación Superior. 

(ICFES) propone que para la formación en el contexto nacional, el Fundamento 

Conceptual para Ciencias Naturales donde se consideran algunos puntos de interés para 

esta propuesta, estos son: 
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 “La adquisición y generación de los conocimientos científicos y técnicos más avanzados, 

humanísticos, históricos, sociales, geográficos y estéticos, mediante la apropiación de 

hábitos intelectuales adecuados para el desarrollo del saber”. 

 “El acceso al conocimiento, la ciencia, la técnica y demás bienes y valores de la cultura, 

el fomento de la investigación y el estímulo a la creación artística en sus diferentes 

manifestaciones”. 

 “El desarrollo de la capacidad crítica, reflexiva y analítica que fortalezca el avance 

científico y tecnológico nacional, orientado con prioridad al mejoramiento cultural y de la 

calidad de la vida de la población, a la participación en la búsqueda de alternativas de 

solución a los problemas y al progreso social y económico del país”. 

“La formación para la promoción y preservación de la salud y la higiene, la prevención 

integral de problemas socialmente relevantes, la educación física, la recreación, el 

deporte y la utilización adecuada del tiempo libre”. 

La Ciencia y la Tecnología, como cualquier otra actividad del quehacer diario de nuestra 

nación posee una reglamentación, esta reglamentación se elaboró en cumplimiento de 

un mandato constitucional contenido en el artículo 71 de la Constitución colombiana de 

1991 que reza “La búsqueda del conocimiento y la expresión artística son libres. Los 

planes de desarrollo económico y social incluirán el fomento a las ciencias y, en general, 

a la cultura. El Estado creará incentivos para personas e instituciones que desarrollen y 

fomenten la ciencia y la tecnología y las demás manifestaciones culturales y ofrecerá 

estímulos especiales a personas e instituciones que ejerzan estas actividades.”  

En nuestro país la Ley 29 de febrero de 1990 le otorga al estado Colombiano la 

responsabilidad de promover y orientar el adelanto científico y tecnológico y lo obliga a 

incorporar la Ciencia y la Tecnología a los planes y programas de desarrollo económico y 

social del país y a formular planes de Ciencia y Tecnología tanto para el mediano como 

para el largo plazo. Además, establece los mecanismos de relación entre sus actividades 

de desarrollo científico y tecnológico y las que adelantan las universidades, la comunidad 

científica y el sector privado. Esta misma Ley le ordena al Ministerio de Hacienda, incluir 

en el presupuesto nacional las sumas necesarias para desarrollar la actividad científica 

en Colombia, además faculta a Colciencias para brindar exenciones y descuentos 

tributarios a aquellas entidades que adelanten actividades de C&T.  
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El plan de desarrollo de Antioquia se identifica con la expresión “Antioquia la más 

educada”, el gobierno departamental en cabeza de Sergio Fajardo (Gobernador) le 

apuesta  a la educación como eje para la consolidación del desarrollo, progreso y 

transformación de la región con el que se pretende dar solución a tres problemas 

centrales: las desigualdades sociales, la violencia y la corrupción. A continuación se cita 

un aparte de este proyecto político. 

El Plan de Desarrollo Departamental 2012-2015, Antioquia La Más Educada,  de acuerdo 

con lo expresado por el Gobernador Sergio Fajardo, la educaciones el eje para la 

consolidación del desarrollo pues a partir de ella se puede dar solución a los  problemas 

que aquejan al departamento, por esta razón se propone en la segunda línea de trabajo 

de la propuesta de esta administración a la “Educación como motor de transformación de 

Antioquia “entre las 7 líneas a desarrollar durante este gobierno. La propuesta 

departamental va en la siguiente dirección:  

LÍNEA 2 – LA EDUCACIÓN COMO MOTOR DE TRANSFORMACIÓN DE ANTIOQUIA. 

Desarrolla los elementos centrales de nuestro plan de desarrollo, plantea la educación 

como motor de transformación. Empezamos por definir que entramos al mundo de la 

política con la certeza de que el eje de la transformación de nuestra sociedad es la 

educación. Sin una educación de calidad para todos, las desigualdades sociales están 

destinadas a acrecentarse. En el departamento nuestra apuesta por la educación se verá 

reflejada en el diseño y ejecución de programas y proyectos que respondan a las 

necesidades particulares de cada subregión, con énfasis en los maestros y maestras, y 

en una infraestructura acorde con las necesidades y prioridades de cada subregión. La 

educación pública será una prioridad del gobierno.   

Aprendimos que la educación debe entenderse en un sentido amplio que trascienda los 

muros de los colegios. La Antioquia del siglo XXI debe ser la Antioquia en donde todas 

las personas tengamos espacio en el mundo maravilloso de la educación. Por eso vamos 

a construir Antioquia, la más educada, y en ella la cultura, el emprendimiento, la 

innovación, la ciencia y la tecnología tienen espacios preponderantes. […]. Las nuevas 

generaciones, en todas las regiones, reclaman una educación pertinente, de calidad. Por 

tanto, queremos universidades e instituciones de educación superior públicas, de calidad.
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Metodología 

En este trabajo se elabora una propuesta para la enseñanza  de la microscopía óptica 

mediante el uso de las nuevas tecnologías de la información y las comunicaciones 

(NTIC) haciendo énfasis en el procesamiento y análisis de las imágenes digitales. 

 

La propuesta se aplicó como prueba piloto en un curso extracurricular intensivo sobre 

microscopía óptica del cual participaron de forma voluntaria 10 estudiantes de ingeniería 

y un profesor todos ellos pertenecientes a la comunidad de la Universidad Nacional de 

Colombia sede Medellín. Es de anotar que dicho curso fue autorizado por el Consejo de 

la Facultad de Ciencias de la universidad y aunque los participantes lo realizaron con el 

único  interés de aprender, al final se les expidió un certificado de asistencia, Anexo G. 

 

El criterio que se consideró para la aceptación de los voluntarios participantes fue el 

haber cursado y aprobado el curso regular de Física de Ondas y Óptica impartido por la 

Escuela de Física de la universidad a los estudiantes de ingeniería. Se anota que los 

estudiantes participantes fueron alumnos en esa asignatura del profesor Diego Luis 

Aristizábal Ramírez quien es el asesor de éste trabajo final. 

 

La metodología empleada  es la de “aprender haciendo” que es de corte constructivista y 

siguiendo la perspectiva del aprendizaje activo donde de acuerdo con  Schwartz et al 

(1998), el profesor propone actividades que: 

- Potencien el desarrollo de ejercicios motivadores que generen agrado del estudiante 

por el tema a tratar. 

- Den solución a tareas como prerrequisito para la adquisición de nuevos 

conocimientos y/o el afianzamiento del conocimiento ya adquirido. 
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- Se desarrollen en grupos pequeños de trabajo, donde el aprendizaje sea 

colaborativo. 

3.1. Seguimiento de implementación de la propuesta 

Los pasos seguidos en el desarrollo de la propuesta se describen a continuación. 

3.1.1. Temas de lectura previa  

Se seleccionaron los temas sobre los cuales los participantes deben realizar  lectura 

previa. Estos temas están relacionados con los conceptos de la óptica aplicados en 

microscopía y sobre fundamentos de procesamiento y análisis digital de las imágenes. 

En la Tabla 3 se relacionan estos temas  de los cuales la mayor parte son de repaso para 

los participantes. Para facilitar el acceso a esta información de forma más depurada, se 

les envió vía correo electrónico con dos meses de antelación al inicio del curso una serie 

de documentos (5 módulos de enseñanza-aprendizaje)  preparados por el profesor Diego 

Aristizábal Ramírez)   y que son usados en los cursos básicos de enseñanza sobre 

Análisis de Señales y sobre Óptica que imparte la Escuela de Física de la universidad a 

sus estudiantes de Ingeniería Física. 

Tabla 3: Temas para estudio previo 

 
TEMA  

 

 
SUBTEMAS 

LA LENTE COMO SISTEMA 
FORMADOR DE IMÁGENES 

 ¿Qué es una lente? 
 Propiedades focales de las lentes 
 Imágenes formadas por una lente 
 Aplicación de la difracción a los Sistema Formadores de 

Imágenes 

LA LENTE DESDE LA ÓPTICA 
DE FOURIER 

 El teorema de Fourier 
 Difracción de Fraunhofer y la transformada de Fourier 
 La lente convergente realiza la transformada de Fourier  
 Teoría de Abbe de los sistemas formadores de 

imágenes. 
 Función de respuesta al impulso y formación de la 

imagen 

ELEMENTOS ÓPTICOS 
USADOS EN MICRSOCOPÍA 

 Fuente de luz 
 Filtros 
 Polarizadores 
 Material birrefringente 
 Retardadores 
 Colores de interferencia 
 Compensadores 

EL MICROSCOPIO   El ojo y la visión 
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 Microscopio simple 
 Microscopio compuesto 
 Objetivos y oculares 
 Aumento 
 Apertura numérica 
 Resolución 
 Área y profundidad de campo 
 Contraste 

TÉCNICAS BÁSICAS DE 
MICROSCOPÍA 

 Microscopía de campo claro 
 Microscopía de campo oscuro 
 Microscopía contraste por interferencia 
 Microscopía de contraste de fase 
 Microscopía de luz polarizada 
 Microscopía de contraste de fase por interferencia 

diferencial (DIC) 
 Microscopía de ultravioleta 
 Microscopía de fluorescencia 
 Microscopía confocal 
 ¿Qué es un microscopio electrónico? 

CONCEPTOS BÁSICOS DEL 
PROCESAMIENTO DIGITAL 
DE IMÁGENES 

 Propiedades básicas de la imagen digital 
 Operaciones básicas con imágenes digitales 
 Representación de una imagen: dominio espacial y 

dominio de frecuencias espaciales 
 Cálculo de la Transformada de Fourier de una imagen  
 Mejora de la imagen actuando en el dominio espacial: 

operaciones punto a punto 
 Mejora de la imagen actuando en el dominio espacial: 

operaciones de área 

3.1.2. Módulos de las prácticas  

Se diseñan e implementan los módulos correspondientes a las 5 prácticas 

experimentales que  realizarán los participantes en 6 sesiones bajo la metodología 

“aprender haciendo”. En la tabla 4 se indican estos módulos. 

Tabla 4: Módulos de las prácticas experimentales a realizar 

 
MÓDULO 

 

 
TÍTULO 

 
PRÁCTICA  

1 
 

OPERACIONES BÁSICAS DE LAS IMÁGENES USANDO ORQUIDEAJAI 

 
PRÁCTICA 

2 
 

PROCESAMIENTO DIGITAL DE IMÁGENES USANDO ORQUIDEAJAI: 
DOMINIO ESPACIAL 

 
PRÁCTICA 

PROCESAMIENTO DIGITAL DE IMÁGENES USANDO ORQUIDEAJAI: 
DOMINIO DE FRECUENCIAS 
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3 
 

 
PRÁCTICA 

4 
 

ESTIMACIÓN DE PARÁMETROS BÁSICOS EN MICROSCOPÍA 

 
PRÁCTICA 

5 
 

ANÁLISIS Y PROCESAMIENTO DIGITAL DE IMÁGENES CON IMAGEJ 

 

3.1.3. Selección de los participantes  

La selección de los participantes se hizo mediante invitación a los alumnos que estaban 

finalizando el curso de Física de Oscilaciones y Ondas  del grupo del profesor Diego 

Aristizábal del semestre 01 de 2014. En principio se invita a los estudiantes de Ingeniería 

Biológica pero debido al interés de otros estudiantes se dejó abierto para otras 

ingenierías.  

 

El requisito que se les impuso fue que sacrificaran tiempo de sus vacaciones intermedias 

para realizar un estudio previo sobre los temas señalados en la Tabla 6 (en su mayor 

parte repaso del curso de ondas y óptica que ya estaban terminando, pero orientado 

hacia la aplicación en microscopía) y que tuvieran suficiente tiempo disponible en el 

primer mes del semestre académico 02 del 2014 para realizar intensivamente el curso 

piloto. De esta forma se lograron seleccionar 10 estudiantes. Adicionalmente se unió al 

grupo un profesor de la Escuela de Geociencias. 

3.1.4. Descripción de las 6 sesiones-taller  

El curso se desarrolla a través de 6 sesiones tipo taller de duración 3 horas presenciales 

y 3 horas de trabajo extra. La parte presencial se realiza en el laboratorio de física de 

Ondas y Óptica de la Escuela de Física de la Universidad Nacional de Colombia sede 

Medellín con previa autorización de la dirección de dicha Escuela. A continuación se 

describen las actividades realizadas en las sesiones. 
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Sesión 1: 

Se presenta el grupo de trabajo, y se exhiben ante ellos los objetivos y programa de 

ejecución de esta propuesta.  Durante esta fase se indagó por asuntos como el programa 

académico al que pertenece cada participante, intereses que motivaron su participación 

en este proyecto, entre otras particularidades que permiten conocer algo de cada una de 

estas personas. Aquí también se formaron grupos de trabajo conformados por dos (2) 

participantes (hubo uno de tres) y se les asignó una mesa de trabajo equipada con un (1) 

computador personal que disponía de Internet y del software necesario para las 

actividades a realzar. También cada mesa de trabajo tenía los elementos ópticos (lentes, 

redes de difracción,  polarizadores, filtros, retardadores,…) que necesitaban manipular 

para comprender adecuadamente los temas tratados en las sesiones de trabajo.  

 

Se hace un repaso relacionado con los temas de los módulos de la Tabla 6 los cuales 

tuvieron aproximadamente dos meses (periodo de vacaciones intersemestrales) para 

estudiarlos con el debido detalle. Se debe recordar que este era un requisito para poder 

participar del curso. Aquí se resolvieron las dudas y se afinaron los conceptos orientando 

siempre las discusiones hacia el área de la microscopía.  

Esta sesión permitió indagar por los preconceptos de los estudiantes alrededor del tema 

a tratar y con base en esto se ajustaron los temas de relacionados con las siguientes 

sesiones. 

 

En parte presencial de las sesiones 2, 3, 4 y 6 se explican los temas con el debido detalle 

mediante exposición magistral y a través de actividades experimentales usando el 

computador; esto último busca que los participantes  adquieran la habilidad necesaria 

para desarrollar el taller en forma no presencial e individualmente. 

Sesión 2: Operaciones básicas de las imágenes usando OrquideaJAI 

Esta actividad consiste en desarrollar el taller del Anexo A denominado  Práctica # 1. 

Aquí se usa la calculadora de imágenes OrquideaJAI para  abordar las operaciones 

básicas con la imagen digital: análisis y variación de histogramas, operaciones 

aritméticas, operaciones booleanas, operaciones morfológicas. Adicionalmente se 
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generan imágenes patrón que serán de gran utilidad para abordar las siguientes sesiones 

del curso.  

 

Los temas tratados son: 

 Operaciones aritméticas con la imagen. 

 Mejoramiento de la imagen variando el histograma. 

 Binarización de la imagen. 

 Algebra booleana con la imagen. 

 Operaciones morfológicas con la imagen. 

 Generación de imágenes patrón. 

 

Sesión 3: Procesamiento digital de imágenes usando OrquideaJAI (Dominio 

espacial) 

Esta actividad consiste en desarrollar el taller del Anexo B denominado  Práctica # 2. 

Aquí se usa la calculadora de imágenes OrquideaJAI para  abordar el procesamiento 

digital de las imágenes bajo la teoría general de sistemas lineales en invariantes (LSI)  en 

domino espacial. Se diseñan e implementan filtros pasa-baja, pasa-alta y se analizan sus 

efectos sobre las imágenes.  

 

Los temas tratados son: 

 Teoría general de sistemas formadores de imágenes LSI en el dominio espacial. 

 Filtros espaciales paso bajo. 

 Filtros espaciales paso alto. 

Sesión 4: Procesamiento digital de imágenes usando OrquideaJAI (Dominio de las 

frecuencias) 

Esta actividad consiste en desarrollar el taller del Anexo C denominado  Práctica # 3. 

Aquí se usa la calculadora de imágenes OrquideaJAI para  abordar el procesamiento 

digital de las imágenes bajo la teoría general de sistemas lineales en invariantes (LSI)  en 

domino de las frecuencias. Se diseñan e implementan filtros pasa-baja, pasa-alta y se 

analizan sus efectos sobre las imágenes.  
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Los temas tratados son: 

 La transformada de Fourier 

 Teoría general de sistemas formadores de imágenes LSI en el dominio  de 

frecuencias 

 Filtros frecuenciales paso bajo 

 Filtros frecuenciales paso alto  

 Filtros frecuenciales pasa banda 

 

Sesión 5: Estimación de los parámetros básicos en microscopía 

Esta actividad consiste en desarrollar el taller del Anexo D denominado  Práctica # 4.  

En ésta se busca que los estudiantes adquieran el conocimiento de los componentes 

ópticos del microscopio con el debido detalle técnico, desde la resolución óptica de 

acuerdo a la configuración usada de éste hasta la resolución espacial de la cámara digital 

acoplada. También se busca que los estudiantes adquieran la capacidad de transformar 

un microscopio muy básico mediante el uso de elementos muy caseros, en uno que 

permita hacer técnicas de microscopía avanzadas para mejorar el contraste. 

 

En la Figura 15 se ilustra el microscopio usado para la práctica. Tiene tres objetivos: 4X 

(A.N. = 0,16), 10X  (A.N. = 0,25) y 40X (A.N. = 0,65). El ocular es de 10X. La cámara 

digital tiene una resolución de 0.3 Megapixeles (640x480 pixel=307 200 pixeles) y con 

dimensiones del área sensora igual a 4,8 mm x 3,6 mm. 

 

 
 

Figura 15: Microscopio usado en el curso piloto 
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Los temas tratados son: 

 Datos del microscopio a usar en esta práctica  

 Tipo de imagen dado por el microscopio óptico 

 Estimar el aumento 

 Estimar la resolución espacial 

 Estimar la frecuencia espacial de corte del  objetivo 

 Estimar la resolución espacial de la cámara digital  

 Estimar  el campo visual 

 Estimar el tamaño de objetos  microscópicos 

 Mejorando el contraste: microscopía de  campo oscuro 

 Mejorando el contraste: microscopía de polarización 

Sesión 6: Análisis y procesamiento digital de imágenes usando ImageJ 

Esta actividad consiste en desarrollar el taller del Anexo E denominado  Práctica # 5. 

Aquí mediante el uso de ImageJ se hace el procesamiento y análisis de imágenes 

digitales de forma más profesional. Se comienza haciendo un rápido recorrido sobre 

algunas utilidades de ImageJ como lo son el manejo de histogramas, manejo del color, 

visores 3D, manejo de algunos filtros. Se termina realizando análisis densitométricos y 

morfométricos sobre la imagen. 

 

Los temas tratados son: 

 ¿Qué es una imagen digital? Tipo y formato 

 Filtros Espaciales y convolución 

 Convolucionando la imagen con al PSF 

 Deconvolución de imágenes de sistemas ópticos 

 Filtros frecuenciales 

 Sobre el análisis de la imagen 

 Midiendo: morfometría 

 Midiendo: densitometría 
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3.2. Encuesta de evaluación del proceso (Anexo F). 

Durante la última sesión los estudiantes participantes valoraron la propuesta de 

ejecutada durante este curso extracurricular y a través de una encuesta plasmaron sus 

impresiones sobre la pertinencia, claridad, oportunidad y calidad de la misma. Los 

resultados de estas  actividades dan sustento al trabajo propuesto lo cual se mide de 

forma cualitativa, los participantes analizan los aportes a su proceso de aprendizaje y 

valoran la aplicación que el contenido de esta propuesta hace al avance y proyección que 

cada una de estas personas  tiene como profesional. 
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4. Resultados  

En la primera sesión de trabajo los participantes mostraron que habían preparado 

adecuadamente el material previo que se les había sugerido para poder ingresar al 

curso. Esto permitió hacer una muy buena inducción y definir claramente los temas que 

debían reforzarse en el desarrollo de las siguientes sesiones. 

Las sesiones 2, 3, 4 y 6 fueron muy similares en su desarrollo. El refuerzo teórico de los 

conceptos y la explicación de cómo enfrentar los talleres tuvo como resultado que los 

participantes resolvieran todos los retos que se planteaban en éstos. Cada taller mínimo 

exigió un trabajo personal de 3 horas para su solución.  

Sorprendente fue el grado de asimilación de los de los temas desarrollados en los 

talleres. Esto se detectaba a través de la indagación grupal cada que comenzaba una 

nueva sesión.        

En la sesión 6 es donde se logró detectar el impacto final de curso. Usando ImageJ, 

mostraron todos los participantes las habilidades adquiridas en el manejo de la imagen 

digital. Hicieron morfometría y densitometría de imágenes de muestras de células con 

gran calidad en sus resultados. Construyeron PSF (Pont Spread Function) y 

comprendieron que se podía usar para corregir las aberraciones ópticas del microscopio. 

Usaron con fluidez filtros espaciales y frecuenciales interpretando adecuadamente sus 

efectos  (ver anexo E).   

En la sesión 5 (práctica # 4) todos los participantes lograron transformar el microscopio 

básico en un microscopio que además de poderse hacer microscopía de campo claro, se 

pudiese hacer microscopía de campo oscuro y de polarización. Esto lo hicieron con 

material casero (gafas 3D de la que se usan para ver cine 3D, filtros de acrílico, pantallas 

de papel mantequilla). Con cada uno se disertaba de los efectos sobre la imagen al variar  
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el recorrido de la luz desde que parte de la fuente lumínica hasta llegar al medio de 

registro (cámara CCD o el ojo). Calcularon con éxito todos los parámetros básicos del  

microscopio: área y profundidad de campo,  aumento, frecuencia de corte, frecuencia de 

muestreo, tamaño ideal de pixel de la cámara CCD, frecuencia de muestreo de la imagen 

ya digitalizada para hacerle transformaciones. En las Figura 16, 17 y 18 se ilustran 

algunas imágenes obtenidas en esta práctica por algunos participantes.  

 

Figura 16: Imagen de un corte longitudinal de Lauraceae sp, Vistas al microscopio con objetivo 10X usando 

diferentes adaptaciones para lograr varias técnicas usadas en microscopia.  

 

Figura 17: Imagen granos de polen de la flor del San Joaquín Amarillo (Hibiscus sp), Vistas al microscopio 

con objetivo 10X usando diferentes adaptaciones para lograr algunas de las técnicas de microscopía 
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Figura 18: Imagen muestras de limo Rio Escondido San Jerónimo (Ant). Vistas al microscopio con 
objetivo 10X usando diferentes adaptaciones para lograr algunas de las técnicas usadas en 

microscopia 

 

El compromiso y entusiasmo de los estudiantes durante la ejecución del curso  fue alto, 

este se evidenciaba durante el desarrollo de cada sesión donde la asistencia y 

participación fueron nutridas. Incluso la propuesta logró despertar en algunos 

participantes ideas para proyectar en su quehacer profesional orientándolas hacia los 

temas aquí tratados. 

Aunque el curso los participantes lo realizaron con el único fin de aprender sobre el tema, 

se tramitó ante el Consejo de Facultad de Ciencias un certificado de participación al 

curso, el cual fue concedido como se muestra en el anexo G. 

Encuesta de evaluación del curso 

Al final de proceso los estudiantes fueron convocados para valorar la calidad y 

pertinencia del curso. A ésta cita asistieron ocho participantes quienes respondieron la 

encuesta (Anexo G) y sentaron sus impresiones sobre las actividades realizadas durante 

la ejecución de la propuesta. 

A continuación se muestra la Tabla 5, donde están unificadas las respuestas de los 

encuestados. 
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Tabla 5: Resultados de la encuesta  

Preguntas formuladas 
Opción 

% 
# de 

participantes 

¿El contenido del curso estuvo ajustado según sus 
expectativas? 

100 4 

80 3 

60 1 

40 0 

20 0 

¿El material del curso fue adecuado según sus 
expectativas? 

100 5 

80 2 

60 0 

40 1 

20 0 

¿El curso cambió su visión sobre las microscopía y sus 
técnicas? 

100 7 

80 1 

60 0 

40 0 

20 0 

¿El curso da herramientas que favorecen la innovación 
en el quehacer de la microscopía? 

100 6 

80 2 

60 0 

40 0 

20 0 

¿Los temas se trataron con la profundidad  necesaria 
para aportar una visión clara de los mismos? 

100 3 

80 3 

60 1 

40 1 

20 0 

¿Las herramientas que se usaron en este curso le han 
parecido útiles? 

100 6 

80 2 

60 0 

40 0 

20 0 

¿El curso recibido es útil para mi formación como 
ingeniero? 

100 7 

80 1 

60 0 

40 0 

20 0 

¿El desarrollo del curso se realizó de lo simple a lo 
complejo? 

100 6 

80 2 

60 0 

40 0 

20 0 

En general usted valora el curso en 

100 4 

80 4 

60 0 

40 0 

20 0 

¿Recomendaría a otros colegas o compañeros a 
realizar el curso? 

Si 8 

No 0 

Quizá 0 
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En la Figura 19 se ilustra la gráfica correspondiente a los resultados de la Tabla 5. 

 

 

Figura 19: Resultados de la encuesta 

Se observa del resultado de la encuesta el alto grado de satisfacción de los participantes 
respecto al curso. Se advierte que sólo 1 de los 8 encuestados, muestra cierto grado de 
descontento.
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5. Conclusiones y recomendaciones 

5.1. Conclusiones 

El objetivo general que consistió en elaborar una propuesta de enseñanza-aprendizaje de 

la microscopía óptica mediante el uso de las nuevas tecnologías de la información y las 

comunicaciones haciendo énfasis en el procesamiento y análisis digital de las imágenes 

se logró con resultados satisfactorios. Se diseñó e implementó material de alta calidad 

que permite la replicación sin mayores dificultades del curso piloto.  

  

Los módulos se diseñaron e implementaron para favorecer el aprendizaje bajo el lema 

“aprender haciendo”. Los estudiantes se acercaron bajo esta metodología de manera 

clara, fácil y practica a los conceptos teóricos y programas computacionales preparados 

para el desarrollo del curso. El proceso fue muy dinámico, enriquecedor y ameno: 

realmente los participantes disfrutaron. 

 

Las dos herramientas computacionales usadas, OrquideaJAI e ImageJ,  permitieron que 

los estudiantes lograran manipular e interpretar las imágenes digitales de forma muy 

profesional, reconociendo durante estas actividades los principios teóricos básicos en los 

que se fundamentan estos programas.  

 

Los participantes coincidieron en afirmar que a partir de lo tratado se habían despertado 

intereses personales para “jugar con la imagen” haciendo uso de las herramientas 

computacionales disponibles. Para los participantes fue muy grato lograr transformar el 

microscopio hacia tecnologías superiores usando sus conocimientos y con muy bajo 

costo. 
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5.2. Recomendaciones 

 

Las siguientes inquietudes que manifestaron los participantes (por escrito) se deberán 

tener en cuenta para mejorar la aplicación de la propuesta: 

 

 Tratar un poco más el tema de diseño de microscopios caseros. 

 Realizar un curso con más sesiones, donde la actividad práctica aumente para 

asimilar mejor el contenido. 

 Procurar que el curso se desarrolle en sesiones más frecuentes (algunas estuvieron 

muy “espaciadas”). 

 De ser posible incorporar dentro de los contenidos ejercicios o aplicaciones 

referentes a otras ciencias. 

 

Se anota que la propuesta fue diseñada e implementada para estudiantes de ingeniería 

que ya han cursado la asignatura de Física de Ondas y Óptica, que además tienen 

conocimientos de matemáticas avanzadas.  El reto es adecuar la propuesta a otros 

niveles de la educación como la básica secundaria. Este podría ser objetivo de otros 

trabajos finales de la maestría en Enseñanza de las Ciencias Exactas y Naturales. 
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Anexo A: Práctica # 1 

Operaciones básicas con las imágenes 
digitales usando Orquídea JAI 

 

Temas 

 Introducción 

 Operaciones aritméticas con la imagen 

 Mejoramiento de la imagen variando el histograma 

 Binarización de la imagen 

 Algebra booleana con la imagen 

 Operaciones morfológicas con la imagen 

 Generación de imágenes patrón  

 

 

Introducción 

 

En las tres primeras sesiones de este curso se empleará la calculadora de imágenes 

OrquideaJAI para  estudiar los conceptos básicos sobre el procesamiento digital de imágenes. 

En la primera sesión, que es la correspondiente a éste módulo, se abordarán las operaciones 

básicas con la imagen digital: análisis y variación de histogramas, operaciones aritméticas, 

operaciones booleanas, operaciones morfológicas. Adicionalmente se generarán imágenes 

patrón que serán de gran utilidad para abordar las siguientes dos sesiones del curso. En la 

segunda sesión se abordará la teoría general de sistemas lineales en invariantes (LSI)  desde 

el domino espacial y los filtros espaciales y en la tercera sesión se abordará la teoría general 

de sistemas lineales en invariantes (LSI) desde el domino frecuencial y los filtros 

frecuenciales.     

 

Operaciones aritméticas con la imagen 

Ejercicio 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

aritmética_imagenes las imágenes botones_1 en una celda y botones_2 en otra celda.  

 Usando la calculadora restar las dos imágenes: botones_1 – botones_2 

 

En la Tabla 1 se presenta el resultado. ¿Qué se puede concluir del resultado? 
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Tabla 1 

 

Ejercicio 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

aritmética_imagenes la imagen airplane.  

 Hacer una copia de esta imagen en otra celda. 

 Sobre esta última y usando la calculadora de imágenes restar la constante 100 

 

En la Tabla 2 se presenta el resultado. ¿Qué se puede concluir del resultado? 

Tabla 2 

 

Mejoramiento de la imagen variando el histograma 

Ejercicio 

 Usando OrquideaJAI,  abrir de la carpeta  taller_imagenes_microscopia> contraste la 

imagen grano_polen. 

 Hacer una copia de esta imagen en otra celda.   
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 Mejorar su contraste ecualizando el histograma.  

 Hacer una copia en otra celda de la imagen resultado. 

 Sobre este resultado y usando la calculadora restarle a esta imagen  la constante 100. 

 

En la Tabla 3 se dan los resultados. 

 

Tabla 3 

 

 

Ejercicio 

 Usando OrquideaJAI,  abrir de la carpeta taller_imagenes_microscopia> contraste la 

imagen neurona_rata. 

 Hacer una copia de esta imagen en otra celda.   

 Mejorar su contraste ecualizando el histograma.  

 Hacer una copia en otra celda de la imagen resultado. 

 Sobre este resultado y usando la calculadora restarle a esta imagen  la constante 100 

 

En la Tabla 4 se dan los resultados. 

Ejercicio 

 Usando OrquideaJAI,  abrir de la carpeta  taller_imagenes_microscopia> contraste la 

imagen cultivo_celulas_tejido. 

 Hacer una copia de esta imagen en otra celda.   

 Mejorar su contraste normalizando el histograma.  

  

En la Tabla 5 se dan los resultados. 
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Tabla 4 

 

Tabla 5 

 
 

Binarización de la imagen 

Ejercicio 

 Usando OrquideaJAI,  abrir de la carpeta taller_imagenes_microscopia> umbralizacion 

la imagen celulas. 

 Hacer una copia de esta imagen en otra celda.   

 Binarizar la imagen umbralizando (“thresholding”) con corte en 127.  

 

En la Tabla 6 se dan los resultados. 
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Tabla 6 

 
 

Algebra booleana con la imagen 

Ejercicio 

 Usando OrquideaJAI,  abrir de la carpeta taller_imagenes_microscopia> 

algebra_booleana las imágenes a, b, negación_a y negación_b en celdas diferentes. 

 Cada una de ellas binarizarlas con corte en 50.   

 Usando la calculadora hacer la operación ~(a   b).  

 Usando la calculadora hacer la operación ~a   ~b.  

 Verificar que el resultado sea igual (mejor equivalente) 

 

En la Tabla 7 se dan los resultados. 

Tabla 7 
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Operaciones morfológicas con la imagen 

Ejercicio 

 Usando OrquideaJAI,  abrir de la carpeta taller_imagenes_microscopia> morfologia la 

imagen figuras_geometricas_erosion_dilatacion. 

 Binarizar la imagen.   

 Usando la calculadora erosionar la imagen.  

 Usando la calculadora dilatar la imagen.  

 

En la Tabla 8 se dan los resultados. ¿Qué se puede concluir del resultado de estas dos 

operaciones morfológicas? 

 

 

Tabla 8 

 

 

Ejercicio 

 Usando OrquideaJAI,  abrir de la carpeta taller_imagenes_microscopia> morfologia la 

imagen figuras_geometricas_apertura_cierre. 

 Binarizar la imagen.   

 Usando la calculadora hacer una apertura a la imagen.  

 Usando la calculadora hacer un cierre a la imagen.  

 

En la Tabla 9 se dan los resultados. ¿Qué se puede concluir del resultado de estas dos 

operaciones morfológicas? 

 

Tabla 9 
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Generación de imágenes patrón 

Con la calculadora de OrquideaJAI se pueden construir imágenes muy especiales que son de 

gran utilidad tanto para el estudio de los conceptos fundamentales del análisis y 

procesamiento de imágenes como para el estudio de los sistemas formadores de imágenes en 

óptica: imágenes con perfiles armónicos planos, colecciones de fuentes puntuales (deltas de 

Dirac o funciones impulso), redes, máscaras etc…  

 

Ejercicio 

 Usando OrquideaJAI,  generar una imagen que tenga el perfil armónico plano con 

frecuencias espaciales: fx= 0,02 líneas/pixel, fy = 0,00 líneas/pixel. El resultado es el de 

la Figura 1. 

 Guardarla como imagen en formtato .tiff en la carpeta taller_imagenes_microscopia> 

imágenes_generadas. 

 

 

Figura 1 

¿Cuánto vale el periodo espacial de esta imagen? Escribir la ecuación que lo representa. 

Escribir la ecuación de la fase que la representa. 

Ejercicio 

 Usando OrquideaJAI,  generar una imagen que tenga el perfil armónico plano con 

frecuencias espaciales: fx= 0,00 líneas/pixel, fy = 0,02 líneas/pixel. El resultado es el de 

la Figura 2. 

 Guardarla como imagen en formtato .tiff en la carpeta taller_imagenes_microscopia> 

imágenes_generadas. 
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Figura 2 

¿Cuánto vale el periodo espacial de esta imagen? Escribir la ecuación que lo representa. 

Escribir la ecuación de la fase que la representa. 

 

Ejercicio 

 Usando OrquideaJAI,  generar una imagen que tenga el perfil armónico plano con 

frecuencias espaciales: fx= 0,02 líneas/pixel, fy = 0,05 líneas/pixel. El resultado es el de 

la Figura 3. 

 Guardarla como imagen en formtato .tiff en la carpeta taller_imagenes_microscopia> 

imágenes_generadas. 

 

 

Figura 3 

¿Cuánto vale el periodo espacial de esta imagen? Escribir la ecuación que lo representa. 

Escribir la ecuación de la fase que la representa. 

 

Ejercicio 

 Usando OrquideaJAI,  generar una imagen agujero centrado de pequeño radiol. El 

resultado es el de la Figura 4. 

 Guardarla como imagen en formtato .tiff en la carpeta taller_imagenes_microscopia> 

imágenes_generadas. 
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Figura 4 

Ejercicio 

 Usando OrquideaJAI,  generar una imagen con dos agujeros, Figura 5. 

 Guardarla como imagen en formtato .tiff en la carpeta taller_imagenes_microscopia> 

imágenes_generadas. 

 

 

Figura 5 

Ejercicio 

 Usando OrquideaJAI,  generar una imagen de Figura 6. Utilice la calculadora en el modo 

RETICULA del panel Generar. 

 Guardarla como imagen en formtato .tiff en la carpeta taller_imagenes_microscopia> 

imágenes_generadas. 
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Figura 6 

FIN 
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Anexo B: Práctica # 2 

Procesamiento digital de imágenes usando 
Orquídea JAI –Dominio espacial- 

 

 

Temas 

 Introducción 

 Teoría general de sistemas formadores de imágenes LSI en el dominio espacial 

 Filtros espaciales paso bajo 

 Filtros espaciales paso alto  

 

 

Introducción 

 

En la primera sesión se abordaron las operaciones básicas con la imagen digital: análisis y 

variación de histogramas, operaciones aritméticas, operaciones booleanas, operaciones 

morfológicas. Adicionalmente se generaron imágenes patrón que son de gran utilidad para 

abordar ésta y la tercera sesión del curso. En esta sesión se abordará la teoría general de 

sistemas lineales en invariantes (LSI) desde el domino espacial y los filtros espaciales. En la 

tercera sesión se abordará la teoría general de sistemas lineales e invariantes (LSI) desde el 

dominio frecuencial y los filtros frecuenciales.     

 

Teoría general de sistemas formadores de imágenes LSI en el dominio espacial 

Ejercicio 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

filtraje_espacial la imagen letra_E. Esta se denominará f(x,y). 

 Suponer que se tiene un sistema formador de imágenes LSI en donde la respuesta al 

impulso, es decir el PSF h(x,y), es un punto. Es decir la imagen de un punto dada por este 

sistema es otro punto (equivale a los coeficientes  de la Figura  1).  

 Usando OrquideaJAI aplicar la propiedad de un sistema LSI en el dominio espacial para 

obtener la imagen de la letra_E  dada por éste sistema. 

Ayuda: Aplicar la convolución de la imagen f(x,y) con el filtro espacial pasa baja de la 

Figura 1, diseñando con OrquiedaJAI en la opción Espaciales > Personal > Paso Bajo 3x3. 
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Figura 1 

En la Figura 2 se ilustra la operación a realizar y su resultado. 

 

Figura 2 

¿Es posible en la práctica un sistema de estos? ¿Qué pasaría con la resolución espacial? ¿Qué 

pasaría con las aberraciones ópticas? 

Ejercicio 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

filtraje_espacial la imagen letra_E. Esta se denominará f(x,y). 

 Suponer que se tiene un sistema formador de imágenes LSI en donde la respuesta al 

impulso, es decir el PSF h(x,y), es una pequeña mancha cuadrada. Es decir la imagen de un 

punto dada por este sistema no es un punto sino una mancha cuadrada (equivale a los 

coeficientes  de la Figura  3).  

 Usando OrquideaJAI aplicar la propiedad de un sistema LSI en el dominio espacial para 

obtener la imagen de la letra_E  dada por éste sistema. 

Ayuda: Aplicar la convolución de la imagen f(x,y) con el filtro espacial pasa baja de la 

Figura 3, diseñando con OrquiedaJAI en la opción Espaciales > Personal > Paso Bajo 7x7. 
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Figura 3 

En la Figura 4 se ilustra la operación a realizar y su resultado. 

 

 

Figura 4 

Ejercicio 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

filtraje_espacial la imagen lena. Esta se denominará f(x,y). 

 Suponer que se tiene un sistema formador de imágenes LSI en donde la respuesta al 

impulso, es decir el PSF h(x,y), es una pequeña mancha cuadrada. Es decir la imagen de un 

punto dada por este sistema no es un punto sino una mancha cuadrada (equivale a los 

coeficientes  de la Figura  5).  

 Usando OrquideaJAI aplicar la propiedad de un sistema LSI en el dominio espacial para 

obtener la imagen de lena  dada por éste sistema. 

Ayuda: Aplicar la convolución de la imagen f(x,y) con el filtro espacial pasa baja de la 

Figura 5, diseñando con OrquiedaJAI en la opción Espaciales > Personal > Paso Bajo 7x7. 
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Figura 5 

En la Figura 6 se ilustra la operación a realizar y su resultado. 

 

 

Figura 6 

Ejercicio 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

filtraje_espacial la imagen dos_puntos_muy_separados. Esta se denominará f(x,y). 

 Suponer que se tiene un sistema formador de imágenes LSI en donde la respuesta al 

impulso, es decir el PSF h(x,y), es una pequeña mancha cuadrada. Es decir la imagen de un 

punto dada por este sistema no es un punto sino una mancha cuadrada (equivale a los 

coeficientes  de la Figura  7).  

 Usando OrquideaJAI aplicar la propiedad de un sistema LSI en el dominio espacial para 

obtener la imagen de dos_puntos_muy_separados dada por éste sistema. 

Ayuda: Aplicar la convolución de la imagen f(x,y) con el filtro espacial pasa baja de la 

Figura 7, diseñando con OrquiedaJAI en la opción Espaciales > Personal > Paso Bajo 7x7. 
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Figura 7 

En la Figura 8 se ilustra la operación a realizar y su resultado. 

 

 

Figura 8 

Ejercicio 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

filtraje_espacial la imagen dos_puntos_muy_cercanos. Esta se denominará f(x,y). 

 Suponer que se tiene un sistema formador de imágenes LSI en donde la respuesta al 

impulso, es decir el PSF h(x,y) es una pequeña mancha cuadrada. Es decir la imagen de un 

punto dada por este sistema no es un punto sino una mancha cuadrada (equivale a los 

coeficientes  de la Figura  9).  

 Usando OrquideaJAI aplicar la propiedad de un sistema LSI en el dominio espacial para 

obtener la imagen de dos_puntos_muy_cercanos  dada por éste sistema. 

Ayuda: Aplicar la convolución de la imagen f(x,y) con el filtro espacial pasa baja de la 

Figura 9, diseñando con OrquiedaJAI en la opción Espaciales > Personal > Paso Bajo 7x7. 
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Figura 9 

En la Figura 10 se ilustra la operación a realizar y su resultado. 

 

Figura 10 

Ejercicio 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

filtraje_espacial la imagen planeta. Esta se denominará f(x,y). 

 Suponer que se tiene un sistema formador de imágenes LSI en donde la respuesta al 

impulso es decir el PSF h(x,y) es una pequeña mancha como la ilustrada en la Figura 11. Es 

decir la imagen de un punto dada por este sistema no es un punto sino dicha mancha (esta 

mancha se estimó con los coeficientes de la Figura 12).  

 Usando OrquideaJAI aplicar la propiedad de un sistema LSI en el dominio espacial para 

obtener la imagen de planeta  dada por éste sistema con un aumento de 4. 

Ayuda: Aplicar la convolución de la imagen f(x,y) con el filtro espacial pasa baja de la 

Figura 12, diseñando con OrquiedaJAI en la opción Espaciales > Personal > Paso Bajo 7x7. 

Luego magnificar por 4 con OrquideaJAI. 
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Figura 11 

 

Figura 12 

 

El resultado obtenido es el ilustrado en la Figura 11. 

¿Qué se concluye del resultado de estos seis ejercicios? Para que no haya distorsión de la 

imagen cómo debe ser la respuesta al impulso h(x,y) del sistema, es decir el PSF (para un 

sistema sólo limitado por difracción: un sistema óptico perfecto). 

Filtros paso bajo 

Ejercicio 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> filtro_espacial 

la imagen patata_ruido_2.  

 Usando la calculadora aplicar todos los filtros espaciales pasa baja dados por 

OrquideaJAI. 
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En la Tabla 1 se presenta el resultado de aplicar el filtro espacial Pasa Baja Media 7x7, Figura 

13. ¿Qué se puede concluir del resultado? 

Tabla 1 

 

 

Figura 13 

Ejercicio 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> filtro_espacial 

la imagen squash_bug_mouth_ruido_1.  

 Usando la calculadora aplicar todos los filtros espaciales pasa baja dados por 

OrquideaJAI. 

 

En la Tabla 2 se presenta el resultado de aplicar el filtro espacial Pasa Baja Media 3x3, Figura 

14. ¿Qué se puede concluir del resultado? 
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Tabla 1 

 

 

Figura 14 

Filtros paso alto 

Ejercicio 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> filtro_espacial 

la imagen circulo_negro.  

 Usando la calculadora aplicar todos los filtros espaciales pasa alta dados por 

OrquideaJAI. 

 

En la Tabla 3 se presenta los resultados de aplicar el filtro espacial Pasa Alta de Realce 

Sharpen 2, Figura 15 y el filtro espacial pasa alta de Detección de bordes Laplaciano 1, 

Figura 16. ¿Qué se puede concluir de los resultados? 
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Tabla 3 

 

Repetir para las imágenes taller_imagenes_microscopia> filtro_espacial: 

 circulo_blanco 

 circulo_negro_linea 

 corona_negra 

 cuadrado_negro 

 

 

Figura 15 
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Figura 16 

Ejercicio 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> filtro_espacial 

la imagen lena.  

 Usando la calculadora aplicar todos los filtros espaciales pasa alta dados por 

OrquideaJAI. 

 

En la Tabla 4 se presenta los resultados de aplicar el filtro espacial Pasa Alta de Realce 

Sharpen 10, Figura 17 y el filtro espacial pasa alta de Detección de bordes Laplaciano 3, 

Figura 18. ¿Qué se puede concluir de los resultados? 

 

Tabla 4 
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Figura 17 

 

Figura 18 
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Ejercicio 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> filtro_espacial 

la imagen patata.  

 Usando la calculadora aplicar todos los filtros espaciales pasa alta dados por 

OrquideaJAI. 

 

En la Tabla 5 se presenta los resultados de aplicar el filtro espacial Pasa Alta de Realce 

Sharpen 10, Figura 19 y el filtro espacial pasa alta de Detección de bordes Laplaciano 3, 

Figura 20. ¿Qué se puede concluir de los resultados? 

Tabla 5 
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Figura 19 

 

Figura 20 

FIN  
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Anexo C: Práctica # 3  

Procesamiento digital de imágenes usando 
Orquídea JAI –Dominio de frecuencias- 

 

 

Temas 

 Introducción 

 La transformada de Fourier 

 Teoría general de sistemas formadores de imágenes LSI en el dominio  de frecuencias 

 Filtros frecuenciales paso bajo 

 Filtros frecuenciales paso alto  

 Filtros frecuenciales pasa banda 

 

 

Introducción 

 

En la primera sesión se abordaron las operaciones básicas con la imagen digital: análisis y 

variación de histogramas, operaciones aritméticas, operaciones booleanas, operaciones 

morfológicas. Adicionalmente se generaron imágenes patrón que son de gran utilidad en el 

desarrollo del curso. En la segunda sesión se abordó la teoría general de sistemas lineales en 

invariantes (LSI) desde el dominio espacial y los filtros espaciales En esta sesión se abordará 

la teoría general de sistemas lineales en invariantes (LSI) desde el dominio frecuencial y los 

filtros frecuenciales.     

 

La transformada de Fourier 

Ejercicio : Transformadas de Fourier de círculos 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

transformada_fourier la imagen circulo_1. Esta se denominará f(x,y). 

 Usando la calculadora de OrquideaJAI calcular la magnitud y la fase de la transformada 

de Fourier (TF). Para esto escoger DFT del panel Transformadas, Figura 1. 
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Figura 1 

El resultado se ilustra en la primera fila de la Tabla 1. 

Repetir para las imágenes circulo_2, circulo_3, circulo_4, circulo_5 y circulo_6 ubicadas 

también en la carpeta taller_imagenes_microscopia> transformada_fourier.  

 

Los resultados se ilustran en la Tabla 1. En el caso del circulo_5 hubo que multiplicar x3 los 

niveles de gris de la imagen correspondiente a la magnitud de la TF para hacerla más visible. 

Para el caso del circulo_6 también hubo que multiplicar pero x20 para lograr mejor visibilidad. 

¿Qué se puede concluir de los resultados? Relacionar con el fenómeno de Difracción de 

Fraunhofer a través de un agujero. 

Ejercicio: Transformada de Fourier de cuadrados  

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

transformada_fourier la imagen cuadrado_1. Esta se denominará f(x,y). 

 Usando la calculadora de OrquideaJAI calcular la magnitud y la fase de la transformada 

de Fourier (TF). Para esto escoger DFT del panel Transformadas, Figura 2. 

 

El resultado  se ilustra en la primera fila de la Tabla 2. 

Repetir para las imágenes cuadrado_2, cuadrado_3 y cuadrado_4 ubicadas también en la 

carpeta taller_imagenes_microscopia> trasnformada_fourier.  

 

Los resultados se ilustran en la Tabla 2. ¿Qué se puede concluir de los resultados? Relacionar 

con el fenómeno de Difracción de Fraunhofer a través de una abertura rectangular. 
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Tabla 1 
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Continuación de la Tabla 1 

 
 

 

Figura 2 
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Tabla 2 

 

 

 
 

 

 

 

 

 

 

 



Anexos 106 

 

 

Continuación de la Tabla 2 

 

 

Ejercicio: Transformada de Fourier de dos círculos y de dos rectángulos 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

transformada_fourier la imagen dos_circulos. Esta se denominará f(x,y). 

 Usando la calculadora de OrquideaJAI calcular la magnitud y la fase de la transformada 

de Fourier (TF). Para esto escoger DFT del panel Transformadas, Figura 3 

 

 
Figura 3 

El resultado se ilustra en la primera fila de la Tabla 3. 

Repetir para las imágenes dos_circulos_puntuales, dos_cuadrados y 

dos_cuadrados_pequenos ubicadas también en la carpeta taller_imagenes_microscopia> 

trasnformada_fourier. Los módulos de las TF de dos_circulos_puntuales y de 

dos_cuadrados_pequenos se amplificaron en sus niveles de gris multiplicando x10 para 

mejorar sus visibilidades. 
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Los resultados se ilustran en la Tabla 3. ¿Qué se puede concluir de los resultados? Relacionar 

con el fenómeno de Difracción de Fraunhofer y el de interferencia (experimento de Young). 

Tabla 3 
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Continuación de la Tabla 3 

Continuación Tabla 3 

 

 
 

 

Ejercicio X: Transformada de Fourier de imágenes armónicas 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

transformada_fourier las imágenes: 

 armonico_1_x, 

 armonico_2_x, 

 armonico_1_y, 

 armonico_2_y, 

 armonico_1_xy. 

 

 Usando la calculadora de OrquideaJAI calcular la magnitud de la transformada de Fourier 

(TF) para cada una de estas imágenes. 

Los resultados se ilustran en la Tabla 4. ¿Qué se puede deducir de estos resultados? Asociar 

con la Difracción de Fraunhofer a través de redes sinusoidales. 
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 Tabla 4
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Continuación de la Tabla 4 

 

Ejercicio: Transformada de Fourier de imágenes delta 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

transformada_fourier las imágenes: 

 delta_centro, 

 deltas_horizontales, 

 deltas_verticales, 

 deltas_45_derecha, 

 deltas_45_izquierda, 

 peinilla_40_40,  

 peinilla_20_20,  

 peinilla_5_5. 
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 Usando la calculadora de OrquideaJAI calcular la magnitud de la transformada de Fourier 

(TF) para cada una de estas imágenes. 

 

Los resultados se ilustran en la Tabla 5. En algunos casos se multiplicó x20 los niveles de gris 

de la imagen correspondiente a la magnitud de la TF para hacerla más visible. ¿Qué se puede 

deducir de estos resultados?  

 

 

Tabla 5 
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Continuación de la Tabla 5 
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Continuación de la Tabla 5 
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Ejercicio: Transformada de Fourier de rayas 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

transformada_fourier las imágenes: 

 red_rayas_horizontales_1, 

 red_rayas_verticales_1, 

 red_rayas_verticales_2, 

 red_rayas_verticales_3,  

 red_rayas_verticales_4. 

 Usando la calculadora de OrquideaJAI calcular la magnitud de la transformada de Fourier 

(TF) para cada una de estas imágenes. 

 

Los resultados se ilustran en la Tabla 6. ¿Qué se puede deducir de estos resultados?  

 

 

Tabla 6 
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Continuación de la Tabla 6 

 

Ejercicio: Trasnformadas de Fourier de imágenes en general 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

transformada_fourier las imágenes: 

 

 avispa_europea, avispa_cynipid 
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 avispa_ichneumonoidea, 

 grano_polen_micrsocopia_electronica, 

 lenna, 

 rayas_horizontales_verticales_cuadrantes 

 lena_con_rayas_verticales_horizontales. 

 

 Usando la calculadora de OrquideaJAI calcular la magnitud y la fase de la transformada 

de Fourier (TF) para cada una de estas imágenes. 

 

Los resultados se ilustran en la Tabla 7.  

 

Tabla 7 
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Continuación de la Tabla 7 
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De las tres últimas filas de la tabla 7 que se puede deducir (observar la magnitud de la 

transformada)  

 

Ejercicio: Comprobando que la información se encuentra en la fase (Experimento de 

Oppenheim) 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

transformada_fourier las imágenes lenna y avispa_ichneumonoidea. 

 

 Usando la calculadora de OrquideaJAI calcular la magnitud y la fase de la transformada 

de Fourier (TF) de cada una de estas dos imágenes. 

 

 Usando la Transformada de Fourier Inversa (IDFT) de la calculadora de OrquideaJAI 

construir las siguientes dos imágenes: 

 

 Imagen_1:  Magnitud de la TF de lenna con la Fase de la TF de 

avispa_ichneumonoidea  

 Imagen_2: Magnitud de la TF de avispa_ichneumonoidea con  la Fase de la TF de 

lenna 

 

Los resultados se ilustran en la Tabla 8. ¿Qué se puede concluir de estos resultados? 

 

 

El resultado de este ejercicio puede ser usado para 

ENCRIPTAR imágenes 
 

 



Anexos 119 

 

Tabla 8

 
Ejercicio: Obtención de armónicos de una imagen 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

transformada_fourier las imaágenes: 

 

 avispa_ichneumonoidea, 

 delta_centro, 
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 deltas_horizontales, 

 deltas_verticales, 

 deltas_45_derecha, 

 deltas_45_izquierda 

 

 Usando la calculadora de OrquideaJAI calcular la magnitud y la fase de la transformada 

de Fourier (TF) para esta imagen. 

 

 Usando la calculadora de OrquideaJAI hacer el producto de la magnitud de la TF de 

avispa_ichneumonoidea con (delta_centro/255).  

 

 Usando la calculadora de OrquideaJAI construir una imagen haciendo la IDFT tomando 

como magnitud el resultado del producto anterior y como fase la de la imagen 

avispa_ichneumonoidea. 

 

El resultado se ilustra en la Tabla 9. Repetir el procedimiento anterior pero haciendo el 

producto con las otras imágenes delta. Observar que los resultados son armónicos de la 

imagen. 

 

Tabla 9 
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Continuación de la Tabla 9 
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Continuación de la Tabla 9 

 

¿Por qué fue necesario dividir los deltas por 255? ¿Qué se concluye de este ejercicio?  

Ejercicio: Modulación de una imagen con otra imagen siusoidal 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

transformada_fourier las imágenes: 

 

 lenna, 

 armonico_2_x, 

 armonico_2_y, 

 armonico_1_xy 
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 Usando la calculadora de OrquideaJAI obtener las magnitudes de las TF de lena y 

armonico_1_x. 

 

 Usando la calculadora de OrquideaJAI  obtener la imagen de lena MODULADA por la 

imagen armonico_1_x: antes de realizar el producto normalizar la imagen moduladora 

dividiéndola entre 255.  

 

 Usando la calculadora de OrquideaJAI obtener la magnitud de la TF de la imagen de lena 

modulada por armonico_1_x. 

Repetir los dos últimos pasos pero modulando a lena con las otras imágenes: armonico_2_x,… 

 

Los resultados se ilustran en la Tabla 10. ¿Qué se puede concluir de estos resultados? 

 

 

Tabla 10 
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Continuación de la Tabla 10
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Continuación de la tabla 10 

 

IMPORTANTE: 

1. TEOREMA DE LA CONVOLUCIÓN: 

 

Si fx,y), g(x,y) son dos imágenes y F(fx,fy), G(fx,fy) son sus respectivas TF se cumple que, 

 

   f x,y g(x,y)  F fx,fy G(fx,fy)                [1]   

 

es decir, la convolución de la imagen f(x,y) con la imagen g(x,y) se puede hacer mediante dos 

pasos:  

 

- realizar el producto de sus transformadas de Fourier, 

- realizar la transformada de Fourier inversa del resultado.    
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2. TEOREMA DE LA MODULACIÓN: 

 

Es un teorema dual al de convolución. Si fx,y), g(x,y) son dos imágenes y F(fx,fy), G(fx,fy) 

son sus respectivas TF se cumple que, 

 

   f x,y g(x,y)  F fx,fy G(fx,fy)                      [2]   

 

es decir, el producto (la modulación)  de la imagen f(x,y) con la imagen g(x,y) se puede hacer 

mediante dos pasos:  

 

- realizar la convolución  de sus transformadas de Fourier, 

- realizar la transformada de Fourier inversa del resultado.    

 

 

 

Resumiendo: 

 

El PRODUCTO (MODULACIÓN) en uno de los dominios (espacial o 

frecuencias) es la CONVOLUCIÓN en el otro 
 

 

 

Ejercicio: Muestreo (se puede ilustrar modulando la imagen f(x,y) con la imagen peinilla) 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

transformada_fourier las imágenes: 

 

 lenna, 

 peinilla_paso_2_2, 

 

 Usando la calculadora de OrquideaJAI obtener las magnitudes de las TF de lena y 

peinilla_paso_2_2. 

 

 Usando la calculadora de OrquideaJAI  obtener la imagen de lena MODULADA por la 

imagen peinilla_paso_2_2: antes de realizar el producto normalizar la imagen moduladora 

dividiéndola entre 255.  

 

 Usando la calculadora de OrquideaJAI obtener la magnitud de la TF de la imagen de lena 

modulada por peinilla_paso_2_2. 

El resultado se ilustra en la tabla 11. ¿Qué se puede concluir? ¿Cuál sería el resultado si la 

peinilla tuviera un paso menor? ¿Cuál sería el resultado si la peinilla tuviera un paso mayor? 
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Tabla 11 
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Ejercicio: teorema del muestreo 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

transformada_fourier las imágenes: 

 

 lenna, 

 lena_muestreada_1, 

 Lena_mestreada_2. 

 

 Usando la calculadora de OrquideaJAI recuperar del espectro de Fourier de 

lena_muestreada_1 la imagen original de lena. Para esto, primero se realiza la TF de 

lena_muestreada_1, luego se debe aislar uno de los espectros correspondientes a lena 

original y por último sobre éste se obtiene la TF inversa. Con la calculadora OrquideaJAI 

se puede proceder así: panel Filtros > Paso Bajo Frecuencial, se elige el panel donde está 

ubicada la imagen lena_muestreada_1 y se previsualiza, desplegándose su espectro 

(izquierda) y el resultado de la TF inversa (derecha), Figura 4. 

 

 
Figura 4 

 

Hay un filtro que permite cambiar su radio. Hacerle variaciones a éste y observar el 

resultado, Tabla 12. En 1 no pasan frecuencias espaciales altas por lo tanto al recuperar la 

señal aparece desenfocada. En 2 y 3 se dejan pasar frecuencias más altas recuperándose 

más detalles de la imagen de lena original, siendo mejor en 3 que en 2.  En 4 se dejan 

pasar adicionalmente parte de los otros espectros que resultaron de la muestreada, no 

pudiéndose entonces recuperar a lena en su forma original.  

 

 

 

 



Anexos 129 

 

Tabla 12 
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Continuación de la Tabla 12 
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Para que una imagen esté bien muestreada la frecuencia de muestreo fm 

debe ser como mínimo el doble de la frecuencia de corte de la imagen (a 

esa frecuencia de muestreo se le conoce con el nombre de frecuencia 

Nyquist): 

 

m cf   2f                                  [3]   

 

Si no se cumple esto, los espectros replicados en el dominio de Fourier 

se montarán (aliasing) y no habrá forma de recuperar la imagen: la 

imagen recuperada tendrá información que no es real ya que contendrá 

frecuencias espaciales que no están presentes en la imagen original. 

 

Este teorema se conoce con el nombre de TEOREMA DEL MUESTREO o 

TEOREMA DE Whitaker-Shannon. 
 

 

Una forma práctica de enunciar el teorema del muestreo es la siguiente: 

La frecuencia de muestreo debe ser como mínimo igual al doble de la 

frecuencia espacial correspondiente al menor detalle de la imagen que se 

desea observar. Es decir, el intervalo de muestreo (paso en el dominio 

espacial de la imagen peinilla) debe ser escogido de un tamaño menor o 

igual a la mitad del menor detalle de interés en la imagen. 

Repetir el procedimiento para lena_muestraeda_2. En la Tabla 13 se observan los resultados. 

Observar que no hubo forma de recuperar la imagen original sin aliasing, ¿cuál es la razón de 

estos resultados? 
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Tabla 13 

 

 

 

 



Anexos 133 

 

Continuación de la Tabla 13 
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Continuación de la Tabla 13

 
Teoría general de sistemas formadores de imágenes LSI en el dominio  de frecuencias 

En la práctica 2 se abordó la teoría general de sistemas lineales e invariantes (LSI) desde el 

domino espacial y los filtros espaciales. En esta práctica se abordará la teoría general de 

sistemas lineales en invariantes (LSI) desde el dominio frecuencial y los filtros frecuenciales.     
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Los sistemas lineales e invariantes bajo desplazamiento cumplen en el dominio espacial lo 

siguiente, 

     f x,y h x,y g x,y                  [4]   

en donde f(x,y) es la imagen original, h(x,y) es la respuesta al impulso o también denominana 

PSF (Point Spread function: función de punto esparcido) del sistema lineal (por ejemplo, un 

filtro) y g(x,y) la imagen transformada.   

Aplicando el teorema de la convolución, relación [1], se obtiene, 

     F fx,fy H fx,fy G fx,fy          [5]    

En donde F(fx,fy) es la TF de la imagen original, H(fx,fy) la TF de h(x,y) y se denomina 

función de transferencia del sistema,  G(fx,fy) la TF de la imagen transformada. 

Ejercicio: Verificación de la ecuación [5]’ 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

transformada_fourier las imágenes: 

 

 lenna, 

 cuadrado_3. 

 

Suponer que lenna es f(x,y) y h(x,y) es cuadrado. En la práctica 2 se hizo la operación de 

la ecuación [4] y se obtuvo como resultado el ilustrado en la primera fila de la Figura 6. En 

este ejercicio se trata de verificar la ecuación [5], ilustrada en la segunda fila de la 

Figura 5, y comparar los dos resultados. 

 

 Usando la calculadora de imágenes de OrquideaJAI  obtener la magnitud y la fase de la 

TF de lenna. El resultado se ilustra en la Figura 5. 

 

 Usando la calculadora de imágenes de OrquideaJAI  obtener la magnitud de la TF de 

cuarado. Hacer el producto de la magnitud de la TF de lenna con la magnitud de la TF de 

cuadrado. 

 

 Usando la calculadora de imágenes de OrquideaJAI  hace la transformada de Fourier 

inversa tomando como magnitud de la TF del resultado del ítem anterior y como fase la de 

la TF de lenna. El resultado en la fila 3 de la Figura 6. 

Comparando los resultados logrados con la ecuación [4] y los logrados con la ecuación [5] se 

concluye que son los mismos. 
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Figura 5 

 

 

Figura 6 

 

 

Filtros frecuenciales paso bajo 

Ejercicio: Aplicando filtro frecuencial pasa baja 
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 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

transformada_fourier la image avispa_ichneumonoidea. 

 

 Usando la calculadora de OrquideaJAI aplicar el filtro frecuencial pasa baja a la imagen 

avispa_ichneumonoidea. Para esto ir a panel Filtros > Paso Bajo Frecuencial y elegir el 

panel donde está ubicada la imagen avispa_ichneumonoidea y previsualizar: se  despliega 

su espectro (izquierda) y el resultado de la TF inversa (derecha), Figura 7 Variar el radio 

del filtro y observar los resultados, Tabla 14. 

 

 

 

Figura 7 

 

 

 

¿Qué se concluye de los resultados? 
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Tabla 14 
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Continuación de la tabla 14 

Filtros 

freceunciales paso alto  

Ejercicio: Aplicando filtro frecuencial pasa alta 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

transformada_fourier la image avispa_ichneumonoidea. 

 

 Usando la calculadora de OrquideaJAI aplicar el filtro frecuencial pasa baja a la imagen 

avispa_ichneumonoidea. Para esto ir a panel Filtros > Paso Alto Frecuencial y elegir el 

panel donde está ubicada la imagen avispa_ichneumonoidea y previsualizar: se  despliega 
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su espectro (izquierda) y el resultado de la TF inversa (derecha), Figura 8 Variar el radio 

del filtro y observar los resultados, Tabla 15. 

 

 

Figura 8 

 

¿Qué se concluye de los resultados? 
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Tabla 15 
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Continuación de la Tabla 15 

 

Filtros frecuenciales pasa banda 

Ejercicio: Aplicando filtro frecuencial pasa banda 

 Usando OrquideaJAI, abrir de la carpeta taller_imagenes_microscopia> 

transformada_fourier las imágenes: 
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 lena_con_rayas_verticales_horizontales, 

 rectangulos_superior_inferior. 

 

 Usando la calculadora de OrquideaJAI obtener la magnitud y la fase de la TF de 

lena_con_rayas_verticales_horizontales.  

 

 Normalizar a rectangulos_superior_inferior dividiendo entre 255 y el resultado 

multiplicarlo por la magnitud de la TF de lena_con_rayas_verticales_horizontales. 

 

 Mediante la TF inversa tomando como fase la fase de  

lena_con_rayas_verticales_horizontales y como magintud el resultado obtenido en el 

ítem anterior construir de nuevo la imagen.  

 

El resultado se ilustra en la Tabla 16. ¿Qué se concluye este resultado? 

 

Tabla 16 

Imagen original Magnitud de la TF de la 

imagen original 

Fase de la TF de la imagen 

original 

 

 
 

 

 

 

 

 

Imagen máscara 

(Imagen mascara/255) 

x 

(Magnitud de TF Original) 

TF inversa: imagen filtrada 
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FIN 
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Anexo D: Práctica # 4  

Estimación de parámetros básicos de 
microscopia. 

Temas 

 Introducción 

 Datos del microscopio a usar en esta práctica  

 Tipo de imagen dado por el microscopio óptico 

 Estimar el aumento 

 Estimar la resolución espacial 

 Estimar la frecuencia espacial de corte del  objetivo 

 Estimar la resolución espacial de la cámara digital  

 Estimar  el campo visual 

 Estimar el tamaño de objetos  microscópicos 

 Mejorando el contraste: microscopía de polarización 

 Mejorando el contraste: microscopía de campo oscuro 

 

 

Introducción 

 

Para hacer un buen procesamiento y análisis de la imagen digital obtenida a través de un 

microscopio es necesario conocer los fundamentos de los parámetros básicos involucrados en 

el proceso de adquisición de ésta, desde la resolución óptica de acuerdo a la configuración 

usada del microscopio hasta la resolución espacial de la cámara digital acoplada. Con base en 

esto se tiene los fundamentos  para obtener buenas imágenes como para saber el límite de la 

información que en ellas se encuentra: es este el objetivo de la práctica que se realizará. 

 

Datos del microscopio a usar en esta práctica  

El microscopio que se usa en esta práctica se ilustra en la Figura 1. Tiene tres objetivos: 4X 

(A.N. = 0,16), 10X  (A.N. = 0,25) y 40X (A.N. = 0,65). El ocular es de 10X. La cámara digital 

tiene una resolución de 0.3 Megapixeles (640x480 pixel=307 200 pixeles) y con dimensiones del 

área sensora igual a 4,8 mm x 3,6 mm. 
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Figura 1 

Tipo de imagen dado por el microscopio óptico 

En la Figura 2 se representa el diagrama esquemático de un microscopio compuesto. Consta de 

dos lentes convergentes. La lente más próxima al objeto se denomina objetivo, forma una 

imagen real, invertida y de mayor tamaño que el objeto. La lente más próxima al ojo se 

denomina ocular y permite observar la imagen formada por el objetivo (logra que veamos la 

imagen del objetivo con un ángulo aparente mayor que si el objeto estuviera en el punto 

próximo del ojo). La imagen final dada por el microscopio es virtual, invertida (derecha 

respecto a la imagen del objetivo)  y de mayor tamaño: la imagen final después de pasar por el 

ojo se forma en la retina.  Cuando el ocular se reemplaza por la cámara digital, la imagen real 

dada por el objetivo se proyecta sobre el área sensora de ésta. 

 

Figura 2 
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Ejercicio 

 

Retirar el ocular e introducir en su lugar una pantalla de papel  transparente (papel 

matequilla), Figura 3: desplazarla hasta obtener una imagen real proyectada en ella lo más 

nítida posible. Retirar la cámara y tratar de observar con el ojo esta imagen real: ésta se 

observa “suspendida” en el aire (no es fácil). Las imágenes reales son muy difíciles de 

observar sin estar proyectadas sobre alguna superficie. 
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Figura 3: Pantalla (arriba), acoplando pantalla al microscopio (centro) y observando imagen 

real proyectada en la pantalla (abajo)  

 

 

Estimar el aumento 

La distancia d entre el punto focal imagen del objetivo F’1 y el punto focal objeto del ocular F2 

se llama longitud del tubo, Figura 2. En los microscopios tiene un valor fijo: 16 cm. 

El poder amplificador del microscopio (M) es el producto de la amplificación lateral del 

objetivo por la amplificación angular del ocular: 

   aobjetivo ocular
M = M x M               [1]  

 
objetivo

1

d
M  =                                  [2]

f
 

en donde f1 es la distancia focal del objetivo. El aumento angular  del ocular es, 

a

2

0,25
M  =                                       [3]

f
 

en donde f2 es la distancia focal del ocular. Por lo tanto el aumento del microscopio es, 

1 2

0,25 d
M =                                       [4]

f  f
 

La Tabla 1 indica los aumentos logrados con diferentes objetivos. 

Tabla 1 

 Objetivo f1 

en mm 

Aumento 

objetivo 

para d=16 

cm 

Aumento total 
Distancia de 

trabajo en 

mm 
Ocular 5X Ocular 10X Ocular 15X 

50 3,2 16 32 48 30 

25 6,4 32 64 96 14 

16 10 50 100 150 8 

8 20 100 200 300 2 

4 40 200 400 600 0,5 

2 80 400 800 1200 0,2 
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Observaciones: 

 La distancia de trabajo es la distancia existente entre la lente frontal del objetivo y el 

objeto enfocado. Es siempre menor que la distancia focal del objetivo. 

 Cuanto mayor es el aumento del objetivo más cerca está del objeto y menor es la lente por 

lo que llega menos luz al ojo. A mayor aumento menos luminosidad. 

Ejercicio 

Para las diferentes combinaciones ocular/objetivo que se dispone en el microscopio que se usa en la práctica 

estimar el aumento total, Tabla 2. 

Tabla 2 

Objetivo Ocular Aumento total 

4X(0,16) 

10X 

 

10X(0,25)  

40X(0,65)  

 

Estimar la resolución espacial 

Apertura numérica 

 

La capacidad de dejar pasar órdenes de difracción es lo que en una la lente objetivo del 

microscopio recibe el nombre de apertura numérica (A.N.). Esta se define como, 

 

A.N. = n senθ                                    [5]
 

 

en donde n es el índice de refracción del medio en donde está la lente (1,0 para aire y 1,56 

para aceites de inmersión)  y  es la mitad del ángulo de apertura  (ángulo hasta donde se 

logran captar los rayos luminosos refractados cuando éstos atraviesan un medio 

transparente). 

 

Poder de resolución 

 

Se define como poder de resolución d de un objetivo de microscopio a la distancia mínima 

que debe existir entre dos puntos del objeto para que se puedan visualizar como dos puntos 

separados. La calidad de una imagen, en la que se observe la claridad, nitidez y la riqueza  de 

detalles, depende del poder de resolución del objetivo.  El poder de resolución (dmin) de un 

objetivo depende de la longitud de onda en el vacío (0) de la luz que se  utiliza y de su 

apertura numérica, 

 

 
0

min

λ
d = 0,61                                [6]

A.N.
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En la Tabla 3 se dan los límites de resolución típicos de tres instrumentos ópticos 

 

Tabla 3 

INSTRUMENTO 
LÍMITE DE RESOLUCIÓN (dmin) 

En mm En µm En nm 

OJO HUMANO 0,2 200 200 000 

MICROSCOPIO 

ÓPTICO 
0,0002 0,2 200 

MICROSCOPIO 

ELECTRÓNICO 
0,000002 0,002 2 

 

 

Ejercicio 

 

Para cada uno de los objetivos del microscopio que se usa en la práctica calcular los límites de 

resolución: tomar como longitud de onda de la luz el verde, 0λ  = 550 nm . Reportar los 

resultados en la Tabla 4. 

 

Tabla 4 

OBJETIVO 

LÍMITE DE 

RESOLUCIÓN 

(dmin en nm) 

4X(0,16)  

10X(0,25)  

40X(0,65)  

   

Aumento útil 

En realidad no hay un límite máximo de aumentos en un microscopio, sólo existe un límite en 

cuanto al denominado aumentos útil. La limitación fundamental no consiste en el aumento sino 

en el poder de resolución, o sea, la capacidad del microscopio de visualizar los detalles más 

finos del objeto. Una vez que la imagen se ha aumentado hasta el punto en donde la imagen se 

vuelve borrosa, el hecho de aumentar la imagen aún más producirá, debido al límite del poder 

de resolución, una imagen de tamaño más grande, pero también más borrosa y sin visualización 

de más detalles. Este tipo de incremento inútil del aumento se llama "aumentos vacíos”, 

indicando que se trata de aumentos más allá del límite útil en cuanto a la reproducción fiel de 

los detalles finos.  

Con óptica bien corregida el aumento útil se puede estimar así, 

 utilM   1 000  A.N.                       [7];
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Por ejemplo si se tiene un objetivo 100X que posee una A.N.=1,25 el aumento máximo que debe 

presentar la imagen para ofrecer la mayor cantidad de detalles es aquel que resultaría de 

multiplicar 1,25 x 1 000 = 1 250, por lo tanto si el objetivo es 100X se debe usar un ocular de 

por lo menos 12X Si se usa un ocular 15X la ampliación de la imagen estaría dando un aumento 

vacío. Al contrario, si se emplea un ocular 5X el aumento es 5x100 = 500 y se  estaría 

subutilizando el poder de resolución del objetivo: no se está logrando el aumento necesario 

para observar los detalles de la imagen que el objetivo utilizado es capaz de resolver.  

Los límites que existen para que un objetivo pueda ofrecer al observador un adecuado poder 

de resolución oscilarían entre las cifras que señalan un máximo poder de resolución 

equivalente a multiplicar la AN del objetivo utilizado por 1000, y un mínimo poder de 

resolución útil equivalente a multiplicar la AN del objetivo por 500: oculares de gran potencia 

favorecen el aumento pero disminuyen la luminosidad, nitidez y las dimensiones del campo 

visual. Por eso es aconsejable situar el aumento total entre 500 y 1000 veces el valor de A.N. 

 

Otro ejemplo 

Según la regla anterior, para un objetivo 40X  con A.N. igual a 0,65  se debe usar un ocular 

que logre valores comprendidos entre los siguientes aumentos:  

500 x 0,65 = 325 aumentos 

1000 x 0,65 = 650 aumentos 

Para lograr valores comprendidos entre 325 y 650 aumentos con un objetivo de 40X se debe 

emplear oculares 10X y 15X: empleando el de 10X el aumento total será de 400 y empleando el 

de 15X el aumento será de 600. Un ocular 20X producirá imágenes de mayor aumento (800) 

pero serán poco nítidas. 

La limitación fundamental no consiste en el aumento sino en el poder de resolución, o sea, la 

capacidad del microscopio de visualizar los detalles más finos del objeto. Una vez que el 

imagen del objeto se ha aumentado hasta el punto en donde se vuelve borrosa, el hecho de 

aumentarla aún más producirá, debido al límite del poder de resolución, una imagen de tamaño 

más grande, pero también más borrosa y sin visualización de más detalles. Este tipo de 

incremento inútil del aumento se llama "aumentos vacíos”, indicando que se trata de 

aumentos más allá del límite útil en cuanto a la reproducción fiel de los detalles finos. 

Ejercicio 

Para el microscopio que utiliza en la práctica calcular y reportar  los aumentos posibles para  las diferentes 

configuraciones de objetivo/ocular. Adicionalmente dar el rango recomendable de aumento útil del microscopio. 

Para reportar emplear la  Tabla 5. 
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Tabla 5 

Mobjetivo  (A.N.) Mocular Mtotal Aumento útil 

mínimo 

Aumento útil 

máximo 

4X(0,16) 

10X 

   

10X(0,25)    

40X(0,65)    

 

¿Se puede concluir algo respecto al buen uso de la resolución espacial de los objetivos? 

Estimar la frecuencia espacial de corte del  objetivo 

La frecuencia espacial de corte de un microscopio es, 

 

c

0

A.N.
f =  2                                       [8]

λ
 

 

Combinando las ecuaciones [6] y [8],   

 

c

min

1,22
f =                                          [9]

d
 

 

Es decir al aumentar la frecuencia de corte disminuye el límite de resolución del 

microscopio: se definen más detalles. Si el mínimo límite de resolución para el 

microscopio óptico es del orden de 200 nm la máxima frecuencia espacial de corte se 

estima en,  

 

c

líneas líneas
f   =  6   6 000 

μm mm


 
Ejercicio 

Para el microscopio que utilizará en las prácticas calcular y reportar  la frecuencia de corte de cada uno de los 

objetivos disponibles para el microscopio usado en la práctica. Para reportar emplear la Tabla 6. 
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Tabla 6 

Mobjetivo  (A.N.) 
FRECUENCIA DE CORTE fc 

En líneas/mm En líneas/µm 

4X(0,16)   

10X(0,25)   

40X(0,65)   

 

¿Para cada objetivo cuánto debe ser la mínima frecuencia de muestreo para digitalizar las imágenes obtenidas 

con cada uno de los objetivos disponibles para el microscopio de la práctica para lograr una óptima 

representación de éstas? Reportar en la tabla 7 

Tabla 7 

Mobjetivo  (A.N.) 
FRECUENCIA DE NYQUIST fs 

En líneas/mm En líneas/µm 

4X(0,16)   

10X(0,25)   

40X(0,65)   

 

Estimar la resolución espacial de la cámara digital  

La resolución espacial de la cámara (tamaño del pixel o potencia resolutiva) define la 

capacidad para capturar detalles finos del modelo original. Cuanto más definidos sean los 

detalles visibles, mayor es la resolución, Figura 4.  

 

Figura 4: Imagen tomada de http://www.desarrolloweb.com/articulos/1903.php 

La resolución espacial de las cámaras digitales usadas en los microscopios depende de la 

resolución espacial óptica del objetivo, del número de celdas de la cámara y de la distancia 

entre los centros de dos celdas consecutivas, valor conocido como separación, . 

Para estimar la resolución espacial de la cámara digital a usar en el microscopio, es necesario 

recurrir al criterio de Nyquist el cual exige para obtener una imagen que registre los mayores 
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detalles del objeto muestrear espacialmente a una frecuencia  fs  igual o superior al doble de 

la frecuencia de corte fc (que corresponde a la mayor frecuencia espacial que permite el 

objetivo del microscopio) 

s cf   2f                                             [10]  

Es decir el periodo de muestreo (intervalo de muestreo) o separación espacial de los 

registros, , debe cumplir, 

c

1
δ                                              [11]

2f


 

Pero como la imagen proyectada sobre la superficie sensora de la cámara tiene una 

magnificación Mobj debido a al aumento del objetivo, se tiene que la separación espacial, , en 

esta superficie es, 

objΔ = M  δ                     

 

obj

c

M
  

2f
 

 

y según ecuación [8] se obtiene, 

 
obj 0M  λ

                              [12]
4 A.N.

 

 

Esta separación  equivaldría al tamaño del pixel (tamaño de cada sensor) de la cámara. 

Ejemplo 

Suponer un microscopio de fluorescencia iluminando con luz de longitud de onda de 550 nm y 

usando un objetivo 100X con apertura numérica 1,40. Calcular la frecuencia espacial de corte 

y el tamaño del pixel requerido de la cámara digital para una máxima resolución óptica. 

 

Solución 

La frecuencia de corte viene dada por la ecuación [8], 

c

0

A.N.
f =  2

λ
 

c 3

1,40 líneas
f =  2 5,10 

550 10 μm μm
 


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Muestreando con el límite de requerimiento de Nyquist, el tamaño del sensor es según la 

ecuación [12], 

 
0M λ

   
4 A.N.

 

 

 
100  550 nm

   = 9,8 μm
4 1,4


 

 

que corresponde a un área del pixel igual a 9,8 µm x 9,8 µm. 

 

Por lo tanto este tamaño del pixel sensor (9,8 µm x 9,8 µm) garantiza el cumplimiento del 

criterio de Nyquist para adquirir una buena imagen sin perder los detalles de las más altas 

frecuencias espaciales que permite el objetivo 100X(1,40). Por precaución se muestrea 

normalmente no al doble de la frecuencia de corte sino al triple, por lo que el tamaño del pixel 

en esta caso pasaría a valer aproximadamente 6,5 µm x 6,5 µm. Algo que se debe tener en 

cuenta es que entre más pequeños sean los sensores de la cámara digital mejor es la 

resolución espacial pero también genera más limitación en el rango dinámico del dispositivo.  

 

En la Tabla 8 se ilustra datos del tamaño del píxel del sensor sugerido para objetivos 

comúnmente utilizados en la microscopía de fluorescencia para una máxima resolución óptica. 

 

Tabla 8 

Objectivo 

(Apertura 

Numérica) 

Frecuencia espacial 

de corte del 

microscopio 

(líneas/µm) 

Intervalo de 

muestreo sin 

aumento,  

(µm) 

Tamaño requerido del pixel 

en la superficie sensora de 

la cámara,  

(µm x µm) 

4x (0,20) 0,73 0,68 2,8 x 2,8 

10x (0,45) 1,63 0,31 3,1 x 3,1 

20x (0,75) 2,72 0,18 3,6 x 3,6 

40x (0,85) 3,10 0,16 6,4 x 6,4 

40x (1,30) 4,72 0,11 4,2 x 4,2 

60x (0,95) 3,45 0,15 9,0 x 9,0 

60x (1,40) 5,09 0,01 6,0 x 6,0 

100x (0,90) 3,27 0,15 15 x 15 

100x (1,25) 4,54 0,11 11 x 11 

100x (1,40) 5,09 0,01 10 x 10 

 

La resolución de una cámara digital es una función del número de píxeles y del tamaño del 

pixel. Superficies sensoras de las cámaras de más de 1000 x 1000 sensores (1 Mega-pixel) son 

usadas en tareas científicas.  Hoy, en el mercado de consumo se encuentran cámaras con 
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píxeles tan pequeños como de 4 µm x 4 µm. En la Figura 5 se ilustran las superficies sensoras 

de varias de las cámaras digitales que usualmente se consiguen en el mercado 

 

Figura 5 

Por ejemplo, una cámara digital sencilla para ser acoplada a un microscopio óptico contiene un 

sensor de imagen cuyo tamaño de los píxeles alrededor de 7,6 µm x 7,6 µm, que produce un 

área de la imagen correspondiente de 4,86 mm x 3,64 mm en la superficie de la matriz de 

fotodiodos cuando el sensor está funcionando en el modo VGA. El tamaño de la imagen digital 

resultante es de 640 pixeles x 480 píxeles, lo que equivale a 307 200 elementos sensores 

individuales (imagen de 0,3 Mega-pixeles). Suponer un microscopio configurable desde un 

objetivo 4X con A.N. igual 0,20 hasta un objetivo 100X (sin aceite) con A.N. igual a 0,90. Para 

cumplir el límite del criterio de Nyquist el tamaño del pixel requerido con máxima resolución 

óptica es para la primera configuración 2,8 µm x 2,8 µm  y para la segunda 15 µm x 15 µm, lo 

que lleva a concluir que el tamaño del sensor de esta cámara (7,6 µm x 7,6 µm) es adecuado 

para capturar adecuadamente los detalles presentes de las muestras desde valores 

intermedios del aumento hasta grandes valores del mismo.  

Ejercicio 

Para el microscopio que se emplea en la práctica calcular  en el límite del criterio de Nyquist el tamaño del 

sensor (pixel) de la cámara digital necesario para  obtener imágenes con la máxima resolución óptica para cada 

uno de los objetivos. Para reportar emplear la Tabla 9. 

Tabla 9 

Objectivo 

(A.N.) 

Frecuencia espacial 

de corte del 

microscopio 

(líneas/µm) 

Intervalo de 

muestreo sin 

aumento,  

(µm) 

Tamaño requerido del pixel 

en la superficie sensora de 

la cámara,  

(µm x µm) 

4X(0,16)    

10X(0,25)    

40X(0,65)    

 

Si por precaución se debe muestrear no al doble de la frecuencia de corte del microscopio sino al triple, estimar 

el tamaño del sensor (pixel) de la cámara digital en cada uno de los objetivos. Para reportar emplear la Tabla 10. 
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Tabla 10 

Objectivo 

(A.N.) 

Tamaño requerido del 

pixel en la superficie 

sensora de la 

cámara,  

(µm x µm) 

4X(0,16)  

10X(0,25)  

40X(0,65)  

 

Utilizando las especificaciones dadas de la cámara digital usada en esta práctica hacer una discusión al respecto. 

 

Estimar el campo visual 

El campo visual corresponde al área del círculo que se observa a través del microscopio: a 

mayor aumento menor campo visual, Figura 6. 

 

Figura 6 

Ejercicio 

Para el microscopio que utilizará  calcular el diámetro del campo visual para cada uno de sus objetivos.  Para esto 

seguir los siguientes pasos: 

 Recortar un cuadrado de 1 cm de lado (debidamente milimetrado) de un acetato, Figura 7. 

 Ubicarlo sobre el portaobjeto sin cubrir. 

 Observarlo con nitidez a través de objetivo de menor aumento del microscopio (en esta práctica es el de 

4X). Mover la muestra hasta lograr que coincida la línea cero con uno de los extremos del campo visual. 

 Dibujar lo observado, Figura 8. 
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Figura 7 

 

 

Figura 8 

 Contar el número de milímetros que se ven y estimar la fracción sobrante (si la hay), el resultado será el 

diámetro del campo visual para ese aumento (objetivoxocular). 

 Repetir para el objetivo 10X y reportar los resultados en la Tabla 11. 

Tabla 11 

Diámetro del campo visual 

Unidades de medida Objetivo 4X Objetivo 10X 

mm   

μm   

nm   

Å   

 

Conocido el diámetro del campo visual para uno de los objetivos se puede utilizar  la siguiente fórmula para 

calcular el diámetro del campo visual para otro objetivo, 

1 2

2 1

a d
 =                                  [13]

a d
 

en donde d corresponde al  diámetro del campo visual y a al aumento. Verificar si se cumple esta fórmula en los 

resultados reportados en la Tabla 11. 
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Empleando la fórmula [13] calcular el diámetro del campo visual del objetivo 40X. Reportar en la Tabla 12 

Tabla 12 

Diámetro del campo visual 

Unidades de medida Objetivo 40X 

mm  

μm  

nm  

Å  

 

Estimar el tamaño de objetos  microscópicos 

Una vez se tiene las medidas de los campos visuales que ofrece el microscopio es fácil estimar las dimensiones 

de los objetos en observación: por ejemplo el diámetro aproximado de las células o estructuras observadas.  

Dada una muestra de una hoja de Tradescantia reportar la estimación del tamaño de las estomas. Reportar en 

la Tabla 13. 

Tabla 13 

 ESTRUCTURA 

OBJETIVO 

Estomas en hoja de 

Tradescantia 

En mm En µm 

4X   

10X   

40X   

PROMEDIO   

 

Mejorando el contraste: microscopía de polarización 

Una de las formas de mejorar el contraste en el microscopio es introducir en el camino óptico de la luz 

elementos ópticos que favorezcan el fenómeno de interferencia. Este es por ejemplo el caso por ejemplo de la 

microscopía de polarización que aumenta ostensiblemente el contraste de muestras muy transparentes y con 

algo de anisotropía. 

Ejercicio 

Realizar el montaje de la Figura 9 para transformar el microscopio de campo claro usado en la práctica en uno 

de polarización: ubicar un polarizador sobre la fuente de luz y el otro antes de llegar al ocular (analizador). 
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Observar diferentes muestras rotando el analizador. Éste tiene adicionalmente un retardador: hacer 

diferentes tomas enfrentado el polarizador y luego enfrentando el retardador. Retirar el ocular y reemplazarlo 

por la cámara digital: repetir los experimentos y grabarlos. Ver resultados de un ejemplo en la Tabla 14. 

 

Figura 9: Polarizadores (arriba), Montaje (abajo) 

Tabla 15 
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Mejorando el contraste: microscopía de campo oscuro 

Otra forma de aumentar el contraste es cambando la estructura de la iluminación. Este es el caso de la 

microscopía de campo oscuro. 

Ejercicio 

Retirar los polarizadores y realizar el montaje de la Figura 10 ubicando de nuevo el ocular. Jugando con los 

filtros trate de lograr el efecto de la microscopía de campo oscuro. Repetir con la cámara digital y realizar las 

grabaciones respectivas. Ver resultados de un ejemplo en la Tabla 15 

Retirar los polarizadores y realizar el montaje de la Figura 10 ubicando de nuevo el ocular. Jugando con los 

filtros trate de lograr el efecto de la microscopía de campo oscuro. Repetir con la cámara digital y realizar las 

grabaciones respectivas. Ver resultados de un ejemplo en la Tabla 15 

 

 

Figura 10: Filtro (izquierda) y ubicación del filtro (derecha) 

Tabla 16 

 

FIN  
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Anexo E: Práctica # 5  

 

Análisis y procesamiento digital de imágenes 
con Image J 

 

Temas 

 Introducción 

 ¿Qué es una imagen digital? Tipo y formato 

 Filtros Espaciales y convolución 

 Convolucionando la imagen con al PSF 

 Deconvolución de imágenes de sistemas ópticos 

 Filtros frecuenciales 

 Sobre el análisis de la imagen 

 Midiendo: morfometría 

 Midiendo: densitometría 

 

 

Introducción 

 

ImageJ es un software de análisis y procesamiento digital de imágenes de dominio público y 

desarrollado por National Institutes of Health. En esta práctica se usará para hacer algunos 

procesos comunes sobre la imagen digital y adicionalmente para realizar análisis y mediciones 

sobre ésta.  

 

Se comenzará haciendo un rápido recorrido sobre algunas utilidades de ImageJ como lo son el 

manejo de histogramas, manejo del color, visores 3D, manejo de algunos filtros. Se terminará 

realizando análisis densitométricos y morfométricos sobre la imagen. 

 

El software y su documentación se encuentran en, 

 

http://rsb.info.nih.gov/ij/index.html 

 

Un buen tutorial se encuentra en, 

 

http://rsbweb.nih.gov/ij/docs/guide/146-1.html#toc-Section-1 

 

 

 

 

http://rsb.info.nih.gov/ij/index.html
http://rsbweb.nih.gov/ij/docs/guide/146-1.html#toc-Section-1
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¿Qué es una imagen digital? Tipo y formato 

Una imagen se puede representar por una función f(x,y) en donde (x,y) corresponde a su 

dominio espacial y f la intensidad luminosa (nivel de gris). Si la imagen es digital su dominio 

está muestreado y su intensidad cuantizada. Su resolución espacial está relacionada con el 

muestreo y su profundidad de color con la cuantización. 

   

Resolución espacial 
 

La resolución óptica se define como la distancia más corta entre dos puntos en un espécimen 

que todavía se pueden distinguir por el sistema de observación o de la cámara. Para un 

microscopio óptico la resolución depende de la longitud de onda de la luz con que se ilumina y 

de la apertura numérica del objetivo.  

 

En la práctica # 4 se ilustró cómo estimar el tamaño del píxel de la cámara CCD para 

aprovechar la óptima resolución del microscopio para cada configuración posible objetivo-

ocular (cumpliendo el criterio de Nyquist) pero sin considerar el binning1: este aumenta la 

sensibilidad de la cámara a costillas de pérdida de resolución espacial. También se estimó el 

tamaño en pixeles (Megapixels) de la imagen obtenida con base en el tamaño del pixel (del 

fotosensor) y el tamaño del área total de la superficie sensora de la cámara CCD. 

 

Ejemplo: 

 

Tamaño de la celda cámara: 10 x 10 µm 

Número de celdas: 1000 x 1000 

Tamaño del chip: 10 x 10 mm 

 

Si Binning = 1x:  

 

 Tamaño celda final= 10 x 10 µm   

 # pixeles toma: 1000 x 1000 (1 Megapixel) 

 

Si Binning = 2x: 

 

 Tamaño celda final= 20 x 20 µm 

 # pixeles toma: 500 x 500 (0,25 Megapixel) 

 

 Si bien es cierto que al usar binning 2x, la sensibilidad aumenta 4 veces, también es 

verdad que el tamaño (superficie) de la imagen, se reduce 4 veces.  

                                                
1
 El “binning” es una técnica mediante la cual se suma, por decirlo de alguna forma, la señal recibida por varios 

fotosensores creando una especie de superpíxel (agrupa los pixeles vecinos en un solo) en el cual se ve incrementada 

la señal y reducido el ruido. Evidentemente se pierde resolución espacial ya que la imagen final tendrá menos pixeles. 
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 Ahora, cuando a esta imagen binning 2x, le duplicamos el tamaño para igualarlo a 

una imagen  1x puede aparecer cierto pixelado.  

 

Profundidad de color 

Pero no solo el número de pixeles es importante (lo que está asociado con el debido muestreo), 

también lo es y mucho el número de bits (bit depth: profundidad de color) del archivo (lo que 

está asociado con la debida cuantización  -niveles por ejemplo de gris-).  La profundidad de 

color se mide en bits por pixel (bpp) y se calcula así, 

 

nbbp = 2  

 

en donde n es el número de bits. 

Las imágenes digitales en color están hechas de píxeles, y los píxeles están formados por 

combinaciones de colores primarios. Un canal en este contexto es la imagen en escala de 

grises del mismo tamaño que la imagen en color, hecha de uno de estos colores primarios. Por 

ejemplo, una imagen de una cámara digital estándar tendrá los canales rojo, verde y azul. Una 

imagen en escala de grises tendrá sólo un canal. 

 

Una imagen RGB tiene tres canales: rojo, verde y azul. Los canales RGB derivan u obedecen a 

los receptores de color del ojo humano, y se usan en monitores de ordenador y escáneres de 

imagen. Si la imagen RGB es de 24 bits (denominada también de “color verdadero”), cada canal 

tiene 8 bits, para el rojo, verde y azul— en otras palabras, la imagen está compuesta de tres 

imágenes (una por cada canal), donde cada imagen puede almacenar píxeles con intensidades 

de brillo convencional entre 0 y 255 cada pixel puede tener 28 x 28 x 28 = 224
 = 256 x 256 x 

256 = 16 777 216 colores diferentes, que son más de los que puede captar el ojo humano. Si 

una imagen RGB emplea 32 bits en cuatro canales (cada uno de 8 bits), el cuarto canal es la 

denominada transparencia. Si la imagen RGB es de 3 canales y cada uno de 16 bits, la imagen 

RBB es de 48 bits y se denomina de alta resolución. 

 

Para estimar el tamaño del archivo de una imagen sin aplicarle algoritmos de compresión se 

realizan operaciones simples tal como se ilustra en el ejemplo: una imagen tiene 400 x 400 

píxeles y de 8 bits tiene un tamaño 400 x 400 = 160.000 bytes o aproximadamente 156 kb (1 

kb = 1024 b). Si se duplica el tamaño de la imagen a 800 x 800 pixeles el tamaño del archivo 

será cuatro veces más grande, es decir 625 kb. 

 

ImageJ puede mostrar, editar, analizar, procesar, guardar, e imprimir imágenes del siguiente 

tipo, Figura 1: 

 en escala de grises de 8 bits (valores de 0 a 255), 
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 en escala de grises 16 bits en escala de grises (valores de 0 a 65535), 

 en escala de grises de 32 bits (usa números de coma flotante con signo),  

 en color de 8 bits (valores de 0 a 255), 

 en color de 8 bits con una tabla de búsqueda (Lookup-Table: LUT), 

 en color RGB (3 canales de valores de 0 a 255, la profundidad de bits de 24). 

 

 
Figura 1 

 

En cuanto a formatos ImageJ puede leer varios formatos de imagen incluyendo TIFF, PNG, 

GIF, JPEG, BMP, DICOM, FITS, así como formatos RAW. Para guardar las imágenes 

científicas se debe hacer en formato TIFF  el cual es una comprensión sin pérdida de 

información.  

 

Ejercicio: Analizando información básica de una imagen 

 Con ImageJ abrir la imagen blobs.gif ubicada en la carpeta imagenes_practica_5_imagej 

> formato_tipo_imagen. Se despliega la ventana de la Figura 2.  En la parte superior de la 

ventana se despliega alguna información acerca de la imagen: el tamaño de la imagen en 

píxeles, el tipo y el tamaño de la imagen en la memoria de la computadora. 

 Buscar la herramienta de ImageJ que permite hacer ZOOM a la imagen. ¿Cuál es el 

máximo ZOOM permitido? ¿Cuál es el mínimo ZOOM permitido? 

Respuesta. Máximo: _____________  Mínimo: ______________ 

 ¿Cuál es el valor de gris del pixel con las coordenadas x = 66 y = 86?  
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Respuesta. Valor de gris: __________  

 ¿Cuál es el valor de gris del pixel con las coordenadas x = 213 y = 241? 

Respuesta. Valor de gris: __________  

 ¿Cuál es el ancho y el alto de la imagen en pixeles?  

Respuesta. Ancho: _________ (pixeles)   Alto: ___________ (pixeles) 

 ¿Cuál es su tipo de la imagen?  

Respuesta. Tipo de imagen: _________ 

 ¿Cuál es el formato de la imagen? 

Respuesta. Formato: _______ 

 ¿Qué tamaño ocupa en la memoria del PC? 

Respuesta. Tamaño: ______ 

 ¿Cuánto vale la profundidad de color (nivele de gris)? 

Respuesta. Número de niveles de gris: _______ 

 

 

Figura 2 

Ejercicio: Analizando información básica de una imagen  

 Con ImageJ abrir la imagen ovulo_tulipan.png ubicada en la carpeta 

imagenes_practica_5_imagej > formato_tipo_imagen. Se despliega la ventana de la 

Figura 3.  En la parte superior de la ventana se despliega alguna información acerca de la 

imagen: el tamaño de la imagen en píxeles, el tipo y el tamaño de la imagen en la memoria 

de la computadora. Llenar la Tabla 1. 
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Figura 3 

 

Tabla 1 

Ovulo_tulipan 

Tipo de imagen  

Formato de imagen  

Dimensiones de la imagen en pixeles  

Tamaño que ocupa en la memoria del PC  

Número de canales  

Número de bits por canal  

Número de niveles de gris por canal  

 

Ejercicio: falso color (pseudocolor) 

 Con ImageJ abrir la imagen blobs.gif ubicada en la carpeta imagenes_practica_5_imagej 

> formato_tipo_imagen. Se despliega la ventana de la Figura 2.  Duplicar la imagen 

haciendo clic en Image > Duplicate: se despliega otra ventana con un duplicado de la 

imagen. 

 Sobre el duplicado de la imagen se aplicará falso color usando LUT definidos.  Hacer cli en 

Image > Lookup Tables > Spectrum: la imagen toma la forma de la Figura 4. Ensayar con 

otros LUT.  
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Figura 4 

 

Filtros Espaciales y la Convolución 

La aplicación de filtros espaciales lineales para transformar una imagen cumple la siguiente 

expresión de convolución, 

     g x,y f x,y h x,y   

En donde f(x,y) es la imagen a transformar, g(x,y) la imagen transformada y h(x,y) 

corresponde a la máscara o filtro que se aplica: esto se puede explicar con la denominada 

teoría de los sistemas LSI (Sistemas Lineales e Invariantes bajo traslación). Esta propiedad 

se puede utilizar para aplicar diferentes filtros a la imagen digital: paso alta, paso baja, 

resaltadores de borde, etc… 

Ejercicio: Implementación de filtros personales 

 Con ImageJ abrir la imagen hormiga_acaro_con_ruido.tif ubicada en la carpeta 

imagenes_practica_5_imagej > filtros_espaciales. Se despliega la ventana de la Figura 5.  

Duplicar la imagen haciendo clic en Image > Duplicate: se despliega otra ventana con un 

duplicado de la imagen. 
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Figura 5 

 Sobre el duplicado de la imagen se aplicar el filtro espacial de la Tabla 2.  Para esto en 

ImageJ ir a Process > Filters > Convolve: se despliega la ventana de la Figura 6, en 

donde introduce los coeficientes. Observar que tiene la opción  para normalizar: 

normalizar. También tiene la opción de previsualizar antes de dar por terminado el 

proceso. Hacer clic en el botón OK y se despliega la imagen ya transformada, Figura 7. 

 

Tabla 2 

1 1 1 1 1 1 1 

1 1 1 1 1 1 1 

1 1 1 1 1 1 1 

1 1 1 1 1 1 1 

1 1 1 1 1 1 1 

1 1 1 1 1 1 1 

1 1 1 1 1 1 1 

 

 

Figura 6 
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Figura 7 

¿Cuál fue el efecto de este filtro?  

Respuesta.  

 

 

 

 

 

¿Es un filtro pasa alta o pasa baja? ¿Por qué? 

Respuesta.  
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Ejercicio: Implementación de filtros personales 

 Con ImageJ abrir la imagen cuadricula.tiff ubicada en la carpeta 

imagenes_practica_5_imagej > filtros_espaciales. Se despliega la ventana de la Figura 8.  

Duplicar la imagen haciendo clic en Image > Duplicate: se despliega otra ventana con un 

duplicado de la imagen. 

 

 

Figura 8 

 Siguiendo el mismo protocolo del ejercicio anterior aplicar los filtros de la Tabla 3. 

Estos filtros reciben el nombre de filtros derivadas. Los resultados se ilustran en la 

misma tabla. 
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Tabla 3 

 

-1 0 1 

-1 0 1 

-1 0 1 

 

 

 

 
 

Derivada en x Resultado de la derivada en x 

 

 

-1 -1 -1 

0 0 0 

1 1 1 

 

 

 

 
 

Derivada en y Resultado de la derivada en y 
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¿Cuáles fueron los efectos sobre la imagen al aplicarle estos filtros derivada? 

Respuesta. 

 

… 

 

 

Ejercicio: Implementación de filtros personales 

 Con ImageJ abrir la imagen codo_arana.bmp ubicada en la carpeta 

imagenes_practica_5_imagej > filtros_espaciales. Se despliega la ventana de la Figura 9.  

Duplicar la imagen haciendo clic en Image > Duplicate: se despliega otra ventana con un 

duplicado de la imagen. 

 

 

Figura 9 

 Siguiendo el mismo protocolo del ejercicio anterior aplicar los filtros de la Tabla 4. 

Estos filtros reciben el nombre de filtros derivadas. Los resultados se ilustran en la 

misma tabla. 
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Tabla 4 

-1 0 1 

-1 0 1 

-1 0 1 
 

 

 
 

Derivada en x Resultado de aplicar la derivada en x 

 

 

 

 

-1 -1 -1 

0 0 0 

1 1 1 

 

 

 

 
 

Derivada en y Resultado de aplicar la derivada en y 

 

 

 

 

-1 -1 -1 

-1 8 -1 

-1 -1 -1 

 

 

 

 
 

Laplaciano Resultado de aplicar el Laplaciano 
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 Analizar las variaciones en los niveles de gris en la línea y=90. Para esto trazar con la 

herramienta Línea, Figura 10, una línea en la imagen a la altura de y=90, Figura 11. Hacer 

un perfil de niveles de gris: para esto ir a Analyze > Plot Profile  y se despliega la gráfica 

de la Figura 12.  

 

 

Figura 10 

 

 

Figura 11 
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Figura 12 

 Repetir el análisis de perfil para la imagen que representa la derivada X de codo_arana. 

Recordar que es para la línea a la altura y=90 Figura 13 y 14.  

 

 

Figura 13 
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Figura 14 

Observar que la derivada acentúa las variaciones. 

Convolucionando la imagen con al PSF 

Si un sistema óptico formador de imágenes (lente, microscopio, telescopio,…) es considerado 

LSI se le aplica la siguiente expresión, 

     g x,y f x,y h x,y   

en donde f(x,y) es el objeto,  g(x,y) la imagen formada por el sistema óptico y h(x,y) 

corresponde a la respuesta al impulso del sistema o también denominada PSF (Función de 

Punto Esparcida: es la imagen formada por el sistema de un objeto puntual), Figura 15. Para un 

sistema perfecto (sin aberraciones) y sólo limitado sólo por los efectos de difracción h(x,y) es 

el denominado patrón de Airy. 

 

Figura 15 
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Es decir si se conoce el PSF del sistema y la información del objeto (distribución de 

intensidades del objeto) se puede obtener la imagen aplicando la expresión anterior. 

 

 

 

A continuación se realizarán varios ejercicios que ilustren esta propiedad. Para esto es 

necesario adicionarle a ImageJ el plugin Convolve3D con el cual se pueden realizar 

convoluciones del PSF con imágenes 2D o 3D. Este se puede obtener la siguiente dirección: 

http://www.optinav.com/Convolve_3D.htm 

Aquí se baja el archivo Convolve_3D.class. En Windows este se debe ubicar en la carpeta 

plugins de ImageJ ilustrada en la Figura 16. 

 

 

Figura 16 

Cuando ejecute de nuevo ImageJ debe aparecer disponible este plugin en el menú de Plugins. 

Se debe tener los siguientes cuidados: 

 Las dimensiones del PSF no puede ser más grandes que las de la imagen con la que se 

convolucionará: bits de profundidad, ancho y alto en pixeles. 

 Se admiten todos los tipos de imágenes excepto RGB, y la salida es siempre de 32 bits.  

 

http://www.optinav.com/Convolve_3D.htm


Anexos 179 

 

Ejercicio: Convolucionando la imagen con la PSF 

 Con ImageJ abrir la imagen imagen_prueba.tif ubicada en la carpeta 

imagenes_practica_5_imagej > convolucion_psf. Se despliega la ventana de la Figura 17.  

Duplicar la imagen haciendo clic en Image > Duplicate: se despliega otra ventana con un 

duplicado de la imagen. 

 

 

Figura 17 

 Con ImageJ abrir la imagen psf_1.tif ubicada en la carpeta imagenes_practica_5_imagej 

> convolucion_psf. Se despliega la ventana de la Figura 18. 

 

 

Figura 18 
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 Con ImageJ realizar la convolución de la imagen con la PSF psf_1. Para esto acceder a 

Plugins > Convolve 3D y se despliega la ventana de la Figura 19. 

 

Figura 19 

 Seleccionar el duplicado de la imagen y el PSF y hacer clic en OK. El resultado se 

despliega en una ventana, Figura 20. 

 

 

 

Figura 20 
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¿Qué se observa? 

 

 

 

 

 

Repetir con los PSF psf_2 y psf_3 que se encuentran en la carpeta carpeta 

imagenes_practica_5_imagej > convolucion_psf. Los resultados son los ilustrados en la Tabla 

5. 

Tabla 5 
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¿Qué se concluye del ejercicio? 

 

… 

 

 

Ejercicio: Convolución del PSF con una imagen obtenida con el microscopio 

 Con ImageJ abrir la imagen codo_arana.tif ubicada en la carpeta 

imagenes_practica_5_imagej > convolucion_psf. Se despliega la ventana de la Figura 21.  

Duplicar la imagen haciendo clic en Image > Duplicate: se despliega otra ventana con un 

duplicado de la imagen codo_arana.tif. Observar que la imagen es tipo RGB y por lo tanto 

para poder usar el plugin Convolve3D es necesario transformarla por ejemplo a 8 bits. 

Para esto último acceder a Image > Type > 8-bit y se despliega la ventana de la Figura 

22. 

 

 

 

Figura 21 
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Figura 22 

 

 Con ImageJ realizar la convolución de la imagen con la PSF psf_1 del ejercicio anterior. 

Se despliega la ventana de la Figura 23. 

 

 

Figura 23 

¿Qué se puede concluir? 
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Ejercicio: Costruir una PSF adecuada para el microscopio usado 

Existe software que permite bajo argumentos teóricos construir una PSF adecuada para el 

microscopio usado. Para el caso de ImageJ se puede obtener el plugin Diffraction PSF 3D. 

Este se puede obtener la siguiente dirección: 

http://www.optinav.com/Diffraction-PSF-3D.htm 

Aquí se baja el archivo Diffraction_PSF_3D.class. En Windows este se debe ubicar en la 

carpeta plugins de ImageJ ilustrada en la Figura 24. 

 

Figura 24 

Cuando ejecute de nuevo ImageJ debe aparecer disponible este plugin en el menú de Plugins. 

Ejemplo: Construir la PSF para el microscopio que se usó en la práctica # 4 en la configuración 

con la que se captó la imagen codo_arana.tif: objetivo 10X (A.N.=0,25) y dimensión del pixel 

de la cámara CCD usada es de 7,5 µm x 7,5 µm. 

 Para proceder a la construcción del PSF, acceder en ImageJ a Plugins > Diffraction PSF 

3D y se desplegará la ventana de la Figura 25. Llenar los campos con los valores que 

aparecen en la Figura.  El dato correspondiente al campo sobre las dimensiones del pixel 

se calculó así: 

      7,5 µm/10X = 750 nm 

 Una vez efectuado el proceso se despliega una ventana con el PSF, Figura 26. Si se quiere 

observar con más detalle éste volver a realizar el proceso pero activando el box PSF in 

http://www.optinav.com/Diffraction-PSF-3D.htm


Anexos 185 

 

DB (escala logarítmica), Figura 27. Sin embargo se debe tener en cuenta que la 

convolución se hará con el de la Figura 26  

 

Figura 25 

 

Figura 26 
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Figura 27 

 Con ImageJ abrir la imagen codo_arana.tif ubicada en la carpeta 

imagenes_practica_5_imagej > convolucion_psf. Duplicar la imagen haciendo clic en 

Image > Duplicate y por último acceder a Image > Type > 32-bit para convertirla a una 

imagen de 32 bits. Se despliega la ventana de la Figura 28. 

 

Figura 28 

Proceder a convolucionar la imagen de la Figura 28 con la PSF de la Figura 26. Par esto 

acceder a Plugins > Convolve 3D y se desplegará la ventana de la Figura 29. Chequear bien que 

la imagen y la PSF (Kernel) si correspondan a los que se van a operar.   



Anexos 187 

 

 

Figura 29 

Una vez terminado el proceso se despliega la imagen resultante de la convolución, Figura 30.  

 

Figura 30 

¿Qué se puede concluir del resultado? 

Repetir el procedimiento pero suponiendo que  el aumento no es 10X sino 20X. En la Tabla 6 se 

observan los resultados.  ¿Qué se puede concluir de los resultados? 
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Tabla 6 

 

Deconvolución de imágenes de sistemas ópticos 

Todo objetivo/lente de microscopio (o sistema óptico en general) proyecta una imagen REAL a 

partir de un objeto REAL. Si nuestro objeto REAL fuera un punto (tan pequeño y 

perfecto como fuera posible) la imagen REAL que proyecta el objetivo nunca será otro punto, 

sino una pequeña MANCHA que representará a nuestro punto REAL (imagen del punto REAL): 

esta es la denominada PSF. Recordar que si se convoluciona este PSF, h(x,y), con el objeto 

f(x,y) se obtiene la imagen g(xy), ver Figura 15, 

     g x,y f x,y h x,y 
 

La deconvolución es un término que se podría traducir como “enfoque de imágenes sucias”, es 

una técnica que permite restaurar una imagen borrosa  y obtener de ella información 

adecuada. Esta técnica fue aplicada para corregir digitalmente la “miopía” del telescopio 

Hubbel para evitar la pérdida  de millones de dólares. Fue este hecho el que hizo que esta 

operación comenzara a valorase en la comunidad científica. 
 

Si la convolución implica reemplazar cada fuente luminosa puntual original por su 

correspondiente PSF para producir una imagen borrosa, el proceso de restauración sigue el 



Anexos 189 

 

camino inverso, recolectando toda la luz dispersa y poniéndola en su sitio de nuevo. Esto 

produce una mejor representación del objeto real, más clara a nuestros ojos. (El brillo de la 

imagen parece disminuir mientras que aumenta el contraste entre objetos y fondo, y el rango 

dinámico se agranda). 

En términos matemáticos, la deconvolución es simplemente la resolución de la ecuación 

     g x,y f x,y h x,y  , donde conocidas la imagen convulocionada g(x,y)  y la PSF h(x,y), 

se obtiene la distribución de luz original f(x,y): una representación del objeto "real". Esto no 

es posible sin tener algo de ruido, pero con una aplicación cuidadosa de la técnica se logran 

excelentes resultados.  

El ejemplo que se estudiará a continuación tiene copyright. 

Copyright: US Air Force Phillips Laboratory, Lasers and Imaging Directorate, Kirtland Air 

Force Base, New Mexico. 

Visitar la Web: 

https://sites.google.com/site/piotrwendykier/software/deconvolution/parallelspectraldecon

volution  

Para poder realizar el ejemplo es necesario obtener otro plugin para ImageJ que el el caso de 

Window es:  

parallel_spectral_deconvolution-1.12-bin.zip  

el cual se obtiene de la Web arriba señalada. Se descomprime y se ubica en la carpeta de los 

plugins de ImageJ, Figura 31. 

 

Figura 31 
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 Con ImageJ abrir las imágenes satellite-blur.png, satellite-true.png y satellite-

psf.png ubicadas en la carpeta imagenes_practica_5_imagej > deconvolucion_psf. . 

 Deconcolucionar satellite-blur.png con satellite-psf.png. Para esto acceder a 

Plugins> Parallel spectral Deconvolution > 2D Spectral Deconvolution  y se 

despliega la ventana de la Figura 32. Colocar los parámetros señalados en esa Figura. 

 

 

Figura 32 

El resultado se ilustra en la Tabla 7. ¿Qué se concluye? 
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Tabla 7 

 

Filtros frecuenciales 

Recordar que si se convoluciona este PSF, h(x,y), con el objeto f(x,y) se obtiene la imagen 

g(xy), ver Figura 15, 

     g x,y f x,y h x,y 
 

Otra forma de expresar esto es a través del teorema de la convolución, 

           g x,y f x,y h x,y   G fx,fy  = F fx,fy H fx,fy  
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En donde G, F y H son las respectivas transformadas de Fourier de g,f,h. fx y fy son las 

frecuencias espaciales. H es la denominada función de transferencia del sistema LSI (Sistema 

Lineal Invariante bajo desplazamiento). 

Se puede filtrar  en el dominio de las frecuencias y por medio de la transformada de Fourier 

inversa obtener la imagen transformada.  

En ImageJ la transformada de Fourier se hace a través del conocido algoritmo FFT (Fast 

Fourier Transform: Transformada Rápida de Fourier). La Transformada de Fourier inversa a 

través de la IFFT. 

Ejercicio: Transformada de Fourier de una imagen 

 Con ImageJ abrir la imagen mariposa.png ubicada en la carpeta 

imagenes_practica_5_imagej > filtros_frecuenciales. Se despliega la ventana de la 

Figura 33. 

 

Figura 33 

 Con ImageJ obtener su transformada de Fourier. Para esto acceder a Process > FFT > 

FFT y se despliega la ventana de la Figura 34. 
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Figura 34 

 Repetir las siguientes imágenes ubicadas también en la carpeta 

imagenes_practica_5_imagej > filtros_frecuenciales, 

 escarabajo.png,  

 lena_con_rayas_verticales_horizontales.jpg,  

 panel_abejas.png, 

 virus_poliomielitis.tif  

Los resultados se ilustran en la Tabla 8. 

Tabla 8 

 



Anexos 194 

 

Continuación de la Tabla 8 

lena_con_rayas_verticales_horizontales.jpg

, 

Magnitude de la TF de 

lena_con_rayas_verticales_horizontales.jpg

, 

 

 
 

 

 

panel_abejas.png Magnitud de la TF de panel_abejas.png 

 

 
 

 

 

virus_poliomielitis.tif Magnitud de la TF de virus_poliomielitis.tif 
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Ejercicio: Implementación de filtros frecuenciales 

 Con ImageJ abrir la imagen escarabajo.png ubicada en la carpeta 

imagenes_practica_5_imagej > filtros_frecuenciales. Se despliega la ventana de la 

Figura 35. Realizar su TF tal y como se indicó en el ejercicio anterior, Se despliega la 

ventana de la Figura 36. 

 

Figura 35 

 

Figura 36 
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 Con ImageJ aplicar un filtro frecuencial pasa alta. Para esto sobre la TF dibujar un 

círculo (podría ser otra figura geométrica) relleno de COLOR NEGRO (esto tiene como 

efecto, eliminar las frecuencias espaciales ubicadas dentro del círculo) centrado. El 

resultado de penderá del radio del círculo. Para dibujar el círculo ir a la barra de dibujo, 

Figura 37 y activar Ovalo. Luego de dibujar el círculo ir a Edit > Fill para rellenar el 

círculo (DEBE SER DE COLOR NEGRO). 

 

Figura 37 

 Proceder a realizar la transformada de Fourier Inversa para recuperar la imagen ya 

transformada: Process> FFT > Inverse FFT. 

En la Tabla 9 se ilustran 2 resultados. ¿Qué se puede concluir? 

Tabla 9 

 

 

 Con ImageJ aplicar un filtro frecuencial pasa baja. Para esto sobre la TF dibujar un 

círculo (podría ser otra figura geométrica). Ir luego a Edit > Selection > Make Inverse y 
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por último   ir a Edit > Fill. Se eliminarán las frecuencias que se encuentran en el 

exterior del círculo dibujado. 

 Proceder a realizar la transformada de Fourier Inversa para recuperar la imagen ya 

transformada: Process> FFT > Inverse FFT. 

En la Tabla 10 se ilustran 2 resultados. ¿Qué se puede concluir? 

Tabla 10 

 

 Con ImageJ abrir la imagen lena_con_rayas_verticales_horizontales ubicada en la 

carpeta imagenes_practica_5_imagej > filtros_frecuenciales. Se despliega la ventana 

de la Figura 38. Realizar su TF y se despliega la ventana de la Figura 39 
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Figura 38 

 

Figura 39 

 Se implementará un filtro pasa banda que eliminen las rayas verticales de la imagen. Para 

esto dibujar los rectángulos sobre la TF ilustrados en la Figura 40 y luego hacer la 

transformada de Fourier Inversa: se obtiene la imagen de la Figura 41. 
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Figura 40 

 

 

Figura 41 

Proceder a eliminar las rayas horizontales. En la Tabla 11 se ilustra el resultado. 
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Tabla 11 

 

Sobre el análisis de la imagen 

Los parámetros habituales en análisis de imagen se pueden clasificar de la siguiente forma: 

 Según la cualidad a determinar: 

 Parámetros morfométricos: aquellos que determinan la forma  y la topología del 

objeto. 

 Parámetros densitométricos: aquellos que cuantifican lo relativo a la intensidad 

lumínica del objeto. 

 Según se trate de la imagen como un todo o de los objetos individualmente: 

 Parámetros de campo: son parámetros globales que consideran la imagen en 

conjunto. 

 Parámetros de objeto: son parámetros propios de cada uno de los objetos 

contenidos en la imagen. 

Son parámetros morfométricos de campo:  

 el número de partículas presentes en una imagen, 

 el área que ocupa una fase (“no confundir con fase de una sinusoide”) en la imagen, 

 el perímetro que limita una fase en la imagen. 

Son parámetros morfométricos de objeto: 

 coordenadas del objeto (distribución de objetos), 

 centroide, 

 área de un objeto, 

 diámetros de Feret (FeretX y FeretY), 

 longitud y anchura de los objetos, 

 perímetro y perímetro convexo de un objeto, 

 longitud y anchura de fibra, 

 orientación de los objetos, 

 número de Euler del objeto, 
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 factor de forma circular, 

 rugosidad, 

 factores que relacionan la longitud de los ejes (elongación, simetría, extensión)  

En la Tabla 12 se ilustran algunos de estos factores y otros que pueden aparecer en los 

software de análisis digital de imágenes. 

Tabla 12 

Parámetro Fórmula Abreviaturas empleadas 

Factor de forma circular 
2

4π A

P
 

A: Área 

Ac: Área convexa 

Dmax: diámetro máximo 

Dmin: diámetro mínimo 

Fx: FeretX 

Fy: FeretY 

L: longitud 

P: perímetro 

Pc: perímetro convexo 

W: anchura 

 : ángulo entre Dmax y Dmin 

Rugosidad 
c

P

P
 

Convexidad cP

P
 

Redondez 
2

4π A

L
 

Solidez 
c

A

A
 

Cobertura 

2 2
Fx Fy

π  
2 2

   
   
   

 

Elongación 
W

L
 

Simetría 
 max min

max

D -D

D
 

Extensión L W sen α  

Diámetro del círculo 

equivalente  

4A

π
 

 

Son parámetros densitométricos el nivel de gris y la densidad óptica. La densidad óptica se 

define como, 

10DO = - log  T  

En donde T, transmisión, es un parámetro que mide el nivel de gris normalizado. 

Midiendo: morfometría 

Adición de una barra de escala 

Tomado de: http://zafi.blogia.com/temas/image-j.php 
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Frecuentemente las imágenes se reportan indicando el objetivo con  el que fueron tomadas. El 

problema de hacerlo así es que la magnificación no depende sólo del objetivo sino también del 

ocular.  Lo más correcto sería reportar el aumento total. Adicionalmente las imágenes en los 

artículos son muy distintas en su tamaño, lo mejor es incluir una escala en las mismas.  

 

Incluir una escala con ImageJ es muy sencillo, aunque antes hay que realizar una fotografía 

de un objeto cuya medida se conozca, como por ejemplo una cámara de contaje (cámara de 

Neubauer) con el mismo objetivo y con la misma resolución de imagen (tamaño, binning, etc…) 

que la imagen a la que se quiere insertar la escala. Puede parecer tedioso, pero como el número 

de objetivos y resoluciones que normalmente se utilizan es bastante limitado basta con hacer 

una imagen de cada juego y guardarlas (sabiendo cual es cual) para poder utilizarlas siempre 

que se quiera.  

Para insertar escala con ImageJ se siguen los siguientes pasos: 

 Abrir la imagen de la cámara de contaje tomada con el mismo objetivo y resolución que la 

imagen a la que queremos insertar la escala. 

 Con la herramienta "Straight Line" dibujar una línea en la imagen cuya distancia se 

conozca.  

 Analyze > Set Scale ... > el programa indica la distancia en pixeles de la línea 

seleccionada y se entrega la distancia real y sus unidades. También hay que marcar 

"Global" para que aplique la misma escala a todas las imágenes. 

 Abrir la imagen a la que se qiere insertar la escala. 

 Analyze > Tools > Scale Bar... > Introducir el tamaño que se quiere que tenga la escala 

en el campo "Width Scale" y darle al OK. También se puede seleccionar el grosor de 

la barra, su color y posición y si se quiere o no que incluya texto indicando su valor. 

 Salvar la imagen como una nueva imagen porque la escala se embebe en ella y ya no se 

puede quitar.   

 

Nota: 

En este taller no se incluyó un ejercicio de insertar escala a una imagen debido a que 

en el momento no se disponía de un objeto confiable de referencia al cual se le 

conociera sus medidas.  

 

Ejercicio: Midiendo áreas 

 

 Con ImageJ abrir la imagen leaf.jpg ubicada en la carpeta imagenes_practica_5_imagej 

> morfometria. Se despliega la ventana de la Figura 42.  
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Figura 42 

 Hacer un duplicado de la imagen original para evitar estropearla guardando posibles 

cambios sobre ésta. Sobre este hacer una conversión a una imagen de 8 bits: Image > 

Type > 8–bit. Se despliega la ventana de la Figura 43. 

 

Figura 43 

 Para proceder a medir es necesario calibrar la escala. Para esto dibujar sobre la regla, por 

ejemplo, una línea de 50 mm, Figura 44 
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. 

Figura 44 

 Ir a Analyze > Set Scale: se despliega la ventana de la Figura 45. En el campo Known 

Distance colocar 50 y en el campo Unit of Measurement colocar mm. En el box 

seleccionar Global. Hacer clic en el botón OK. 

 

Figura 45 

 Binarizar la imagen: Process > Binary > Make Binary. Se despliega la ventana de la 

Figura 46. Esta operación tiene como efecto seleccionar solo la parte verde oscura de la 

hoja. 
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Figura 46 

 Para calcular el área de la porción verde de la hoja se enmarca ésta en un rectángulo y se 

procede así: Analyze > Analyze Particles. Se despliega la ventana de la Figura 47. 

Proceder a darle los valores y seleccionar los box como lo ilustra dicha figura y hacer clic 

en el botón OK. Se despliegan las ventanas ilustradas en las Figuras 48, 49 y 50. En las 

dos últimas se encuentran los valores de las medidas.  

 

 

Figura 47 
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Figura 48 

 

Figura 49 

 

Figura 50 

Ejercicio: Conteo y análisis de partículas 

 Con ImageJ abrir la imagen embryos.jpg ubicada en la carpeta 

imagenes_practica_5_imagej > morfometria. Se despliega la ventana de la Figura 51. 
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Hacer un duplicado de la imagen original para evitar estropearla guardando posibles 

cambios sobre ésta. 

 

 

Figura 51 

 

 Para proceder a medir es necesario calibrar la escala. Para esto dibujar sobre el segmento 

de la escala de la imagen una línea, Figura 52. 

 

Figura 52 
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 Ir a Analyze > Set Scale: se despliega la ventana de la Figura 53. En el campo Known 

Distance colocar 100 y en el campo Unit of Measurement colocar µm. En el box 

seleccionar Global. Hacer clic en el botón OK. 

 

 

Figura 53 

 Convertir a escala de grises: Image > Type > 8-bit. La imagen queda transformada en 

grises, Figura 54. 

 

Figura 54 

 Proceder a binarizar: Process > Binary > Make Binary. Ver Figura 55.  
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Figura 55 

 Borrar la escala. Para esto enmarcarla en un rectángulo e ir a Edit > Clear y luego Edit > 

Invert. Ver el resultado en la Figura 56. 

 

Figura 56 

 Configurar la información que se desea obtener. Para esto ir a Analyse > Set 

Measurements y se despliega la ventana de la Figura 57. En este caso se seleccionó la 

información de lo box activados. 
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Figura 57 

 Ahora ir a Analyze > Analyze Particles. Se despliega la ventana de la Figura 58. Entrar 

mínimo tamaño 20, en el campo Show escoger Outlines y en el activar el box Display 

results. Se despliegan las ventanas de las Figuras 59, 60 y 61. En las dos últimas aparece 

la información buscada. 

 

Figura 58 
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Figura 59 

 

Figura 60 
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Figura 61 

En la tabla 13 se da un resumen del resultado. Con esa información se podría obtener 

información adicional usando las expresiones de la Tabla 12. 

 

Tabla 13 

Número de partículas 25 

Área total en  3140,85 µm2 

Tamaño promedio 125,63 µm2 

% de área 3,71 % 

Perímetro  51,66 µm  

Mayor 14,18 µm 

Menor  10,98 µm 

Ángulo  102,52o 

Factor de forma circular 0,63 

Solidez 0,87 

Feret  15,13 µm 

FeretX 152,32 µm 

FeretY  114,71 µm 

FeretAngle 107,29o 

MinFeret 11,92 µm 
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Midiendo: densitometría 

Tomado de :  

 http://rsbweb.nih.gov/ij/docs/examples/index.html 

 Lópe Poveda E.  Universidad de salamanca. Notas sobre Análisis de Imágenes 

La densitometría óptica es una técnica que permite medir la cantidad de luz que absorbe un 

material. En neurociencias, sirve, por ejemplo, para determinar cuantitativa y objetivamente 

la presencia de determinadas moléculas (proteínas, neurotransmisores, moduladores...) en el 

tejido nervioso, en general, y en las neuronas. Se basa en medir la densidad óptica en cada 

región de una preparación histológica observada al microscopio. 

 

¿Cómo se mide la densidad óptica?  

 

Se mide mediante un densitómetro. Existen dos tipos de densitómetros: de transmisión y de 

reflexión. Los densitómetros funcionan haciendo incidir un haz de luz con una intensidad 

conocida sobre la imagen o la película fotográfica y midiendo la cantidad de luz reflejada o 

transmitida por la imagen. La medición es rápida y directa. 

 

Si se emplean cámaras digitales, la densidad óptica de la preparación o de una región de ésta 

puede estimarse indirectamente a partir del nivel de gris de la imagen digital resultante. A 

continuación se explica cómo hacerlo con el software ImageJ.  

 

Ejercicio: estimar la densidad óptica en una preparación a través del nivel de gris de la imagen 

digital 

 

 Abrir la imagen imagenes_practica_5_imagej > densitometría > blobs.gif. Se despliega 

la ventana de la Figura 62. La imagen debe convertirse a una de 8 bits. En este caso no es 

necesario ya que está en ese formato. 
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 Figura 62 

 

 

 Hacer clic sobre el botón “Freehand selections”. El cursor del ratón se transformará en 

una cruz. 

 

 Haga clic en el borde de la “partícula” que desee analizar y sin soltar el botón del ratón 

marque el contorno de la partícula. El contorno se marcará en amarillo, Figura 63. 

 

 
Figura 63 
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 Elegir el menú: Analyze > Measure. Se despliega la ventana “Results” Figura 64. En ella, 

se muestra el tamaño de la partícula (Area en píxeles), el nivel de gris medio (Mean), el 

nivel de gris mínimo (Min) y el máximo (Max) dentro de la partícula. 

 

 

 
 

Figura 64 

 

 Se puede obtener información adicional sobre la “partícula”. Para ello, elegir el menú: 

Analyze > Set measurements. Se desplegará la ventana de la Figura 65 que permite 

seleccionar todas aquellas medidas que se desee obtener sobre la “partícula”. 

 

 
 

Figura 65 
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Sin embargo el nivel de gris es muy dependiente de la configuración del sistema 

microscopio/cámara digital (iluminación, objetivo, apertura,…) lo cual hace que la estimación 

de la densidad óptica a través de este simple método no sea reproducible. Adicionalmente 

este método no mide la densidad óptica de la preparación, sólo da una idea de su magnitud.    

 

Para convertir los niveles de gris medidos en valores de densidad óptica es necesario calibrar 

la imagen. Para garantizar la reproducibilidad de los resultados es imprescindible tomar 

ciertas precauciones metodológicas. 

 

Calibración de la densidad óptica 

 

Calibrar consiste en establecer una correspondencia entre los valores de gris de la imagen 

digital y sus valores correspondientes de densidad óptica (en unidades de densidad óptica).  

 

Para calibrar los niveles de gris de una imagen de fotomicroscopía digital es necesario 

disponer de un filtro neutro de densidad óptica variable. El aspecto de estos filtros es el de 

un porta de microscopio estándar (tamaño de 3×1 pulgadas), cuya densidad óptica cambia a lo 

largo del mismo.  

 

Es común que los programas de análisis de imágenes digitales permitan calibrar las medidas 

con el fin de obtener los resultados en unidades de densidad óptica en lugar de niveles de 

gris. Para ello, incluyen una opción de Calibración. En el ejercicio que se analiza a continuación 

se explica cómo calibrar una imagen con el programa ImageJ. 

 

 

MEDIDAS PARA GARANTIZAR LA REPRODUCIBILIDAD DE LOS RESULTADOS 

 

La calibración no garantiza que los resultados sean reproducibles. Recuerde que los 

niveles de gris dependen de la intensidad de la iluminación. Por tanto, si se cambiase la 

iluminación, cambiaría la densidad óptica correspondiente a un determinado nivel de 

gris. Para garantizar la reproducibilidad de los resultados de densitometría óptica es 

necesario cumplir los siguientes requisitos: 

 

 Utilizar siempre el mismo equipo de medida y análisis. 

 Fijar y anotar las condiciones de iluminación del  microscopio. 

 Fijar y anotar las condiciones ópticas del microscopio (objetivos, filtros, 

condensadores, etc). 

 Fijar y anotar la configuración de la cámara (ganancia, desplazamiento, apertura, 

etc). 

 Fijar y anotar la configuración del software de captura. 

 Utilizar idénticas condiciones en sucesivas sesiones de captura de imágenes. 

 Comprobar que para una misma preparación el nivel de gris obtenido es idéntico en 

diferentes sesiones de captura. Por ejemplo, comprobar que los niveles de gris 

correspondientes a las diferentes densidades ópticas del filtro neutro de densidad 

óptica variable son aproximadamente los mismos en diferentes sesiones de captura.  
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 Aplicar los anteriores criterios en todos los casos. 

  

Nota: 

En este taller no se incluyó un ejercicio de tomar la imagen de una tableta de paso  con 

las diferentes configuraciones del microscopio usado debido a que en el momento no se 

disponía de este elemento.  

 

 

Ejercicio: calibración de la densidad óptica utilizando una tableta de paso 

 

Este es un ejemplo de cómo utilizar una tableta paso densidad óptica para calibrar una imagen. 

En la Figura 66 se ilustra tableta paso Kodak N º 3 escaneada con un escáner Epson 

Expression 1680 Professional. La tableta cuenta con 21 pasos con un rango de densidad de 

0,05 a 3,05 OD. 

 

 
Figura 66 

 

 Medir el valor medio de gris de los 18 primeros pasos de la tableta. Los últimos tres no se 

miden ya que no son distinguibles y adicionalmente la función de calibración de ImageJ se 

limita a 20 medidas. Para esto se debe realizar una selección rectangular de cada paso, 

Figura 67. 

 

 
Figura 67 

 

 Mover la selección para el fondo blanco en el extremo izquierdo de la imagen y medirlo. 

Luego, a partir de la izquierda, mueva la selección y medir cada uno de los 18 primeros 

pasos. Para lograr esto en cada paso hacer clic en Analyze > Measure. Se despliega la 

ventana de la Figura 68. Continuar hasta llegar al paso 18. 
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Figura 68 

 

 Abrir el menú “Analyze > Calibrate” de ImageJ. Aparecerá la ventana “Calibrate...”, 

Figura 69. En el cuadro “Unit:” escriba “DO”. En el cuadro “Function:” elija la función 

matemática que crea que mejor se ajusta a los datos de su tabla de calibración. En la 

ilustración, se ha seleccionado la función “Rodbard”. En la columna izquierda aparecen los 

niveles de gris de cada uno de los pasos del filtro que se analizaron. En la columna 

derecha, escribir las densidades ópticas correspondientes. Hacer clic en “OK”. Se 

despliega una ventana con la curva de calibración: en ella se muestran los datos de la tabla 

de calibración en forma de puntos y la función elegida mediante una línea continua. En 

otras palabras, la gráfica muestra el grado en que la función elegida se ajusta a los datos 

de la tabla de calibración. En el ejemplo de la ilustración, el ajuste es muy bueno (R2 vale 

aproximadamente uno). 

 

 
 

Figura 69 
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Figura 70 

 

 Guardar haciendo clic en Save. Se puede utilizar la misma curva de calibración con todas 

las imágenes abiertas marcando "Global Calibrtion". 

 

 Proceder a medir la densidad óptica de la misma región de interés del ejemplo anterior. 

Abrir la imagen imagenes_practica_5_imagej > densitometría > blobs.gif. Se despliega 

la ventana de la Figura 71. La imagen debe convertirse a una de 8 bits. En este caso no es 

necesario ya que está en ese formato. 

 

 

 
 

 Figura 71 
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 Hacer clic sobre el botón “Freehand selections”. El cursor del ratón se transformará en 

una cruz. 

 

 Haga clic en el borde de la “partícula” que desee analizar y sin soltar el botón del ratón 

marque el contorno de la partícula. El contorno se marcará en amarillo, Figura 72. 

 

 
 

Figura 72 

 

 Elegir el menú: Analyze > Measure. Se despliega la ventana “Results” Figura 73. En ella, 

se muestra el nivel de DO (densidad Óptica) media (Mean), el nivel de DO mínimo (Min) y 

el máximo (Max) dentro de la “partícula”. 

 

 

 
 

Figura 73 

FIN  
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Anexo F: Encuesta de evaluación del 
curso 

Elaboración de una propuesta de enseñanza-aprendizaje de los 

fundamentos de la microscopía óptica mediante el uso de las NTIC haciendo 

énfasis en el procesamiento y análisis digital de las imágenes 

-ENCUESTA- 

Por favor contestar las siguientes preguntas sólo pensando en el CONTENIDO y 

la METODOLOGÍA del curso INDEPENDIENTEMENTE de los docentes que lo 

dirigieron.  

Señalar con una X la opción escogida  

1. El contenido del curso estuvo ajustado según sus expectativas.  

EXCELENTE MUY BUENO BUENO REGULAR MALO 

      

 

 2. El material del curso fue adecuado según sus expectativas.  
 

EXCELENTE MUY BUENO BUENO REGULAR MALO 

      

 
3. El curso cambió su visión sobre las microscopía y sus técnicas.  
 

EXCELENTE MUY BUENO BUENO REGULAR MALO 

      

 
4. El curso da herramientas que favorecen la innovación en el quehacer de la 
microscopía.  
 

EXCELENTE MUY BUENO BUENO REGULAR MALO 
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5. Los temas se trataron con la profundidad necesaria para aportar una visión 
clara de los mismos.  
 

EXCELENTE MUY BUENO BUENO REGULAR MALO 

      

 

6. Las herramientas que se usaron en este curso le han parecido útiles  
 

EXCELENTE MUY BUENO BUENO REGULAR MALO 

      

 
7. El curso recibido es útil para mi formación como ingeniero.  
 

EXCELENTE MUY BUENO BUENO REGULAR MALO 

      

 
 
8. El desarrollo del curso se realizó de lo simple a lo complejo.  
 

EXCELENTE MUY BUENO BUENO REGULAR MALO 

      

 
 
9. En general usted valora el curso como: 
  

EXCELENTE MUY BUENO BUENO REGULAR MALO 

      

 

10. Recomendaría a otros colegas o compañeros a realizar el curso.  
SI:   _____  
NO:   _____  
QUIZÁS:  _____ 
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SUGERENCIAS  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
MUCHAS GRACIAS POR SU COLABORACIÓN 
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Anexo G: Certificado de participación 
y aprobación del curso.  

 

 


